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PART 1: ON1 EFFECTS 2023 OVERVIEW

ON1 Effects 2023 is a complete stylizing tool for your photos. With a professional-grade effects engine that 
includes 31 filters, Effects gives you endless possibilities for finishing your photos, with extensive stacking, AI-
powered masking and blending options; hundreds of borders and textures; and a set of local adjustment tools 
for applying basic tone and color options to your images. You can even create multi-layered composites with 
Effects’ Layers feature. And, to help get you started, Effects comes with more than 100 built-in presets, and 
you can save and apply your own presets with the click of a button. 

You can use ON1 Effects 2023 as a standalone app, simply by dragging and dropping photos into the 
primary app window, or as a plugin to another photo editor such as Adobe’s Photoshop, Lightroom Classic 
CC, and Photoshop Elements, as well as other image editors like Affinity Photo, Capture One, Corel 
PaintShop Pro and Apple Photos. 

When using Effects as a standalone app, you have complete re-editability of your original files, regardless 
of their format. In addition, when you’re using Lightroom Classic, Photoshop or Apple Photos as your 
primary editor, you have the option of having your work saved so that it is re-editable inside Effects at a 
later time.
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Getting Help
You can find an extensive collection of 
video tutorials and help documents in the 
Help section of the ON1 website (on1help.
zendesk.com). This is the quickest way 
to dig into Effects. There, you can search 
our Knowledge Base for frequently asked 
questions, and more. 

You can use the Learning Hub to directly 
display videos for getting started with the 
app, search the ON1 online help system—
including with and online chat assistant—
and the ON1 Shop, where you can purchase 
add-ons and courses for Effects. The 
Learning Hub is accessible via the Help 
menu or from the Help icon at the bottom 
of the left bumper panel.  

System Requirements
MINIMUM RECOMMENDED

OPERATING SYSTEM macOS 10.15.6 and above; Windows 10/11 
(current maintenance releases, 64-bit only)

macOS 12 or Windows 11 (current 
maintenance releases, 64-bit only)

PROCESSOR Intel or AMD processor with 64-bit support, 2 GHz or faster with SSE 4.2 or later;  
Apple Silicon

RAM 8 GB 16 GB or more

HARD DRIVE 2 GB for installation 2 GB for installation; SSD drive

DISPLAY Windows: DirectX 12, DirectML, Vulkan 
1.1, and OpenGL 4.2 compatible video 
card with 2GB VRAM, 1920x1080 
resolution (at 100% scale factor)

macOS: Metal, Vulkan 1.1, and OpenGL 
4.2 compatible video card with 2GB 
VRAM, 1920x1080 resolution (at 100% 
scale factor)

Windows: DirectX 12, DirectML, Vulkan 
1.1, and OpenGL 4.2 compatible video 
card with 8GB VRAM, 1920x1080 
resolution (at 100% scale factor)

macOS: Metal, Vulkan 1.1, and OpenGL 
4.2 compatible video card with 8GB 
VRAM, 1920x1080 resolution (at 100% 
scale factor)

OPTIONAL 
APPLICATION 
INTEGRATION

Photoshop CC 2020 and above; Photoshop Elements 2020 and above; Photoshop 
Lightroom Classic 2020 and above; Apple Photos; Affinity Photo; Corel Paint Shop 
Pro 2019 and above; Capture One 10 and above

INTERNET A high-speed internet connection and active account for activation, auto-update 
checking, content downloads, and tutorials.

SUPPORTED OPTIONS Supports ICC/ICM profiles for camera input, display, soft-proofing, and printing. 
Hardware display calibration tool is recommended.

LANGUAGES English, German, Spanish, French, Japanese, Korean, Simplified Chinese, Russian, 
Portuguese, Italian, Dutch

The Learning Hub is available directly within ON1 Effects 2023, and includes links to 
videos (which can be played directly in the Hub), ON1’s online help system, and the 
ON1 store.

https://on1help.zendesk.com
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Installation
To install ON1 Effects 2023, you must first 
download and install the ON1 Application 
Manager, which manages your ON1 applications 
and free trials. Once you’ve installed the 
Application Manager, double-click on the app 
icon. You will first be prompted to sign in to 
your ON1 account. The Application Manager 
will then communicate with the ON1 servers, 
and display any apps you already have installed, 
as well as any newer apps that are available for 
your account. To install Effects, choose Available 
from the list on the left side of the window, and 
click on the Install button for the ON1 Effects AI 
2023 item. The Application Manager will install 
Effects in the proper location, and add it to the 
Installed section. From there, you can open the 
app. The first time you launch Effects AI, you’ll 
need to sign in again to your ON1 account; after 
that you’re software will be authenticated.

Your license lets you install Effects on two 
computers. When you enter your ON1 account 
info, Effects communicates with the ON1 
activation server and registers your software for 
that computer.

If you wish to move your copy of Effects from 
one registered computer to a new one, and you 
are not going to be using the older machine, it is 
best to sign out of the old computer first. Open 
Effects and select Sign Out from the Help menu. 
This will deactivate Effects 2023 on the current 
machine, and you can install and sign in on 
another machine from the Application Manager.

FREE TRIAL VERSION

ON1 Effects 2023 can also operate as a fully 
featured trial version for 15 days from when you 
first launch it. This gives you time to evaluate 
the product and see if it fits your needs. To 
install Effects as a trial, click on the Free Trials 
label in the Application Manager, and click on 
the Install button. The Application Manager will 
display the number for days left in your trial; to 
purchase Effects, click on the Buy button in the 

The Application Manager is used to install and manage your  ON1 apps and 
plugins. The first time you launch it, you’ll need to sign in with your ON1 
account details.

When using the ON1 Application Manager, the Available section (shown top) 
will list all licensed apps and plugins associated with your account. You can 
install any of those apps by clicking on the Install button, after which they will 
be listed in the Installed section of the Manager.
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Free Trials section, or the Buy Now button in the top right corner of the Effects window.

MAC INSTALLATION LOCATION
On a Mac, the application is installed in the ON1 Effects 2023 folder in the Applications folder. 

If a previous version of ON1’s Effects, Perfect Photo 10 or Perfect Photo Suite is found, it will be 
maintained or replaced based on your preference during installation.

Support files are installed into /Library/Application Support/ and ~/Library/Application Support/ folders.

WINDOWS INSTALLATION LOCATION
The application is installed in the ON1 Effects 2023 folder in the \Program Files\ON1\ directory. If a 
previous version of ON1’s Effects, Perfect Photo 10 or Perfect Photo Suite is found, it will be maintained or 
replaced based on your preference during installation.

Support files are installed into \ProgramData\ON1\.

UPGRADING FROM PREVIOUS VERSIONS

If you have earlier versions of Effects on your computer, the installation process will move over any presets. 

PRODUCT IMPROVEMENT PROGRAM

We believe that the best products are made by listening to our customers. We use many methods to 
gather your ideas and feedback including: emails, surveys, direct conversations, market analysis and the 
Product Improvement Program. The Product Improvement Program is built into our software and gathers 
information about how our software is used. It is the most accurate way for us learn what features are 
important to you and how our products fit into your workflow.

Enrollment in the program is voluntary. When you participate, we collect basic information about how you 
use our programs and basic information about your computer. This information helps us learn what features 
are important to you and how we can make our software easier to use. No personal information is collected 
and you will not be contacted.

You can choose to participate in the Product Improvement Program the first time you launch ON1 Effects 
2023. You can change your participation later, just click the Help menu, then Help Improve ON1 Products.

To learn more about the Product Improvement Program, go to the Support area of the ON1.com website.

Launching ON1 Effects 2023

MACOS

Open the Finder, and navigate to the Applications folder. Find the ON1 Effects 2023 folder and open it, 
then double-click on the ON1 Effects 2023 application icon.

You can add ON1 Effects 2023 to your dock for easy access by clicking and holding the icon in the dock 
and selecting the Keep In Dock option. If you use Launchpad it can be found there as well.
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WINDOWS

Open the Start screen by pressing the Window key; select ON1 Effects 2023.

If you selected the “Add Icon to Desktop” option during installation you can also access ON1 Effects 2023 
from there.

LAUNCHING EFFECTS FROM AN EXTERNAL APPLICATION

To launch ON1 Effects 2023 from an external application, such as Adobe Photoshop or Lightroom, see the 
sections starting on page 6 for complete instructions.

Opening a Photo from within Effects
When you first launch Effects, 
the main window will have 
an icon in the center and an 
Open Photo button. To start 
working on a photo, you can 
either drag a photo from your 
desktop onto the icon, or you 
can click on the Open Photo 
button, both of which will open 
the primary Effects window, 
where you can start applying 
filters and other edits to your 
photos. (See “Part 2: Working in 
Effects 2023” on page 23 for 
detailed information on using 
Effects’ filters and tools on your 
photos.)

On both MacOS and Windows, you can also drag a photo on top of the Effects 2023 icon, which will launch 
the app with that image, bypassing the startup window.

Uninstalling ON1 Effects 2023
To uninstall ON1 Effects 2023, follow these instructions:

First, deactivate your product: open ON1 Effects 2023 and select Sign Out… from the Help menu. (This will 
allow you to transfer your license to another computer.)

On MacOS, go to the Applications/ON1 Effects 2023/Documentation folder. Double-click on the Remove 
ON1 Effects 2023 application.

On Windows, go to Control Panels. Under Programs select Uninstall a program, and select ON1 Effects 
2023 from the list and click on the Uninstall button.

You can edit a photo directly from within ON1 Effects by dragging a file into the window, or by clicking 
on the Edit Photo button.
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Working with Files
ON1 Effects 2023 can view and open the following file types, in RGB color mode, at 8 or 16 bits per pixel:

• Raw files from most major camera manufacturers (file extension varies by manufacturer)

• Digital Negative (DNG)

• Photoshop (PSD)

• Photoshop Large Document (PSB)

• Tagged Image File Format (TIFF)

• Joint Photographic Experts Group (JPEG)

• Portable Network Graphic (PNG)

•	 High Efficiency Image Format (HEIC) 

When you finish working on a photo in Effects, you have the option of saving your resulting file in PSD, 
PSB, TIFF, JPEG, and PNG format.

FILE ACCESS WHEN USING EFFECTS 2023 AS A PLUGIN

If you use ON1 Effects 2023 as a plugin from another image editing app (Lightroom, for example), we 
recommend using the Photoshop format (.PSD) as the exchange file format for maximum compatibility. If 
your saved file will be larger than 2GB, or more than 30,000 pixels on a side, your image will automatically 
be saved in the .PSB (or Large Document) format. This is a newer version of the PSD format designed for 
larger file sizes, and is fully compatible with Effects.

When working with Effects as a plugin to Photoshop, Lightroom Classic, and Apple Photos, there are 
certain conditions in which you can preserve re-editability from within the host app. See “Using Effects 
with Adobe Photoshop” below, “Using Effects with Adobe Lightroom Classic CC” on page 9, and “Using 
Effects with Apple Photos” on page 13 for specifics on how to use these options.

Using Effects with Adobe® Photoshop®
When you edit an image sent from Photoshop to ON1 Effects 2023, you are editing Photoshop’s currently 
selected layer. By default, Effects makes a copy of the layer, so your original layer is saved, unless it 
is a Smart Object (see below). If you’d like to change this preference, see the Plug-Ins section of the 
Preferences window on page 130.

ON1 Effects 2023 is accessible from within Photoshop in two ways, from the File > Automate menu, and 
from the Filter > ON1 menu. 

There are two options for editing an image in ON1 Effects 2023: you can send the layer to Effects for final 
editing, or you can save the editing layer as a Smart Object in Photoshop, which will let you re-edit the 
photo in Effects with your previous settings intact.
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EDITING A PHOTO FROM PHOTOSHOP FOR FINAL EDITING

To use Effects inside Photoshop, when you do not wish to re-edit your operations:

1.	 Open the image you want to work on in Photoshop.

2.	 Select the layer you want to work 
on. (Depending upon your Plug-Ins 
Preference, make a duplicate if you 
want to preserve the original layer 
(Layer > Duplicate))

3.	 From the Filter menu, select ON1 and then ON1 Effects 2023.

4.	 When you’re finished editing your photo, click the Done button in Effects. 

EDITING A PHOTO FROM PHOTOSHOP TO PRESERVE EFFECTS EDITS

To be able to re-edit your Photoshop images at a later point inside ON1 
Effects 2023, you will use Photoshop’s Smart Object technology. To do 
this, follow these steps:

1.	 Open the image you want to work on in Photoshop.

2.	 Select the layer you want to work on.

3.	 Right-click on the layer and choose Convert to Smart Object.

4.	 From the Filter menu, select ON1 and then ON1 Effects 2023.

5.	 When you’re finished editing your photo, click the 
Done button in Effects.

To re-edit your Smart Object layer again inside ON1 Effects 
2023, double-click on the ON1 Effects item in the edited 
Smart Object layer in Photoshop (shown on the right). Effects 
will then launch and let you adjust your previous settings or 
make new ones.

Select ON1 Effects 2023 from Photoshop’s Filter menu to send the current 
layer to Effects.,

Right-clicking on a layer in Photoshop’s 
Layers panel gives you the option to 
turn the layer into a Smart Object..
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Using Effects with Photoshop Elements®
When you edit an image sent from Photoshop Elements to ON1 Effects 2023, you are editing Photoshop 
Elements’ currently selected layer. By default, Effects makes a copy of the layer, so your original layer is 
saved. If you’d like to change this preference, see the Plug-Ins section of the Preferences window (page 
130).

EDITING A PHOTO IN PHOTOSHOP ELEMENTS

To use Effects inside Photoshop Elements, follow these steps:

1.	 Open the image you want to work on in Photoshop Elements.

2.	 Select the layer you want to work on. 

3.	 From the Filter menu, select ON1 and then ON1 Effects 2023.

4.	 When you’re finished editing your photo, click the Done button in Effects.

NOTE: Photoshop Elements does not support Smart Objects, so all edits done 
inside ON1 Effects 2023 are final, once you return to Elements.
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Using Effects with Adobe® Lightroom® Classic CC
ON1 Effects 2023 can be accessed from within Lightroom Classic CC, providing an integrated, round-
trip workflow of your images. There are two primary ways to use Effects with Lightroom, via the Edit In 
command in the Photo menu and Plug-In Extras command in the File menu. Using the Photo > Edit In menu 
gives you access to Effects for quickly editing an image that won’t require re-editing, while File > Plug-In 
Extras gives you two more powerful options for editing inside Effects, including: 

• Re-editability via ON1’s proprietary Smart Photos format (see page 11), which saves all the 
edits made in Effects, so that you can re-edit them at a later time.

• Batch processing of multiple images for editing in Effects (see page 12).

USING ‘EDIT IN’ FROM LIGHTROOM

If you wish to make quick edits on a single image 
in Effects, and don’t need to preserve your edits 
or work with multiple photos, use the Edit In 
submenu from Lightroom’s Photo menu, This is 
the easiest way to send a photo from Lightroom 
to Effects. With this option, you are using 
Lightroom’s plugin export system to control the 
characteristics of the edited file.

File Creation Characteristics When Using Edit In

When you use the Photo > Edit In submenu, Lightroom 
will ask you each time how you wish to edit the selected 
image. You have three editing options: 

• Edit a Copy with Lightroom Adjustments, 
which makes a copy of the file that includes 
any edits you have made in the photo;

• Edit a Copy, which copies the original photo 
without any changes made in Lightroom; or

• Edit Original, which sends the original version 
of the photo to Effects, unless the photo is 
a raw file, in which case the option will be 
unavailable.

In the Copy File Options, you set the file type (TIFF, 
Photoshop PSD or JPEG), the color space and bit depth 
for the resultant file.

When you have set your options and click the Edit 
button, Lightroom will create a new file (or send the 
original) and launch Effects. When you’re finished, 
click the Done button to save your changes, close Effects, and return the file to Lightroom. To return to 
Lightroom without saving your edits, click Cancel. 

For quick editing of photos from Lightroom, you can choose Edit in from 
Lightroom’s Photo menu.
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NOTE: While you cannot create a Smart Photo PSD via Edit In, you can open 
an existing Smart Photo with Edit In. Select the Smart Photo, choose Edit In > 
ON1 Effects 2023, and choose Edit Original in the window. Effects will open 
the image with your previous edits intact (Lightroom adjustments made to 
the Smart Photo will not be visible, however). Any subsequent edits you make 
in Effects will be saved with the Smart Photo when you return to Lightroom, 
and the Lightroom edits will be reapplied. (Information about the Smart Photo 
format starts on page 11.)

USING ‘PLUG-IN EXTRAS’

To use the Plug-In Extras option in Effects, select the 
image in Lightroom, go the File menu and select the 
Plug-In Extras submenu, and choose ON1 Effects 
2023. 

When you access ON1 Effects 2023 through 
Lightroom’s Plug-In Extras menu, the default file-handling options are driven by the settings in the Plug-ins 
tab of Effects’ Preferences window. These options can be configured in advance, based on your workflow, 
and can be changed as desired. The file export options include the following settings:

• File Type: This determines what type of 
file will be created. The default is PSD, 
which does not support re-editability. You 
can also select Smart Photo PSD, JPG or 
TIFF, if you prefer those formats. One 
other option, Same as Source, will edit 
the original file; if that file is in the Raw 
format, it will be sent as a PSD file.

• Color Space: The color space menu 
determines which RGB working color 
space is used; Adobe RGB 1998, sRGB or 
ProPhoto RGB.

• Bit Depth: Sets the exported file’s bit 
depth to either 8 or 16 bits per pixel.

• Resolution: Determines the resolution of 
the newly created file.

• Stack with Original: When enabled, the 
new image is stacked with the original 
image upon return to Lightroom from Effects.

• Use Original for Single PSDs: When enabled, if you select a single image in PSD format, the 
original file will be edited, rather than having a copy made.

The Plug-In Extras submenu is found in Lightroom Classic’s File menu. 

When sending a file from Lightroom to Effects via Lightroom‘s Plug-In 
Extras menu, the edited file will be created according to your settings in 
the Plug-Ins section of Effects’ Preferences window.
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• Ask Every Time: When checked, 
Lightroom will present these export 
copy options whenever you chose an 
item from the Plug-In Extras submenu. 
Turning this option off will bypass the 
file-export window inside Lightroom, 
using the options set in Plug-In 
Preferences window. 

If you have the Ask Every Time option checked, 
you’ll be presented with the Export window (shown 
on the right) inside Lightroom whenever you send 
an image to Effects. The Export Options window 
lets you adjust the file format characteristics as 
needed, and is designed for users with variable 
workflow needs. If you find that you use the 
same options every time, then you can set those 
parameters in Effects’ Preferences window by 
unchecking the Ask Every Time option.

Batch processing options with Plug-In Extras 

You can process multiple images for editing in Effects via Plug-In Extras. Select the images you wish to 
work with in Lightroom’s Library module and choose Effects from the Plug-In Extras submenu. The Export 
Options window will open with two batch options:

• Pause on First Photo: Use this option when you 
wish to apply the exact same editing operations to 
a group of photos. This option will open the first 
selected image inside Effects. There, perform any 
editing option you wish, including adding presets, 
retouching operations, cropping, masks, local 
adjustments and more. When you have finished with 
your edits, click Done. Effects will then apply all of 
the edits to each image in the group, and return you 
to Lightroom.

• Pause on All Photos: This option lets you 
sequentially edit the images in the batch. Effects 
will open each image in the destination tab, where you can edit it as desired. When you are 
finished editing with one photo, click Done, and Effects will save that photo and open the 
next one, with the previous photo’s Effects settings applied. (You can reset any or all of those 
settings as desired.) When you have finished editing the last photo in the group, clicking 
Done will save the image, close Effects and return you to Lightroom.

WORKING WITH SMART PHOTOS

ON1’s Smart Photo technology is a variation of the Photoshop file format that has been engineered 
to preserve all editing and retouching operations made within Effects: filter operations, masks, local 
adjustments, retouching, and so forth. Smart Photos can only be created via the Plug-In Extras export 

The Batch Options window comes up when you wish to 
send a group of photos from Lightroom to Effects for 
editing. (If you have the Ask Every Time option set in 
Effects’ Preferences, Batch Options will be displayed as a 
section in the Export Options window, and you will be 
able to set the file copy options for the photos in the 
batch.)

If you have the Ask Every Time option turned on in Effects’ Plug-Ins 
Preferences window, whenever you send an image from Lightroom to 
Effects, the Export Options window will come up, letting you adjust the 
export characteristics for that image.



ON1 Effects 2023 User Guide	 Part 2: Overview	 12

method as discussed on page 10, although you can re-edit them via either the Plug-In Extras or the Edit 
In menu options in Lightroom.

When you choose Smart Photo PSD as an option in the Plug-In Extras submenu from within Lightroom, 
Effects creates a standard Photoshop file with “Smart Photo” at the end of the original file’s name. As you 
work in Effects, all of your editing operations are saved in a ‘sidecar’ file that sits alongside the PSD on disk 
inside the same folder as your original image. When you are done editing and return to Lightroom, your 
edited photo will look as it did in Effects, but is completely re-editable.

To re-edit a Smart Photo from within Lightroom, select the image, and choose ON1 Effects from either the 
Plug-In Extras from the File menu or Edit In from the Photo menu. Depending upon the method chosen and 
your Effects Preferences, the Smart Photo will open automatically, or you will need to select Edit Original 
from the Lightroom export window. �   

There are a few things to know about with regards to Smart Photos and re-editability:

• Smart Photos have been specifically designed to work as a conduit between Lightroom and 
Effects to preserve re-editability. If you use Effects as a standalone app, you can open and 
view a Smart Photo from within Effects, and can re-edit the photo; as long as your sidecar file 
is present, all of your edits will be present. However, when you complete your edits, Effects 
will create a new file in any of the available file formats (PSD, PSB, TIFF, JPEG, and PNG), but 
that file will be flattened, and your edits will not be preserved.

• If you open a Smart Photo in Adobe Photoshop, the layers will be merged into a single, 
composite layer. If you make any edits to the photo in Photoshop and save it, re-editability in 
Effects will no longer be available.
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Using Effects with Apple® Photos
ON1 Effects 2023 integrates tightly with Apple 
Photos for MacOS and provides a seamless 
experience for enhancing your images. 

If you have Photos on your computer when you 
install ON1 Effects 2023, the appropriate plugin 
will be installed, but you will need to manually 
activate it in order to use it. To do so, go to Apple’s 
System Preferences and click on the Extensions 
icon. In the Extensions pane, click on Photos, then 
check the ON1 Effects 2023 option. This will let 
you send images from Apple Photos to Effects 
2023. (File Sharing must also be turned on in 
System Preferences for this to work.)

To edit an image in ON1 Effects 2023 follow these 
steps:

1.	 Select the image you wish to edit in Photos.

2.	 Click on the Edit button.

3.	 On the right side of the window, at the bottom of the 
editing controls, you’ll see an Extensions pop-up. Click 
that button, and choose ON1 Effects 2023.

4.	 The photo will open in Effects; make any adjustments 
you wish, and click the Done button in Effects to save 
the edited photo and return to Photos.

NON-DESTRUCTIVE EDITING WITH APPLE PHOTOS

When you send an image from Apple Photos to Effects, any settings you apply will be saved with 
the image, so that you can send the image back to Effects with your edits intact, as long as you do not 
subsequently edit that image inside Photos. To re-edit an image processed inside Effects, click on the image in 
Photos and follow the same three steps above. When your image is opened inside Effects, you will see all of 
the changes you made in your previous session. 

Once you make any editing changes to your image inside Photos, your Effects edits will be “baked in” to the 
image. You can send the image again to Effects, but your original settings won’t be visible. 

If you wish to keep your original Effects edits, duplicate the image inside Photos (Image > Duplicate), which 
will create a new virtual copy of the file. You can then edit one of the versions in Photos, using the other 
one to preserve your Effects edits.

After installing ON1 Effects 2023 on your Mac, you must turn the Photos 
extension on via Apple’s Extensions System Preference.

In Apple Photos, click the pop-up menu next to the 
Extensions label when editing a photo and you’ll 
see the options for sending your photo to Effects 
2023.
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Using Effects with Capture One
When you edit an image sent from Capture One to ON1 Effects, Capture One creates a variant of the 
current photo. To use Effects inside Capture One, follow these steps:

1.	 Open the image you want to work on in 
Capture One.

2.	 From the Image menu, select Image > Edit 
With > ON1 Effects 2023.

3.	 Choose the file characteristics in the 
Basic tab that you wish to use in Effects—
File Type, Bit Depth, ICC Profile, and 
Resolution. You can also set the options 
in the Adjustments and Metadata tabs as 
desired. When you’re done, click the Edit 
Variants button to launch Effects.

4.	 When you’re finished editing your photo, 
click the Done button in Effects.

After you’ve returned to Capture One, your new variant will be visible in the current collection.

BATCH PROCESSING IMAGES IN EFFECTS WITH CAPTURE ONE

You can process multiple images for editing in Effects with Capture One. Select the images you wish to 
work with in Capture One and choose Image > Edit With > ON1 Effects 2023. The Export Variant window 
will open with an additional tab, ON1 Batch, which contains a pop-up with two options:

• Pause on First Photo: Use this option 
when you wish to apply the exact same 
editing operations to a group of photos. 
This option will open the first selected 
image inside Effects. There, perform any 
editing option you wish, including adding 
filters, applying presets, retouching 
operations, cropping, masks, local 
adjustments and more. When you have 
finished with your edits, click Done. 
Effects will then apply all of those edits to 
each image in the group, and return you to 
Capture One.

• Pause on All Photos: This option lets you sequentially edit the images in the batch. Effects 
will open each image in the destination tab, where you can edit it as desired. When you are 
finished editing with one photo, click Done, and Effects will save that photo and open the 
next one, with the previous photo’s Effects settings applied. (You can reset any or all of those 
settings as desired.) When you have finished editing the last photo in the group, clicking 
Done will save the image, close Effects and return you to Capture One.
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Before sending multiple images to Effects from Capture One, you can also click on the Basic, Adjustments 
and Metadata tabs to change those options. Once you have all the options chosen, click the Edit Variants 
button and Effects will process that group based on your batch settings.

Using Effects with Corel PaintShop Pro
When you edit an image sent from Corel PaintShop Pro (Windows-only) to ON1 Effects, you are editing 
PaintShop Pro’s currently selected layer. To use Effects inside PaintShop Pro, follow these steps:

1.	 Open the image you want to work on in PaintShop Pro.

2.	 Select the layer you want to work on. 

3.	 From the Effects menu, select PlugIns > ON1 > ON1 Effects 2023.

4.	 When you’re finished editing your photo, click the Done button in Effects.

PaintShop Pro does not support nondestructive editing with Effects; if you would like to work on a copy, 
before you send the photo to Effects, right-click on the layer in PaintShop Pro and choose Duplicate.

Using Effects with Affinity Photo
ON1 Effects can be accessed from within Affinity Photo, providing an integrated, round-trip workflow 
of your images on both MacOS and Windows. To use Effects as a plugin to Affinity Photo, you must first 
activate the plugin from within Affinity Photo.

ACTIVATING EFFECTS FOR USE WITH AFFINITY PHOTO (WINDOWS)

1.	 To setup Effects as a plugin on Windows, go first to Edit > Preferences and click on the 
Photoshop Plugins icon. 

2.	 Check the ‘Allow “unknown” plugins to be used’ box at the bottom of the screen.

3.	 Click the Add button underneath the Plugin Search Folders area, and navigate to 
\Program Files\ON1\ON1 Effects 2023\Plug-in Files\ON1 Effects 2023.plugin. 
Click OK.

4.	 When you click on the Close button, Affinity Photo will prompt you to restart the app. 
When you do this, you should now see Effects listed in the Detected Plugins section of the 
Photoshop Plugins preferences.

ACTIVATING EFFECTS FOR USE WITH AFFINITY PHOTO (MACOS)

Setting Affinity Photo up for MacOS is nearly identical to the Windows activation. There is only one 
additional step.

1.	 Go first to Preferences, located in the Affinity Photo menu on the top left. Click on the 
Photoshop Plugins icon. 

2.	 Check the ‘Allow “unknown” plugins to be used’ box at the bottom of the screen.

3.	 Click on the Authorize Global button at the bottom of the window. MacOS will present you 
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with a dialog box that shows the root folder of your system. Click on the Authorize button in 
this box.

4.	 Click on the Add button underneath the Plugin Search Folders area, and navigate to 
Applications/ON1 Effects 2023/Plug-in Files/ON1 Effects 2023.plugin. Click OK.

5.	 When you click on the Close button, Affinity Photo will prompt you to restart the app. 
When you do this, you should now see Effects listed in the Detected Plugins section of the 
Photoshop Plugins preferences.

EDITING A PHOTO IN EFFECTS FROM WITHIN AFFINITY PHOTO

When you edit an image sent from Affinity Photo to ON1 Effects, you are editing Affinity Photo’s currently 
selected layer. To use Effects inside Affinity Photo, follow these steps:

1.	 Open the image you want to work on in Affinity Photo.

2.	 Select the layer you want to work on. 

3.	 From the Effects menu, select Filters > Plugins >ON1 > ON1 Effects 2023.

4.	 When you’re finished editing your photo, click the Done button in Effects.

Affinity Photo does not support nondestructive editing with Effects; if you would like to work on a copy, 
before you send the photo to Effects, right-click on the layer in Affinity Photo and choose Duplicate.



ON1 Effects 2023 User Guide	 Part 2: Overview	 17

Extras
ON1 Effects 2023 supports a number of additional file types that can be used in various places. These files, 
called Extras, include the following types:

• Presets for use within Effects.

• Borders than can be imported and used with Effects’ Borders filter.

• Textures that can be imported and used with Effects’ Textures filter.

• Look-up tables (LUTs) for use with Effects’ LUTs filter.

• Brush shapes, which are generally saved as black-and-white TIF files. Effects can also import 
custom brushes saved in the Adobe Brush Preset format (.abr). These brushes are generally 
used within the Local Adjustments tab of Effects.

• Sun flares, which can be imported and used with Effects’ Sun Flare filter.

• Watermarks, image files (transparent PNGs) that can be used with the Export function.

ON1 includes a number of extras in the product when you install Effects, and you can create your own, or 
add extras downloaded from the ON1 website. You can use the Extras Manager to import and manage your 
own extras, creating categories for each type, and deleting extras that you no longer want.

HOW TO IMPORT EXTRAS

To import extras, choose Manage Extras from the File menu, then follow these steps:

1.	 Select the type of extras you wish to import from the tabs at the top (Presets, Borders, 
Textures, LUTs, Brush Shapes, Sun Flares) You can only import extras of one type at a time.

The Extras Manager window.
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2.	 Click on the Import button in the footer of the left column. A dialog will appear where you 
can select the files to import. If you want to import an entire folder, open the folder, select 
the first file, then shift-click on the last file. Click Import when your selection is complete.

3.	 Select a category for your extras to be installed in. This is where you will be able to find it 
inside of the ON1 Effects 2023. You can select from an existing category or create a new 
one by clicking on the ‘+’ button at the bottom left side of the Extras window.

When your extras have been imported you will see them in the Extras Manager in the category you 
selected, in the type of extra they belong to.

NOTE: Most extra types mentioned here will have a corresponding Import 
button in their respective panes or windows. (For example, watermarks in 
the Export panel, or textures, borders, and LUTs in their corresponding filter 
panes.) Clicking the Import button in these instances will open the Extras 
Manager. To import backgrounds (for use with Layers) and custom brushes, 
choose Manage Extras from the File menu.

Organizing Presets

The Presets tab of the Extras Manager gives you additional options for working with large groups of 
presets inside Develop and Effects. When you are using the Presets tab, you’ll see ‘+’ and ‘-’ buttons, which 
let you add or delete categories to the list of your presets. 

You can also add subfolders to any of the Presets categories, which can help organize and manage large 
collections of presets. You can use drag-and-drop to move existing categories into another, or you can add 
a category subfolder to an existing category by clicking on the category and then clicking on the ‘+’ button 
in the Extras Manager window. (When you are importing presets, Effects gives you the opportunity to add 
presets to any category folder or subfolder.)

In addition to the Import option, the Presets section of the Extras Manager will also let you export presets, 
for sharing with other users, or to save seldom used presets for archiving purposes. To export a complete 
category, click on the category in the list on the left side of the window and click on the Export button. 
This will export a folder that contains a single .ONpreset file, which includes all of the presets from that 
category. If you would like to export a single preset, click on the preset from the list on the right side of the 
window and click Export.

What Type of Images Can I Import as Extras?

Textures may be any image file that Effects can open, including JPEG, TIFF, raw or Photoshop files. Border 
files must have a large central area that is transparent, so only files that support transparency, such as PNG, 
can be imported as borders. LUTs can be in either .3DL or .CUBE format. Brush shapes can either be in the 
Adobe Brush Preset (.abr) file format, or saved as black-and-white TIF files. Sun flare files are usually JPEG 
files with a black background. 

NOTE: If you download an .ONPreset or .ONP file (for use with Effects), 
double-click on it to install it. For more information, see Presets on page 61.
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USING EXTRAS

You access borders, textures, LUTs and sun flares from within those four filter types in Effects. To use them 
follow these steps:

1.	 Open an image into Effects.

2.	 In the Filter Options pane, select the Borders, LUTs, Sun Flare or Textures filter type.

3.	 From the Category pop-up, select a category you have imported. User-added extras 
categories will appear at the bottom of the category list.

4.	 Choose an extra from the imported category.

NOTE: Each filter will have a different method for choosing that filter’s extras. 
More detailed information on using these extras types and their respective 
filters can be found on page 82 (Borders), page 90 (LUTs), page 93 
(Sun Flares), and page 94 (Textures). For details on how to use custom brush 
shapes within the Local tab, see page 101.

HOW TO DELETE EXTRAS

You can remove imported extras using the Extras Manager. Follow these steps:

1.	 Open the Extras Manager in any module (File > Manage Extras).

2.	 Click on the extras type that contains the content you wish to remove. This will display 
categories within that type.

3.	 To delete an entire category, select in the left column and click on the Delete button in the 
footer of the left column.

4.	 To delete individual extras, select them in the right column and click on the Delete (‘—’ in the 
Presets tab) button in the footer of the right column.

Deleting extras is permanent and cannot be undone.
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Customizing Effects’ Keyboard Shortcuts
You can customize ON1 Effects 2023’s hotkeys via 
the Keyboard Shortcuts window. This window lets 
you view and change the shortcuts for any tool, tool 
option, module, or menu item inside Effects. You 
can assign shortcuts to items that don’t yet have a 
shortcut, build multiple sets of shortcuts as preset 
styles, and create a summary of your shortcuts that 
can be viewed in any web browser.

To view or change Effects’ hotkeys, choose Keyboard 
Shortcuts from the Edit menu. By default, Effects’ 
shortcuts will be displayed, organized hierarchically 
by the following groups: 

• Modules, commands for switching 
between Effects and Local Adjustments.

• Tools, for the 15 tools available in Effects.  

• Tool Options, for the brush and mask 
viewing options available in any masking 
tool’s Options Bar.

• Menu, which includes all of Effects’ menu 
items. 

You open each group by clicking on the triangle to the left of the group name, or you can use the search 
field at the top of the Keyboard Shortcuts window to search for a command in any of the groups. 

Each command that has an assigned key will display that key in the Shortcut column. The Shortcut field 
will be empty for any command that doesn’t have an assigned key, and any field with a grayed-out shortcut 
means that you cannot modify that command’s keys.

NOTE: Some keyboard shortcuts cannot be changed. These include menu 
commands used by the operating system (Cut, Copy, Paste). Also, you can’t use 
the Escape, Return/Enter, or Delete keys as a shortcut.

MODIFYING HOTKEYS

The Default preset style’s hotkeys cannot be modified, but you can create your own set of shortcuts by 
double-clicking on any command you wish to add or change. You’ll be asked if you want to create a new 
preset. Clicking Yes will let you name the new preset style, and Effects will make a duplicate of the Default 
set.
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At this point, you can change any existing hotkeys—or add your own shortcuts for commands that don’t 
have them—by double-clicking in the Shortcut field for that command. The field will be highlighted, and you 
can press the key or key combination you wish to use. If that key is used by another command, a dialog will 
come up, informing you of that, and giving you the option of either keeping the existing hotkey/command 
combination, or changing it to the new command.

When you change a default shortcut to a new 
key combination—even for commands and 
options that didn’t initially have a shortcut—a 
Reset arrow will appear to the right of the 
Shortcut field. Clicking the icon will reset the 
command to its original state, from the Default 
preset style.

To delete a shortcut, double-click in the Shortcut 
field and press the Delete key. 

The Summarize button at the top of the 
Keyboard Shortcuts window will create an 
HTML table of the current set of hotkeys. You’ll 
be asked where to save the file; double-clicking 
on it will open that table in your default web 
browser, where you can view or print the list. 

You can return to the original Effects shortcuts by clicking on the pop-up menu at the top of the Keyboard 
Shortcuts window, and choosing Default from the list of preset styles. That menu can also be used to 
create a new preset or to delete an existing one that you created. The Default preset cannot be removed.

Using Effects with a Scroll Wheel
When you are using ON1 Effects 2023 with a mouse that has a scroll wheel, there are number of different 
options available throughout the app, on both Mac and Windows.

Throughout Effects, the scroll wheel has the following general options:

• Using the scroll wheel will pan up and down in the current window. In Browse’s Thumbnail 
view, it will scroll the window. In most other views, using the scroll wheel with the cursor 
over the preview area will pan the image on screen up and down. Holding the Shift key down 
and scrolling will pan left or right.

• Hold Option (Mac) or Control (Windows) with the scroll wheel to zoom in or out of an image.

In the Edit module, when working with any tool that has a brush size and feather option, press Command-
Option (Mac) or Control-Alt (Windows) and scroll to change the brush size. To change the feather, press 
Option-Shift (Mac) or Alt-Shift (Windows).

NOTE: If you only want the scroll wheel to change brush size, turn on the 
“Only Adjust Brush Size with Scroll Wheel” option in Effects’ Preferences 
window. See “General Settings” on page 129.

When you add or change a hotkey the first time, Effects will prompt you to 
create a new preset style, which makes a duplicate of the Default preset. You 
can switch between preset styles—including back to Effects’ Default set—by 
using the pop-up menu at the top of the Keyboard Shortcuts window.

If you try to add a shortcut key combination that is already in use, Effects will 
let you know, and give you the option of keeping (Cancel) or removing (OK) the 
other command/shortcut.



ON1 Effects 2023 User Guide	 Part 2: Overview	 22

Changing Effects’ font size
By default, ON1 Effects prioritizes the main workspace to focus on photos, using a small font size to display 
panel names, labels, file names any other basic text. You can adjust the default font size to one of three 
settings, Small, Medium or Large, by choosing the General tab of Effects’ Preferences window. Select the 
option from the Font Size pop-up, and restart Effects to have the effect take place.

ON1 Effects has three options for displaying type in the main workspace, Small (left), Medium (middle), and Large (right). To change the size, go to 
the General tab of the Preferences window, and pick the new option from the Font Size window. The change will take effect the next time you 
launch the app.
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PART 2: WORKING IN EFFECTS 2023
ON1 Effects 2023’s photo-editing power consists of two distinct editing functions, separated into tabs:

• Effects is your image stylization center, with 31 filters—everything from sophisticated black 
and white conversion, HDR stylizing, glows, sharpening, color enhancement and more— that 
can be stacked in any order, all with extensive blending and masking options. 

• Local Adjustments are designed to apply basic, targeted edits to parts of your photos, letting 
you perform traditional photo-editing tasks—like dodging and burning—with ease. You can 
also use custom brushes and the Paint with Color option to add overlays like clouds, trees, 
and more to your photos. For more about local adjustments, turn to page 98.

To switch between the different functions, click on the appropriate tab. While you work on an image, all of 
your settings in each tab are saved while you edit. 

When using Effects as a plugin from Affinity Photo, Capture One, or Photoshop Elements, you can still 
move between the Effects  and Local tabs, but your photos will not be re-editable once you leave Effects. 
If you’re using ON1 as a plugin with Lightroom Classic’s Smart Photos file format option (page 11), 
Photoshop Smart Objects (page 6) or with Apple Photos (page 13), your work will be re-editable.

To help you save time and create the looks that you love best, ON1 Effects 2023 also includes a robust 
preset system that lets you save settings made in the Effects or Local tabs for applying to other photos. 
Editing presets can be applied at any time are re-editable. (Presets are discussed in detail on page 61.)

You can also create multi-layered composites inside Effects, via the Layers function. Using layers, you can 
add other photos, backgrounds, replacement skies, textures and more. Each layer has its own Effects and 
Local Adjustments stacks, and has access to all of Effects’ masking tools and operations. (See page 104 for 
details on working with Layers.)
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ON1 Effects 2023 Main Screen Overview

Effects provides you with an easy-to-use work space for editing your photos. Below is an overview of the 
main sections of the Effects window:

A.	Tool Well: Tools for working within Effects 2023.

B.	 Preferences/Help: Shortcuts to app preferences and help.

C.	 Filters/Preset panel: Tabbed panels with (a) a list of all installed presets (by category), or (b) a 
list of all Effects filters. 

D.	Search: Searches presets (and filters, when working in Effects) by name.

E.	 Preview Window: Displays the current photo in detail view.

F.	 Preview option toggles: Magnification slider for current image, compare (before/after) mode, 
show/hide mask, turn soft proofing and preview on or off.

G.	Tool Options bar: Options and settings for currently selected tool.

H.	Photo Information pane: Navigator, levels (histogram) and general photo information and edit 
history panel.

I.	 Layers pane: Add, edit and manage layers here.

J.	 Effects /Local tabs: Tabs for accessing the Effects and Local Adjustments sections of the 
Effects window. Clicking on each tab brings up the settings for that tab.

K.	 Filter stack: Where you add filters to apply to your photo. To add a filter, you can click on the 
Add Filter button at the top of the stack, or use the Presets or Filters panel on the left side of 
the window.
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L.	 Reset bar: Reset All (restores settings to the original state when you opened the photos), 
Cancel (closes the photo without saving), Done (closes photo, opens a dialog box to let you 
specify the file name and type of the finished photo).

M.	Output: Shortcuts for printing or exporting the current photo.

ALTERNATIVE VIEW MODES

In all of the preview modes inside Effects, you have three options for arranging the workspace:

• The default is a resizable, movable window.

• Full Screen Mode, which can be found in the Window menu, will expand the main window 
to fit the contents of the current display. The menu bar is hidden, but it can be viewed by 
moving the mouse cursor to the top of the screen. This mode can be toggled on and off by 
pressing Option-Control-F (Windows) or Command-Control-F (MacOS).

• Full Screen Preview, also found in the Window menu, will display the currently selected 
photo full-screen, without any of the other interface elements. You can use the arrow keys 
on the keyboard to move from photo to photo. This option is helpful when you wish to view a 
selection of photos as large as possible without any distractions. 

Effects provides several ways to navigate and view your image in the Preview window:

• By default, your image is presented in Fit view, which displays the image within the preview 
area, and the Zoom tool is selected. Clicking on the image with the Zoom tool will zoom in 
to 100%, and the cursor will change to the Hand tool. You can move around your image by 
clicking and dragging in the preview area. Clicking once will take you back to Fit view.

• You can also zoom in and out via the View menu and the Navigator pane. The Navigator pane 
displays a bounding box around the area currently on-screen, and you can reposition what is 
displayed in the preview area by clicking and dragging the box around the pane. Clicking on 
one of the buttons at the bottom of the Navigator pane will automatically zoom to Fit, 100%, 
50% or 25% views. (The buttons are visible in the Zoom tool’s Options bar.)

• When the preview zoom is larger than the viewable area, holding down the spacebar will 
display the Hand tool if any editing tool is selected. Clicking and dragging while holding the 
spacebar will reposition your image at the current view level.

Navigator, Levels, Info and History Panes
At the top of the control panel on the right of the main window are the Navigator, Histogram, Info and 
History panes. These tools can be useful for inspecting and viewing details of your image, as well as for 
looking at all of the Effects module adjustments made during a 
session.

THE NAVIGATOR PANE

This gives you a thumbnail view of your image. The white square 
region marks the image area that is visible in the preview pane. You 
can pan your image by clicking and dragging inside the square.
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At the bottom of the Navigator pane are several zoom buttons representing percentage zoom views (100%, 
50% and 25%). Click on one of the buttons to change the view. Fit zooms to fit the current canvas size, 
while 100 zooms to 100%, displaying the actual pixels.

NOTE: You can also use your mouse’s scroll wheel to pan and zoom inside your 
photos. See “Using Effects with a Scroll Wheel” on page 21 for specifics.

THE LEVELS PANE

This gives you a color chart of the shadow, midtone and highlight 
areas based on the image RGB values (commonly known as a 
histogram). This is useful to show areas within the image that may 
be clipping. Clipping is when your image contains pure blacks or 
white and can signify loss of highlight or shadow detail.

The left side of the histogram represents the shadows, while the 
right represents the highlights. At the top of each end is a triangle. 
If the triangle is lit, there is clipping on that side of the histogram. 
If you click on the arrows, you will activate the clipping overlay on 
your image, which displays the areas that are clipped. Those areas with a blue overlay are pure black, while 
the areas with the red overlay are pure white. You can turn the clipping view off again by clicking on one 
of the triangles. You can also temporarily enable clipping view by holding down the J key at any time. The 
clipping view is useful when you are making adjusts to the brightness and contrast of your image. (See page 
69 for more information about using the clipping view.)

The Histogram pane also displays the RGB values under the cursor at the bottom of the pane.

THE INFO PANE

The Info pane displays metadata for the current image in an 
easy-to-read format. This metadata includes camera make and 
model; lens focal length; capture date and time; file type; ISO 
setting; shutter speed; aperture; and exposure compensation.

The Info pane also displays file-specific date, including name 
and image dimensions.

Note that, when editing a photo in Effects as a plugin from 
Lightroom Classic, Photoshop, Photoshop Elements, Affinity 
Photo, Corel Paintshop Pro, or Apple Photos, the Info pane is 
not visible.

Settings Applied

At the bottom of the Info pane is a section that shows all of the operations that have been applied to the 
current image. Clicking on the right arrow to the left of the label will display a list of every adjustment 
made, including cropping, retouching, filters used, and local adjustment layers. If an image has had any 
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adjustments made to it, that section of the Settings Applied area will be represented in white type, and 
you can use the arrows to the left of the label to drill down further into the Effects and Local Adjustment 
tabs to see which adjustments were made to an image. (On an image that has had no adjustments, all of the 
settings will be grayed out.)

Double-clicking on any of the available items inside the Settings Applied area will take you to that specific 
setting inside Effects, where you can make any desired changes.

THE HISTORY PANE

ON1 Effects 2023 has a robust Undo capability, which is 
helpful when you wish to back up a few steps during the 
editing process. When you want to go back further, it can 
be tedious to keep pressing Command/Control-Z. That’s 
where the history pane can be extremely useful. It displays 
every adjustment made during an editing session. From the 
History pane, you can scroll through your edits, all the way 
back to the state of your photo when you opened it for 
editing.

As you work, the History pane tracks all of your edits—
even when working with layered files—adding each change you make to the top of the pane. History 
displays not only the adjustment, but in many cases will display the settings of sliders in the various panes 
and filters. 

You can scroll through the list, and, if you click on an item, Effects will “roll back” your edits to the spot you 
clicked. You can click up and down in the list, and, as long as you don’t make any changes, the entire edit 
history is preserved. If you roll back to an edit and make a change, the History pane “resets” from that point 
on, losing any of the edits you made after the point you rolled back.

The History feature is designed to help you refine and understand the edits you made during an editing 
session; it not saved once you finish editing a photo.  

TIP: If you click on an item in the History pane, and you wish to step up or 
down in the adjustment history from that point, you can use the Undo/Redo 
commands to quickly go through the list. If you are happy with your edits, click 
back on the top item in the History pane to preserve the state of the photo.
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The Tool Well
The Edit module has 18 tools available for you when you are working on a photo, and are accessible via the 
Tool well on the left side of the screen. Some tools— Super Select AI, Transform (Move), Crop, and View—
are self-contained within the tool icons. Others are nested within a tool group—Local, Mask, Refine, and 
Fix—and are accessible via the Tool Options bar at the top of the screen when you click on one of those tool 
icons:

• Crop Tool: Trims an image to your desired size or ratio. Shortcut key: C

• Transform (Move) Tool: Moves and changes the size and rotation of your 
layer. Shortcut key: V

• Super Select AI Tool: Lets you select regions in an image by clicking on them 
and then applies Effects filters or local adjustments automatically to those 
regions. Shortcut key: K

• Adjustment Brush (Local group): Paints in or out local adjustments. Shortcut  
key: Shift+K

• Adjustable Gradient (Local group): Applies a selective gradient in local 
adjustment mode. Shortcut key: Option+K

• Masking Brush (Mask group): Mask large similar areas quickly. (Includes 
Perfect Brush option.) Shortcut key: B

• Masking Bug (Mask group): Applies a selective gradient as a mask in any 
filter (or to the entire stack). Shortcut key: M

• AI Quick Mask Tool (Mask group): Generates masks (for existing filters and 
local adjustments) by clicking on regions in a photo. Shortcut key: W

• Original Quick Mask Tool (Mask group): Create high-quality masks with only 
a few strokes as guidance. Shortcut key: Command-Option-Shift W (Mac); Control-
alt-Shift W (Windows)

• Line Mask Tool (Mask group): Create masks using straight lines, with the 
capability to add curves and adjust mask points. Shortcut key: Shift-P

• Refine Brush (Refine group): Lets you refine an existing mask’s edges, to 
help mask difficult areas, such as hair. Shortcut key: N

• Chisel Tool (Refine group): Removes fringes from the edge of a mask. Shortcut 
key: Shift-H

• Blur Tool (Refine group): Blurs the edges of a masked area to help it blend 
more naturally. Shortcut key: L

• Healing Brush (Retouch group): Paint over a distraction and a matching area 
of your photo is magically blended on top to replace it. Shortcut key: Q 

• Perfect Eraser (Retouch group): Removes distractions like signs and power lines.  
Shortcut key: Shift-Q

• Retouch Brush (Retouch group): Removes blemishes like dust spots and acne. (Includes 
Perfect Brush option.) Shortcut key: R

• Clone Stamp (Retouch group): Paints over an area from a sample of another area. Shortcut key: 
Shift-S
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• View Tool: Adjusts the magnification of the image in the Preview area, and lets you move 
around the Preview window. Shortcut key: Z

When working with nested groups, the icon of the currently selected tool will be visible in the Tool Well. 

NOTE: The tools in the Mask and Refine groups are only accessible once you 
have applied a filter or preset to your photo. Clicking on the Local group will 
automatically create a new local adjustment layer.

ACCESSING AND USING TOOLS

To access a tool, click on the tool or use the shortcut key. When selected, the cursor will change, and you 
will see a set of options for the tool in the Tool Options bar above the Preview window. If the selected tool 
is part of a tool group, you will see the other tools in that group, on the left side of the Tool Options bar.

ADJUSTING TOOL SIZING PARAMETERS

When using any of the tools that have Size and Feather options, you have multiple ways to adjust those 
parameters:

• In the Options Bar for each of those tools, you can use the slider in the Size and Feather 
fields to increase or decrease the amount.

• You can use the left and right bracket keys on your keyboard — ‘ [ ‘ and ‘ ] ’ — to adjust the 
size; additionally, hold down the Shift key to adjust the feather. 

• You can also use your mouse’s scroll wheel. Press Command-Option (Mac) or Control-Alt 
(Windows) and scroll to change the brush size. To change the feather, press Option-Shift 
(Mac) or Alt-Shift (Windows).

• You can also use your pressure-sensitive tablet, if you have one. Settings to turn that option 
on will be found in the Tool Options bar’s Gear menu for the tool.

NOTE: More information about the different ways that you can use your 
mouse’s scroll wheel can be found on page 21.

Each tool in Effects  has an Options Bar, where you can adjust the settings for that tool. Shown here are the options for the Refine Brush.
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CROP TOOL

This tool lets you crop your image, and is fully non-destructive in the Edit module. The tool also 
has a content-aware option that lets you expand the photo canvas, filling the edges of a photo’s 
frame with realistic detail.

To crop an image without content-aware fill, select the Crop tool from the Tool Well, which will display the 
crop overlay. Select any preset crop ratio you would like to use from the Options bar — the default is 
Freeform, which lets you crop in whatever size or ratio you would like. Choosing a preset size (like 4x6) will 
display the crop overlay at that chosen aspect ratio.

Adjust the corner handles of the crop overlay to get the area you wish. (The area outside the crop box 
appears darkened for guidance.) You can resize and move the image inside the crop box. When you are 
satisfied with your settings, press the Apply button in the Options bar or press Enter.

To move the image inside the crop box, simply click and drag inside the box. You can also nudge the image 
using the arrow keys on your keyboard. To resize the crop box, click and drag on any of the handles. 
Clicking on a corner handle allows you to adjust two sides at the same time; clicking on a side handle allows 
you to adjust that side. If you hold the Shift key down while adjusting the size, the box’s proportions are 
maintained. To rotate the crop box, move outside a corner until the tool changes to rotate.

To straighten an image, you can use the Leveling Tool, which is found in the Tool Options bar when the 
Crop Tool is active. Click on it, and drag the tool across an element in your image that should be level.

Crop overlays

When you select the Crop tool, Effects has the option to display guidelines as an overlay on top of your 
photo. These overlays can be used as compositional aids for cropping. Effects includes a number of overlays 

The Crop interface, with the Crop Preset pop-up open.
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that you can display during a crop session, and they can be accessed from the overlay pop-up menu in the 
Tool Options bar when the Crop tool is active. There are seven options — Rule of Thirds, Grid, Diagonal, 
Triangles, Golden Ratio, Golden Spiral, and None — and you can easily go back and forth between them as 
desired while cropping. 

In addition to overlay type, there are two other sets of options in the 
pop-up menu: 

• You can choose to have the overlay displayed all the time 
during a crop session, or to have Effects only display the 
overlay when your cursor is in the preview area of the 
workspace.

• When working with the Triangles or the Golden Spiral 
overlays, the Flip Overlay options will be visible, letting you 
flip the orientation of the overlays horizontally (Golden Spiral 
only) or vertically (Golden Spiral and Triangles).

Content-aware cropping

The content-aware feature lets you extend the crop beyond the edges of the frame. To use this, click the 
Content-Aware option in the Tool Options bar, and move the crop handle past the desired edge. When you 
click Apply, ON1 Effects will fill the expanded area with detail based on the content along the existing 
edge.

The Crop Overlay pop-up 
includes seven options for 
setting and displaying overlays.

When you select the Content-Aware option in the Tool Options bar, you can extend the canvas 
beyond the boundaries of the existing photo. Clicking Apply will fill the area based on the 
characteristics of the edges in the photo.
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Crop Tool Options Bar:

• Overlay pop-up: Selects a crop overlay, sets overlay visibility, and flips the overlay.

• Preset pop-up: Lets you choose from Freeform, constrained or custom preset ratios.

• Width: Sets the width of the crop box.

• Swap Dimensions: Swaps the width and height. Handy for rotating the crop box.

• Height: Sets the height of the crop box.

• Leveling Tool: Click and drag this tool across an element in your image that should be level.

• Angle: See and adjust the angle of rotation.

• Rotation tools: Rotates the photo 90° clockwise or counterclockwise.

• Reset: Resets the crop area to the size of your original photo.

• Cancel: Cancels the crop application and returns you to where you previously were in the 
Edit module.

• Apply: Applies the crop.

• Content-Aware: When clicked, will expand the canvas size, filling the edges of the photo with 
new detail, based on the area next to the expanded space.

Creating custom crop sizes

In addition to the preset crop 
ratios provided, you can create 
your own custom crop sizes. 
The bottom of the crop preset 
pop-up menu has a Custom 
submenu, which lists all of 
your custom ratios. To add a 
size, choose Manage Custom 
Sizes from the submenu. To 
add a new ratio, click the Add 
button, then enter a name, and 
the width and height ratio you 
wish to create (the units will always be “ratio” when you create a custom preset for the Crop tool). You can 
add as many as you’d like and click OK. The new crop ratios will appear in the Custom submenu.

TRANSFORM (MOVE) TOOL

The Transform tool is used to manipulate the contents of a layer, and works even if the only 
layer you have is the base photo layer. A layer may be repositioned, sized or rotated using the 
Transform Tool. When the tool is selected, handles will appear on the edges of the selected 
layer. You use these handles to manipulate the image. When you are done, click the Apply 

button in the Tool Options bar.

The Transform tool is layer-dependent, and each document layer can have its own transform operations. 
This can be useful when compositing photos, or applying backgrounds and textures in a multi-layered file. 

The bottom of the preset pop-up (above left) has a list of custom crop ratios that you can use in addition 
to the preset ratios. You can create your own presets via the Manage Custom Sizes submenu option, 
which opens the Custom Document Size Presets window (above right).
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Repositioning a layer

To reposition a layer, simply click and drag inside the transform box. You can also use the keyboard arrow 
keys to nudge a layer one pixel in any direction.

Resizing a layer

To resize a layer, click and drag on any of the transform handles. Clicking on a corner handle allows you to 
adjust two sides simultaneously. Clicking on a side handle allows you to adjust that side. If you hold the 
shift key down while adjusting the size, the proportions of the layer are maintained. If you hold down the 
Option (MacOS) or Alt (Windows) key while resizing, your image will resize from the center instead of from 
the edge. You can hold down Shift-Option (or Shift-Alt) to resize proportionally from the center.

You can type in the size you desire in the Tool Options bar (see below) in the width and height fields. You 
can also size a layer to fill the canvas automatically by pressing the Fill button in the Options Bar.

Rotating a layer

To rotate a layer, move the Transform Tool just outside a corner transform handle. Notice that the tool 
cursor changes to a rotate cursor. Now click and drag to rotate the layer. You can also use the opt (alt) left 
and right arrow keys to rotate a layer when the transform tool is selected. To rotate the layer quickly in 90 
degree increments, you can use the rotate left and rotate right buttons in the Tool Options bar.

Flipping a layer

You can flip a layer either horizontally or vertically by pressing the flip buttons in the Tool Options bar.

When you have completed your transforms you need to commit the changes. You can do this by pressing 
the Apply button that appears in the Tool Options bar or by pressing the Enter key. You can cancel a 
transform by pressing the Cancel button in the Tool Options bar or by pressing the Escape key.

Restoring a layer after a move

The Reset All command inside Effects will not reset transforms made with the Move tool. To reset your 
layer to its original, non-transformed state, click the Move tool and adjust any rotation you might have 
made, as well as any flip operations. Then choose the Fit to Canvas button. 

(For detailed information regarding Layers functionality, see “Part 4: Working with Layers” on page 104.)

Transform Tool Options Bar

• Width: Changes the width of the layer, in pixels.

• Height: Changes the height of the layer, in pixels.

• Scale: Proportionally scales the layer, in percentage.

• Rotation: Rotates the layer, by degrees.

• Rotate Left/Right buttons: Rotates the layer 90° clockwise or counterclockwise.

• Flip Horizontal/Vertical buttons: Flips the horizontal or vertical axis.

• Fill Canvas button: Scales the layer contents to fit the document size. 
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SUPER SELECT AI TOOL

The Super Select AI 
tool is a specialized 
selection tool that 
lets you make a 

selection (or multiple selections) 
and automatically apply a local 
adjustment or any Effects filter to 
the selected area.

To use this tool, select it from the 
Tool Well and move your cursor 
over the photo. As you move 
around the photo, Effects will 
display the various regions in your 
photo as red overlays; clicking on 
a region will create a selection 
and change the overlay for that 
area from red to blue. If there are 
additional regions you wish to select, hover over the new area and click. To remove a selection, click on it a 
second time.

When you have completed your selection, choose an option from the Apply pop-up menu in the Tool 
Options bar. The menu includes a Local Adjustment option, as well as all of the filters found in the Effects 
tab. Each option in the Apply menu includes all of the styles for that local adjustment or filter. You can see 
the effects of each option in real time on your photo as you scroll over each of the items. When you’ve 
selected your editing option, click Add, and Effects will create that local adjustment or filter — in either the 
Local or Effects tabs — and apply the adjustment to the chosen selection. 

If you would like to add another filter or local adjustment to the photo, you can make a new selection and 
choose the effect you with to apply. Clicking Add will add that enhancement to the photo. When you are 
finished adding adjustments, click the Done button; the Super Select AI tool will be deselected, and Effects 
will choose the Zoom tool.

The Mode menu in the Super Select AI Tool Options bar has two options: Paint In or Paint Out. Paint In 
will apply the final adjustment to the selection you created with the tool, while Paint Out will apply the 
adjustment to the areas to the inverse of the selection (i.e. the areas that have not been selected).

While the masks created by the Super Select AI are generated automatically, they operate like any other 
mask created in Effects. This means you can use any of the other masking and mask-refinement tools to 
adjust and refine the finished masks. (See “Masking Basics” on page 55 for more.)

Super Select AI Tool Options bar

• Apply: For choosing the local adjustment style (Local tab) or the Effects filter and style to be 
applied. 

When you pick the Super Select AI tool and hover over a region in a photo, Effects will display that 
area in red. Clicking on the area will create the selection — changing the overlay from red to blue. 
From there, you can choose to add a local adjustment layer or any Effects filter from the Apply menu.
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• Mode: Sets the masking mode for selections when using the Super Select AI tool. Paint In 
means that the local adjustment or filter will be applied to the selection; Paint Out means that 
the adjustment or filter will be applied to all areas in a photo except for the selection.

• Feather: After you have added an adjustment or filter (by clicking on the Add button), this 
option will apply a feather to the edges of the selection.

• Add: Creates the adjustment layer or the Effects filter based on the current selection.

• Done: Quits the tool and selects the Zoom tool.

ADJUSTMENT BRUSH (LOCAL GROUP)

The Adjustment Brush, which works within the Local Adjustments tab, works like a standard 
brush tool, with adjustable sizes, feathering and opacity. You can paint an adjustment in or out 
via the Mode pop-up in the Tool Options bar, and adjust the size and feathering of the brush via 
the bar or with the bracket keys on your keyboard. The Adjustment Brush is especially powerful 

when used with the Perfect Brush option, represented by its icon at the right of the Tool Options bar 
(shown on the right).

The Perfect Brush option incorporates a color-based, self-masking technology to help create precise 
selections and masks. When you turn the Perfect Brush option on, the Adjustment Brush collects the colors 
under the center of the brush and applies the effect only to those colors. This protects the adjustment from 
being applied across edges. A great of example of using the Perfect Brush would be if you wanted to darken 
the sky in an image, but didn’t want to darken a group of mountains on the horizon.

The Threshold slider will allow you to control the balance between keep and drop colors, based on the area 
you are working on. For example you may want the Perfect Brush to be very precise and only paint away 
very similar colors, other times you want it to paint away a broad range of colors in the same neighborhood.

The Transition slider controls the feather of the Perfect Brush based on color. To create a soft edge, 
increase the transition. To create a harder edge you need to decrease the transition.

TIP: You can toggle the Perfect Brush using Command–R (MacOS) or Control-R 
(Windows). You can also temporarily lock the color to remove by holding 
down the Command (Mac) or Control (Windows) key. This can be useful when 
brushing through areas with a lot of openings, like tree branches.

ON1 Effects lets you mask with custom brush shapes when you are using either the Adjustment Brush or 
the Masking Brush. When you use a custom brush on an adjustment layer, in conjunction with that layer’s 
Paint with Color option, you can add overlays and other embellishments. When used with custom brushes, 
the Manual Spacing option lets you control the distribution of the strokes as you brush. (See page 55 for 
more detailed information about masking brush techniques with any of the masking tools.

Adjustment Brush Tool Options

• Style: The Style pop-up lets you save brush information to use at another time. Selecting a 
saved item from the menu will open that saved brush’s characteristics.
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• Shape: The Shape menu displays a list of all custom brush shapes in your library. The top item 
in the list is the default, round brush.

• Paint Mode: The paint mode controls if you are painting out (hiding the effect) or painting in 
(restoring the effect). You can tell your current mode by looking at the plus or minus icon in 
the center of the brush. If the icon is minus, you are painting out, and if the icon is a plus, you 
are painting in. You can change the mode in the Tool Options bar, or by pressing the X key, or 
by holding down the Option (Mac) or Alt (Windows) key temporarily.

• Brush Size: You can control the size of the brush using the Size pop-up. Use a small brush at 
high magnification for precise work, and a large brush at fit to screen for general work. 

• Feather: This controls the amount of feathering—or hardness—of the brush. The feather has 
a range from 1 to 100 percent. Use a small feather at high magnification for precise, hard-
edged work and a large, soft-edged brush in ‘Fit to screen’ view mode for general work. You 
can visually see your feather by watching the outer concentric circle of the brush tool. In 
addition to the Feather pop-up, you can adjust the size of the feather by holding down the 
Shift key and pressing the right or left bracket keys on your keyboard.

• Opacity: You can control the opacity, or strength of the brush with the Opacity pop-up in the 
Tool Options bar. The opacity has a range from 1 to 100 percent. You use a high opacity to 
paint quickly and hide large areas. You use a lower opacity for blending areas together or for 
subtle work. You can control the amount of opacity in several ways:

• Use the Opacity pop-up in the Tool Options bar.

• Press Option (Mac) or Alt (Windows) and press one of the number keys. Each number 
represents an opacity percentage from 10% (1) to 90% (9); 0 represents no opacity.

• Use your pressure-sensitive tablet.

TIP: Think of the opacity as the shade of gray you are painting onto your 
mask. While white in a mask represents 100% of an effect showing and black 
represents no effect showing, all opacity settings in between will show a 
percentage of the effect. This can be very useful when you wish to blend masks 
in a realistic manner.

• Flow: This is the rate at which the brush is applied, up to the Opacity setting. With a low 
flow number, as you brush back and forth across a stroke, the brush color will build up to the 
Opacity setting. At a flow of 100, the brush stroke will be at the Opacity setting. 

• Angle: This sets the angle of the current brush shape. For the default, round brush shape, this 
setting has no effect; it is more useful when working with custom brush shapes. You can also 
rotate the brush shape by pressing Shift-Option (Mac) or Shift-Control (Windows) and the left 
or right bracket keys (‘[‘ or ‘]’).

Clicking the gear icon at the left of the Tool Options bar gives you options for the Perfect Brush, brush 
spacing and support for pressure-sensitive tablets:

• Perfect Brush: The Perfect Brush incorporates an automatic edge-detection 
technology to help create precise selections and masks. When you turn the option 
on—by clicking on the Perfect Brush icon in the Options bar—the Masking Brush 
collects the colors under the center of the brush and applies the effect only to 
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those colors. This protects the adjustment from being applied across edges, such as tree 
branches. 
	 Further settings for the Perfect Brush can be found by clicking 
on the gear icon in the Tool Options bar. It has these options:

• Color Threshold: This option lets you control the balance 
between keep and drop colors, based on the area you 
are working on. For example, you may want the Perfect 
Brush to be very precise and only paint away very similar 
colors, while at other times you want it to paint away a 
broad range of colors in the same neighborhood.

• Transition: This slider controls the feather of the Perfect 
Brush based on color. To create a soft edge, increase 
the transition. To create a harder edge, decrease the 
transition amount.

• Manual Spacing: When checked, this sets the spacing of the 
brush tip as you apply a stroke. This is primarily used when 
painting with custom brushes. See page 59 for more. 

• Pressure options: Effects supports pressure-sensitive tablets 
from Wacom with the Masking Brush. You can enable pressure sensitive controls for the 
brush size, brush opacity, or both simultaneously. To turn this support on, click on the gear 
icon in the Tool Options bar. You can activate pressure sensitivity for both size and opacity by 
clicking the appropriate buttons in the drop-down menu.

Detailed information on using Local Adjustments in ON1 Effects 2023 starts on page 98. There is also a 
short section, “Masking Basics” on page 55, that includes best practices for using the different masking 
tools in Effects.

NOTE: The Adjustment Brush can also be used to apply custom brushes to an 
adjustment layer. See “Using Custom Brushes to Add Overlays” on page 101.

ADJUSTABLE GRADIENT TOOL (LOCAL GROUP)

The Gradient Adjustment tool is very similar to the Masking Bug, but it is solely for use within 
the Local Adjustments tab. It lets you create a linear or radial gradient mask across part of your 
image, The gradient mask goes from dark to light in tone, applying more of the adjustment where 
the gradient is lighter, and less of the adjustment where the gradient’s tone is dark. The most 

common use of gradient masks is to darken the sky in an image, while preserving the brightness of the 
foreground, similar to using a gradient filter on your camera lens.

To apply a standard gradient to a local adjustment, click on the tool, then click in the image roughly where 
you wish the effect to be. You’ll see the outline of the gradient, which is called a bug. You can use the 
handles on the bug to move your gradient, increase or decrease the length of the gradient, or rotate it.

You can change the gradient shape via the Tool Options bar: in addition to the standard dark-to-light 
horizontal gradient, you can also create a circular gradient and a reflected gradient, which is like the 
horizontal gradient, but goes from black (no effect) at the outer edges to white (full effect) in the center.

Perfect Brush, spacing and Wacom 
tablet options can be found in the gear 
menu  drop-down.
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Adjustable Gradient Tool Options Bar:

• Preset: The preset pop-up includes several common ways to use the Gradient Adjustment 
tool (top down, bottom up, left and right, and circular vignettes), and changes the current bug 
(if there is one) to match the preset.

• Shape: Controls the shape of the bug. In addition to 
the standard Gradient and the Reflected Gradient, 
there are two radial shapes: Center, which puts the 
light tones at the center and the dark tones on the 
outside of the mask, and Edges, which sets the 
gradient in the opposite direction.

• Opacity: Sets the maximum opacity or density of the 
mask.

• Add: Adds a new gradient using the current settings.

• Delete: Deletes the current gradient.

• Reset: Resets the mask on the layer completely. This removes all 
gradients and clears any brushing that has been done.

Manipulating Gradient Masks

Once you’ve added a gradient to an image, you can modify it by accessing the 
parts of the gradient overlay:

• To move a gradient, click on the big circle at the center of the 
gradient and drag.

• To resize a radial gradient, click and drag on the solid line.

• To adjust the feather (hardness) of the mask, click and drag along 
the dashed line.

• To rotate the mask, click the smaller circle near the gradient center and drag.

Detailed information on using Local Adjustments in ON1 Effects 2023 starts on page 98.

MASKING BRUSH (MASK GROUP)

The Masking Brush is one of two tools used for masking filters in Effects, as well as layer masks. 
When you select the Masking Brush, your cursor changes to look like two concentric circles, one 
representing the inner hard edge of the brush, and soft outer, feathered edge of the brush. At the 
center of the brush is either a plus or minus. The plus means that you are painting “in” a filter’s 

effect, while minus means the brush mode is set to paint out.

The Preset (left) and the Shape (right) options for the 
Adjustable Gradient tool.

The Edges gradient shape lets you 
create such masking effects as 
customized, adjustable vignettes.
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Masking Brush Tool Options

• Style: The Style pop-up lets you save brush information to use at another time. Selecting a 
saved item from the menu will open that saved brush’s characteristics.

• Shape: The Shape menu displays a list of all custom brush shapes in your library. The top item 
in the list is the default, round brush.

• Paint Mode: The paint mode controls if you are painting out (hiding the effect) or painting in 
(restoring the effect). You can tell your current mode by looking at the plus or minus icon in 
the center of the brush. If the icon is minus, you are painting out, and if the icon is a plus, you 
are painting in. You can change the mode in the Tool Options bar, or by pressing the X key, or 
by holding down the option (alt) key temporarily.

NOTE: If you would like to invert the mask (turn it from black to white), in 
order to paint a filter’s effect into your image, select the Masking Brush tool, 
then choose Invert Mask from the Mask menu.

• Brush Size: You can control the size of the brush using the Size pop-up. Use a small brush at 
high magnification for precise work, and a large brush at fit to screen for general work.

• Feather: This controls the amount of feathering—or hardness—of the brush. The feather has 
a range from 1 to 100 percent. Use a small feather at high magnification for precise, hard-
edged work and a large, soft-edged brush in ‘Fit to screen’ view mode for general work. You 
can visually see your feather by watching the outer concentric circle of the brush tool. In 
addition to the Feather pop-up, you can adjust the size of the feather by holding down the 
Shift key and pressing the right or left bracket keys on your keyboard.

• Opacity: You can control the opacity, or strength of the brush with the Opacity pop-up in the 
Tool Options bar. The opacity has a range from 1 to 100 percent. You use a high opacity to 
paint quickly and hide large areas. You use a lower opacity for blending areas together or for 
subtle work. You can control the amount of opacity in several ways:

• Use the Opacity pop-up in the Tool Options bar.

• Press Option (Mac) or Alt (Windows) and press one of the number keys. Each number 
represents an opacity percentage from 10% (1) to 90% (9); 0 represents no opacity.

• Use your pressure-sensitive tablet.

TIP: Think of the opacity as the shade of gray you are painting onto your 
mask. While white in a mask represents 100% of an effect showing and black 
represents no effect showing, all opacity settings in between will show a 
percentage of the effect. This can be very useful when you wish to blend masks 
in a realistic manner.
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• Flow: This is the rate at which the brush is applied, up to the Opacity setting. With a low 
flow number, as you brush back and forth across a stroke, the brush color will build up to the 
Opacity setting. At a flow of 100, the brush stroke will be applied at the Opacity setting.

• Angle: Sets the angle of the current brush shape. For the default, round brush, this has no 
effect; it solely for working with custom brushes. You can rotate the brush shape by pressing 
Shift-Option (Mac) or Shift-Control (Windows) and the left or right bracket keys (‘[‘ or ‘]’).

Clicking the gear icon at the left of the Tool Options bar gives you options for the Perfect Brush, brush 
spacing and support for pressure-sensitive tablets:

• Perfect Brush: The Perfect Brush incorporates an automatic 
edge-detection technology to help create precise selections and 
masks. When you turn the option on—by clicking on the Perfect 
Brush icon in the Options bar—the Masking Brush collects the 
colors under the center of the brush and applies the effect only 
to those colors. This protects the adjustment from being applied 
across edges, such as tree branches. 
	 Further settings for the Perfect Brush can be found by clicking 
on the gear icon in the Tool Options bar. It has these options:

• Color Threshold: This option lets you control the balance 
between keep and drop colors, based on the area you 
are working on. For example, you may want the Perfect 
Brush to be very precise and only paint away very similar 
colors, while at other times you want it to paint away a 
broad range of colors in the same neighborhood.

• Transition: This slider controls the feather of the Perfect 
Brush based on color. To create a soft edge, increase the 
transition. To create a harder edge, decrease the transition amount.

TIP: You can toggle the Perfect Brush using Command–R (MacOS) or Control-R 
(Windows). You can also temporarily lock the color to remove by holding 
down the Command (Mac) or Control (Windows) key. This can be useful when 
brushing through areas with a lot of openings, like tree branches.

• Manual Spacing: When checked, this sets the spacing of the brush tip as you apply a stroke. 
This is primarily used when painting with custom brushes. See “Using Custom Brushes to Add 
Overlays” on page 101 for more. 

• Pressure options: Effects supports pressure-sensitive tablets with the Masking Brush. You 
can enable controls for the brush size, brush opacity, or both simultaneously. To turn this on, 
click the gear icon in the Tool Options bar. You can activate pressure sensitivity for size and 
opacity by clicking the appropriate options in the drop-down menu.

Detailed information on using Local Adjustments in ON1 Effects 2023 starts on page 98. There is also a 
short section, “Masking Basics” on page 55, that includes best practices for using the different masking 
tools in Effects.

Perfect Brush, spacing and Wacom 
tablet options can be found in the gear 
menu  drop-down.
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MASKING BUG (MASK GROUP)

The Masking Bug is used for blending layers by creating radial, gradient and reflected gradient 
mask shapes quickly. It works in a similar manner to the Adjustable Gradient tool in the Local 
Adjustments pane. The mask goes from dark to light in tone, applying more of the adjustment 
where the gradient is lighter, and less of the adjustment where the gradient’s tone is dark. The 

most common use of gradient masks is to darken the sky in an image, while preserving the brightness of the 
foreground, similar to using a gradient filter on your camera lens.

To apply a standard gradient to a filter, click the 
Masking Bug, then click in the image roughly where you 
wish the gradient to go. You’ll see the outline of the 
gradient, which is called a bug. You can use the handles 
on the bug to move your gradient around, increase or 
decrease the length of the gradient, or rotate it.

You can change the gradient shape via the Tool Options 
bar: in addition to the standard dark-to-light horizontal 
gradient, you can also create a circular gradient and a 
reflected gradient, which is like the horizontal gradient, 
but goes from black (no effect) at the outer edges to 
white (full effect) in the center.

Masking Bug Tool Options Bar:

• Preset: The preset pop-up includes several common ways to use the tool (linear top down, 
linear bottom up, left and right, and circular vignettes), and changes the current bug (if there 
is one) to match the preset.

• Shape: The shape pop-up controls the shape of the bug. In addition to the standard Gradient 
and the Reflected Gradient, there are two radial 
shapes: Center, which puts the light tones at the 
center and the dark tones on the outside of the mask, 
and Edges, which sets the gradient in the opposite 
direction.

• Opacity: Sets the opacity, or density, of the mask.

• Add: Adds a new gradient using the current settings.

• Delete: Deletes the current gradient.

• Reset: Resets the mask on the layer completely. This removes all gradients and clears any 
brushing that has been done.

Manipulating a Gradient Mask

Once you’ve added a gradient to an image, you can modify it easily by accessing the following parts of the 
gradient overlay:

• To move a gradient, click on the large circle at the center of the gradient and drag.

In this image, a Dynamic Contrast filter has been applied in Effects. 
To keep the effect out of the clouds, a Masking Bug has been added.

The Preset (left) and the Shape (right) options for the 
Adjustable Gradient tool.
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• To resize a radial gradient, click and drag on the solid line.

• To adjust the feather (or hardness) of the mask, click and drag along the dashed line.

• To rotate the mask, click on the smaller circle near the center of the gradient and drag.

TIP: To see the mask created by the Masking Bug, and the range of black to 
white tonality, choose Show Mask from the View menu. You can choose either 
a red overlay, which presents the mask over your image, or grayscale, which just 
shows the mask as black to white tones.

Working with Multiple Masking Bugs

You can have up to six Masking Bugs per layer. Each bug is re-editable when you’re using Effects as a 
standalone app, or when you use Smart Object option from within Photoshop (see page 1 for more).

To add another Masking Bug, press the Add button or click outside of the current bug while the Masking 
Bug tool is selected.

Only one Masking Bug may be adjusted at a time. You will see the overlay controls for the active bug while 
your mouse is over the preview area. Inactive bugs are marked with a small circle; to select an inactive bug 
clicking on this small circle marker.

Masking Bugs are subtractive. Each bug hides more and more of the current layer. When Masking Bugs 
overlay each other they may hide more of the layer too. You can always use the Masking Brush to override 
and paint areas back in hidden by the Masking Bugs.

You can resize, move and rotate gradient masks using the lines and handles in the masking bug overlay.
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AI QUICK MASK TOOL (MASK GROUP)

The AI Quick Mask tool is functionally similar to the Super Select AI tool, but it is intended to 
create selections for the current filter, local adjustment, or layer — all it does it create a mask 
for that item. It does not create a new filter pane or adjustment layer.

To use the Quick Mask tool, first create a filter in Effects, a local adjustment layer in the Local tab, or on 
the master layer mask. Select the AI Quick Mask tool, and move your cursor over the photo. As you move 
around the photo, Effects will display the various regions in your photo as red overlays; clicking on a region 
will create a selection and change the overlay for that area from red to blue. If there are additional regions 
you wish to select, 
hover over the new area 
and click. To remove a 
selection, click on it a 
second time.

The Mode menu in the AI 
Quick Mask Options bar 
has two options: Paint In 
or Paint Out. Paint In will 
apply the final adjustment 
to the selection created, 
while Paint Out will 
apply the adjustment to 
the areas to the inverse 
of the selection (i.e. the 
areas that have not been 
selected).

While the masks created 
by the Quick Mask 
tool are generated 
automatically, they 
function like any other 
mask created in Effects. This means you can use the other masking tools to adjust and refine the finished 
masks. This also includes the Mask Control options found in all Effects filters, local adjustments, and in the 
layer masks. (see “Masking Basics” on page 55 and “Masking control options” on page 57.)

AI Quick Mask Tool Options bar

• Mode: Sets the masking mode for selections. Paint In means that the local adjustment or 
filter will be applied to the selection; Paint Out means that the adjustment or filter will be 
applied to all areas in a photo except for the selection.

• Cancel: Cancels the operation, deselecting the tool and selecting the Zoom tool.

• Done: Creates the mask for the current filter, adjustment or layer and selects the Refine 
brush.

Use the AI Quick Mask tool instead of the Super Select AI tool when you wish to create an AI-generated mask, 
but already have an existing Effects filter or local adjustment layer, or when you want to add a mask to the 
current layer in your document.
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ORIGINAL QUICK MASK TOOL (MASK GROUP)

The Original Quick Mask tool (known as the AI Quick 
Mask tool in previous versions of ON1 Effects) can 
create high-quality masks with just a few strokes as 
guidance. To use it, just mark areas you want to keep in 

green and areas you want to drop in red. When you click Apply, the 
Original Quick Mask tool analyses the color, tone and texture of 
the marked regions to learn what you want to make out and then 
automatically finds the edges and creates the mask for you.  

NOTE: The Original Quick Mask tool resets any existing mask in the current 
filter, local adjustment or layer.

Here are the steps you need to follow to use the Original Quick Mask Tool:

1.	 First, you need to give the tool guidance as to what you want to keep and drop. This is done 
by loosely painting over the regions in your photo. There is no need to precisely paint the 
entire photo: just a few representative strokes of red and green are all that are needed. Paint 
with Drop mode—which is the default brushing mode—over the portions of your image that 
you want to remove. These brushstrokes will appear in red. Then change the tool’s mode to 
Keep (via the Tool Options bar, or by holding the Option/Alt key) and paint over the areas 
you want to keep. These strokes will show up as green.

2.	 Now press the Apply button in either the Tool Options bar or the Original Quick Mask HUD. 
This will generate a temporary mask to preview the results. Areas that are filled with red will 

When you first open the AI Quick Mask tool, you’ll 
see  a window—called the HUD—that includes 
instructions for using the tool.
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be masked out, areas in green will remain. Keep in mind the edges will appear rough at this 
point and will be smoothed out when you generate the final mask.

3.	 If the preview results look good, press the Done button in the Tool Options bar or the 
Original Quick Mask HUD. If there are areas that are incorrect, you can continue to improve 
the results by adding more Keep and Drop strokes. Press Apply each time to preview the 
improved results. When you press Done, the edges are refined with high precision and 
Effects switches to the Refine Mask tool, which you can use over difficult, semi-transparent 
areas—like tree branches—if necessary.

Original Quick Mask Tool Options Bar 

• Mode: This controls keeping (painting green) or dropping (painting red). Green areas are 
protected in your mask, and are the areas of a layer or filter that will remain. The areas 
marked in red will be removed or masked. In your layer these areas will become transparent. 
On a filter in Effects, these areas will have the filter’s effect removed.  
	 You can tell your current mode by looking at the plus or minus icon in the center of the 
Original Quick Mask brush. If the icon is minus, you are painting drop (red) areas; if the icon is 
a plus, you are painting keep (green) areas. You can change the mode in the Tool Options bar, 
or by pressing the Shift-X key, or by holding down the Option (Alt) key temporarily. 

• Brush Size: You can control the size of the brush using the Size pop-up. Use a small brush at 
high magnification for precise work, and a large brush at fit to screen for general work. You 
can control the size of the brush several ways: 

Further settings for the Original Quick Mask tool can be found by clicking on the gear icon in the Tool 
Options bar. There, you can set the following options (shown below): 
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• Pressure Adjusts Size: This option lets you control the size of the brush using a pressure 
sensitive tablet. The harder you press, the larger the brush becomes up to the current setting 
of the size slider.  

• Refine Edge: This applies the Refine Mask Brush automatically to the edge of the resulting 
mask, creating a more natural transition. This is on by 
default and recommended for most photos.

• Show HUD: This displays the Original Quick Mask 
HUD dialog (shown on page 44), which provides 
guidance on how to use the tool.

• Overlay: Sets the transparency of the red and green 
mask overlays on top of your image. A setting of 100 
displays only the mask; the default setting is 50.

LINE MASK TOOL (MASK GROUP)

The Line Mask tool lets you create masks by drawing straight lines in your image, with the added 
flexibility of letting you adjust each individual line segment into curves to better fit the object you 
want to mask. Masks created with this tool are re-editable, can be copied and pasted like any 
other mask inside Effects, and you can have multiple Line Mask selections for each mask. 

To start, you click and drag along the outline of the area you wish to mask. Clicking your mouse button (or 
with a pen and tablet) adds a point to the line; you can continue to click along the edges of your desired 
selection, and the tool will add points along the way. These points will be represented by a small square. 
When you’re finished, hover your cursor over the first point and click on it to close the path created by 
the tool. This will close the selection and change the cursor to a paint bucket icon; click inside the area and 
Effects will create and the display the mask. 

Once you’ve closed the mask, you can adjust the feather 
and opacity of the mask, and you can further adjust the 
points on the line in the following ways:

• You can click on any point in the selection and 
move it by dragging it.

• If you hover (or click) on a point, you’ll see 
a circle appear between that point and the 
previous point on the line. This circle can be 
dragged in all directions to curve the line to 
better fit the object you are masking.

• Add a point by holding down the Shift key and 
clicking on the line.

• You can delete any point by right-clicking on it 
and choosing Delete Point from the pop-up. 

• You can delete the entire mask by choosing 
Delete Line Mask from the pop-up menu.

While you’re creating the mask, the curve option is always available for the current point; move the cursor 
back over the line before the point and the circle will appear. You can then drag the curve in or out, and 

When you complete the mask area by clicking on the original 
point, the cursor will change to a paint bucket icon. Clicking in the 
area will generate the mask, and let you adjust any of the points, 
or add curves for further refinement of the mask edge..
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when you’re done, move the cursor and click on the next place you wish to add a point.

When you’ve made your adjustments to the selection, 
you can click the Done button in the Tool Options bar to 
quit the tool, or you can create another mask. 

To re-edit the mask at a later time, select the filter, layer, 
or adjustment layer that has the mask attached to it and 
choose the Line Mask tool. When you move your cursor 
over the area that contains the mask, the mask’s outline 
will appear in light blue. Click anywhere on the outline, 
and the mask’s points — both square and circle — will 
appear, and you can adjust it as you see fit, even the 
Opacity and Feather settings.

Line Mask Tool Options Bar

• Mode: The mode controls if you are painting out (hiding the effect inside the mask 
boundaries) or painting in (showing the effect).

• Opacity: This controls the opacity, or transparency of the finished mask, from 1 to 100 
percent. At 100 percent, all of the effect will be displayed in the mask area; as the opacity 
level drops, more of the layer underneath the mask will be visible.

• Feather: Controls the hardness of the mask edge. The feather has a range from 1 to 100; 
1 being a hard edge across the boundaries of the mask, 100 being a soft, wide edge that 
‘feathers’ the transition between the masked and unmasked boundaries. 

• Delete: Removes the currently selected line mask.

• Done: Saves the current line masks ad closes the tool, returning Effects to the View Tool. 

REFINE BRUSH (REFINE GROUP)

This tool, one of the most versatile in Effects, can be used to clean up intricate areas and the 
borders along a mask. It is helpful for cleaning up a mask created with the Masking Brush, the 
Super Select AI tool, or other masking tools, or for creating a new mask entirely. 

When you paint with the Refine Brush, the brush strokes are displayed as a red overlay, and when you let 
up off the mouse button, Effects will work to make the mask edge better defined. 

Refine Brush Tool Options

• Mode: Controls the refinement mode, either Paint Out, which refines to remove from the 
mask, Paint In, which refines to add to the mask, or Auto, which determines the best way to 
refine the mask edge. Paint Out is recommended in most cases.

• Size: This adjusts the size of the brush. Select a brush size that is just larger than the 

The curve option—visible when you hover over a point in the 
selection—lets you fine tune the line to make it better fit the 
object you’re masking. (Shown here exaggerated for effect.) 
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intersection of the subject and background. Avoid using oversized brushes it will take longer 
to process and may yield lower quality results. You can use your mouse’s scroll wheel to 
adjust the size of the brush as well (see page 21). Unlike the other masking brushes in 
Effects, the Refine Brush has a maximum size of 500 pixels.

• Method: Lets you choose the refinement algorithm and settings 
based on the subject of the masked area. There are five method 
types, plus a user-defined setting that is created when you adjust 
any of the individual parameters found in the Gear menu:

• Original: Uses the refinement algorithm found in earlier 
versions of Effects (referred to as Mode 1 in the gear 
menu).

• Hair/Branches: Optimized for fine detail, like hair, 
branches and other subjects.

• Hard Edges: Best method for refining masks with distinct edges between masked and 
unmasked areas.

• Diffuse Edges: Works best on areas where edge detail is not as well-defined.

• Noisy Images: Works well on photos that have higher degrees of noise in them.

The Gear menu includes a setting for controlling the size of the Refine Brush with pressure. It also can be 
used to adjust any of the refine methods in the Method menu. The parameters include:

• Mode (1 or 2): As noted above, Mode 1 is the Refine Brush 
algorithm used in previous Effects versions; it remains useful in 
many masking situations. Mode 2 uses the new (2023) version 
of the Refine algorithm.

• Sensitivity (0-100): Refers to the edge sensitivity; low for 
diffuse edges, high for hard edges. (Works only with Mode 2)

• Locality (0-30): This parameter varies the search for similar 
scene materials; higher values expand the search zone along 
the brush edges. (Mode 2 only)

• Smoothness (0-100): Represents post-processing smoothing 
of the refine results. Higher numbers mean smoother edges. 
(Mode 2 only)

• Noise (0-100): This is a post-processing-based noise filter; use 
higher values with noisier images. (Works with both Mode 1 and 2)

When you change any of the parameters in the Gear menu, those 
results will be applied to the User Defined settings, and will be saved 
until you change them again. In general, however, most of your masking 
refinement work with the Refine Brush should be found in one of the five primary Method options.

Working with the Refine Brush

One of the biggest issues with masks is the transitions between edges, or in areas where one of the  
primary masking tools will miss some fine detail. You’ll notice these transitions when you apply an effect or 
adjustment to a masked area, and there will be halos on the mask edges, or areas where the effect should 

The Method pop-up.

The Gear menu for the Refine Brush has 
options that let you fine-tune the brush 
settings, and saves them in the User 
Defined option for the Method pop-up.
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be applied, but isn’t. The Refine Brush, and, on occasion, the Chisel and Blur tools, can be used to help you 
fine-tune your masks and better transitions, ultimately creating more realistic masks. 

The Refine Brush is often the first place you’ll want to go when working with masks that could use some 
tuning. Some of the most common operations include:

• You can paint along the edges of a mask that might have areas where the mask isn’t complete, 
or where the transitions between masked and unmasked areas could be smoother. 

• You can paint over large areas of a masked area where there might be fine edges that could 
use further refinement, like trees or hair.

• You can also “encircle” an area in a photo where you wish to add to or subtract from a mask, 
or even create a new mask altogether. 

For simple areas where you wish to refine an edge that has some halos or is otherwise a bit less than ideal, 
set the brush size a bit larger than the area you wish to tune set the appropriate method, and brush over 
the edge. This is shown in the enlarged area below. 

With tree branches, hair and other areas of fine detail, you can paint over the entire area that you wish the 
mask to refine, as shown in the following graphic.

In the photo above, a local adjustment on the sky, masked with Mask AI, left some ugly halos along a treeline. Using the Refine Brush, set to the 
Diffuse Edges method, smoothed the transition properly, making for a better mask. (Effect exaggerated for demonstration purposes.) 

The Refine Brush is a great choice for adjusting masks with fine details that are often obscured when building masks with some of Effects’ primary 
masking tools. In the screen shots above, you can see the mask of a tree generated automatically with the Mask AI pop-up in a local adjustment 
layer (left). The tree’s interior branches are completely masked. Selecting the Refine Brush, with the Method set to Hair/Branches, we’ve painted 
broad strokes in and around the area where the branches are (center). Effects then refines the mask so that the branches are properly masked 
against the sky, making for a much more realistic mask.
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The Refine Brush’s “encircling method” lets you add to or subtract from an existing mask, or you can use it 
to create your own mask. To do this, use the brush to draw an outline 
around the object you wish to select and mask. What happens next 
depends upon what your intent is, and whether there is already a mask in 
the local adjustment or Effects filter you are currently working with:

• If there is a mask already created, and you wish to remove the 
stroked area, choose Paint Out before applying the brush. If you 
wish to add to the existing mask, choose Paint In.

• If there is no mask already present in the adjustment or filter, 
using the Refine Brush and drawing around an object or area 
will create a mask of the encircled space.

For more information about masking inside Effects, see “Masking Basics” 
on page 55. 

CHISEL MASK TOOL (REFINE GROUP)

The Chisel tool, accessible vie the Refine Tool Options, bar works to remove fringes or halos 
along the hard edges of a mask; just click and drag along the edges of a mask you wish to refine. 
Fringes are common when the background to be removed is brighter than the foreground. The 
chisel works like a chisel or plane in a wood shop: It removes just a sliver along the edges, and, 

because it only works on the edges, you don’t have to be too careful when using it.

Chisel Mask Tool Options

• Mode: Select remove or add

• Size: Adjusts the size of the tool. Use a large chisel to make brushing fast. (The size of the 
chisel does not affect how much is chiseled off.)

• Amount: Controls the amount of pixels that will be removed or added during each stroke.

TIP: Double-click on the Chisel tool to apply the chisel to the entire mask edge.

The encircling method.
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BLUR MASK TOOL (REFINE GROUP)

The Blur Mask tool softens edges of the mask where you paint; all you need to do is run the tool 
over the edges you wish to blur. Softening the edges on blurred or semi-transparent subjects like 
hair can make them blend with a new background in a more realistic manner. 

Blur Mask Tool Options

• Mode: Remove/Add/Normal lets you adjust what part of the mask edge to blur. Remove blurs 
and lightens the mask, Add blurs and darkens the mask, Normal blurs both light and darks.

• Size: Adjusts the size of the blur tool. Feel free to use a large size to make brushing fast. The 
size of the brush does not affect the blur amount.

• Amount: Controls the amount of blur. Use a low amount to maintain detail.

TIP: Double-clicking the Blur tool icon applies the blur to the entire mask edge.

HEALING BRUSH (RETOUCH GROUP)

The Healing Brush is a tool for 
removing distractions like dust 
spots, power lines and unwanted 
people from your photos, using 

sophisticated content-aware fill technology. 
Like the other retouching tools, you can 
apply the brush to multiple portions of an 
image. Unlike the other tools, however, the 
Healing Brush is fully non-destructive: each 
area you apply the brush to is individually 
editable (and removable).

To use the brush, paint over a distraction 
and a matching area of your photo will be 
blended on top to replace it, using content-
aware technology. You’ll see two circular 
markers: red, which is the area that has been 
removed, and green, which is the area that was used to fill the source. Each marker is movable by clicking 
and dragging; sometimes, you’ll want to try a different area to match to your source. Non-active markers 
will be displayed as gray squares until you click on them. (Press the Delete key to remove the current area.)

The Healing Brush has four modes, Heal, Stamp, Copy and Move. Each mode has a different approach:

• Heal mode applies content-aware matching from a nearby area to mask the object or area 
being painted out.  

Areas that use the Healing Brush will be displayed as a gray marker. Clicking on a 
specific marker will let you readjust its placement or delete it.



ON1 Effects 2023 User Guide	 Part 2: Working in Effects	 52

• Stamp mode acts like the Clone Stamp tool (see page 54), applying the actual pixels from 
the area used to mask the object out; unlike that tool, however, this option is non-destructive.

• Copy mode is similar to the Heal mode, except that it makes a copy of the brushed area or 
object instead of masking it out.

• Move mode is similar to Copy mode, except that it masks the brushed area and moves the 
original area to a new location.

Healing Brush modes cannot be changed once they have been applied; if you wish to change the 
application in an area, you must select the old marker, choose Delete from the Tool Options bar, set the 
new mode, and re-brush the chosen area. 

Healing Brush Options

• Brush Size: Adjusts the overall size of the brush.

• Brush Feather: Adjusts the hardness of the brush. 

• Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an 
imperfection. Use a lower opacity to soften it.

• Mode: sets the type of healing that will be applied when brushing — Heal (content-aware), 
Stamp (pixel-exact), Copy (content-aware) or Move (content-aware).

• Pressure Adjusts Size: If you have a pressure sensitive tablet, you can adjust the size of the 
brush according to the pressure. Click the button to activate.

Transforming retouched areas

As noted, all applications of the Healing Brush 
are non-destructive, meaning that you can 
adjust the source and destination areas for 
each marker, and you can delete markers 
by clicking on the appropriate market and 
choosing Delete from the Tool Options bar (or 
by pressing the Delete key).

You can also transform individual destination 
markers in a photo by holding down the 
Option/Alt key (Mac/Windows) and hovering 
over the area. When you do this, a box will 
appear over the currently selected destination 
marker. You can resize the selection by 
adjusting the handles on the box; to resize 
proportionally, hold down the Shift key. You 
can also rotate the selection by clicking outside 
the box and pressing the mouse key, or you can 
flip the selected area vertically or horizontally 
by clicking the icons underneath the box.

When you hold down the Option or Alt key and hover over the currently 
selected Healing Brush marker, a box appears, which lets you adjust the size, 
rotation and orientation of the marker. When used in conjunction with the 
Healing Brush’s Copy or Move modes, you can easily duplicate and transform 
individual subjects within your frame, as shown by the copy of the pronghorn 
above..
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PERFECT ERASER (RETOUCH GROUP)

The Perfect Eraser can be used to remove distracting elements and blemishes from your image. It uses a 
content-aware algorithm that replaces the pixels with a natural-looking result within the boundaries that 
are painted.

Using the tool is easy: paint over the area you wish to remove, making sure you cover the entire area. A 
red overlay appears where you paint. If the first attempt does not give you a perfect result, paint over it 
again and it will improve with each pass. You can also fine tune the area after applying the tool by using the 
Retouch Brush (see below).

Perfect Eraser Options

The Perfect Eraser’s Tool Options bar consists of two options; brush size, and Wacom tablet support The 
default brush size for the Perfect Eraser is 125 pixels; you can make this bigger or smaller by clicking on 
the Brush Size in the Tool Options bar, or by pressing the right or left bracket keys on your keyboard. The 
maximum brush size is 500 pixels. If you have a Wacom pressure-sensitive tablet, select the Pressure 
Adjusts Size button in the Options bar.

RETOUCH BRUSH (RETOUCH GROUP)

Use the Retouch Brush to remove small imperfections like dust or blemishes. Just dab the brush 
on areas that contain spots or other imperfections, such as acne, sensor dust, power lines and 
more. The tool looks at the neighboring areas in your image and fills in the brushed area with an 
area of similar color and texture.

It is best to use the smallest brush size possible and to work by dabbing rather than making large brush 
strokes. If you dab with the Retouch Brush and don’t like the results, use the Undo command and try using 
a smaller brush or vary your brush stroke and try again. The Retouch Brush is also great for retouching skin.

Retouch Brush Options

• Brush Size: This adjusts the overall size of the brush.

• Brush Feather: This adjusts the hardness of the brush. It works best to use a feather larger 
than 50 to blend and look natural.

• Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an 
imperfection. Use a lower opacity to soften them.

• Pressure Adjusts Size: Click on the button to activate the Wacom sensitivity controls.
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CLONE STAMP (RETOUCH GROUP)

Use the Clone Stamp tool to replace an area of a photo with an area from a different part. Hold 
down Option (Mac) or Alt (Windows) and click the area you want to clone from. Then click and 
drag on the area you want to clone over and it will clone from the point you selected.

Clone Stamp Tool Options:

• Brush Size: This adjusts the overall size of the brush.

• Brush Feather: This adjusts the hardness of the brush. It works best to use a feather larger 
than 50 to blend and look natural.

• Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an 
imperfection. Use a lower opacity to soften them.

• Pressure Adjusts Size: If you have a Wacom pressure sensitive tablet, you can adjust the size 
of the brush according to the pressure. Click the button to activate.

VIEW (ZOOM) TOOL

This tool, which is the default tool selected when you open an image in ON1 Effects, adjusts 
the magnification of the image in the Preview window. With the Zoom tool selected, click in the 
Preview window to zoom in and center the image at the location clicked. Hold down the Option/
Alt key to display the Hand tool, which lets you pan around the magnified image. You can also 

double-click the Zoom tool in the Tool Well to set the image to 1:1 (or 100%) magnification view, which 
shows every pixel. This is best when examining small details.
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Masking Basics
One of Effects’ most powerful features is its masking 
capabilities. Every filter, every adjustment panel in the Local 
tab, and every layer can have a mask associated with it. 

At its simplest level, a mask shows or hides the effect of the 
filter or adjustment. Masks have no color: they are grayscale, 
and the tones range from pure white to pure black. A mask 
that is completely white displays the entirety of the effect 
being used, a mask that is completely black hides that effect. 
(A common way to remember it is via the phrase “black 
conceals, white reveals.”) Shades of gray are in effect the 
opacity of the mask. Darker shades reduce the effect, lighter 
shades let more of it through.

The beauty of the masks is that you can paint on them with 
black, white or any shade in between, so you can “mask” 
portions of your photo so that they will not have that 
effect—or will have a reduced effect. You can also copy 
masks from one filter and past them into other filters. Using 
this feature, you can mask out the sky in one filter, copy the 
mask, paste it into another filter and invert it, applying a 
different effect to everything but the sky. Effects even lets 
you create luminosity masks, which are masks that are solely 
based on the brightness of the pixels in the image. You can 
view your masks, either as a red overlay or as the grayscale 
version of the actual mask, which can be helpful when you 
wish to look at the edges of mask.

Creating masks can be as simple as choosing the Super 
Select AI tool and clicking on a region in a photo; adding 
an Effects filter or local adjustment and using the Mask AI 
options; using the Masking Brush with the Perfect Brush 
option on; or placing an adjustable gradient. You can also 
use multiple tools and masking functions to create more 
complex masks. For instance, you can drop a gradient on a 
photo, use the Masking Brush to paint in places where don’t 
want the gradient applied, or you can use the Color Range 
tools (found in the Masking Control Options area) to select 
portions of an image based on color. 

THE MASKING TOOLS AND VIEW OPTIONS

Inside ON1 Effects 2023, there are six basic tools used to create masks: the Masking Brush, the Masking 
Bug, and the Super Select AI, AI Quick Mask, Original Quick Mask, and Line Mask tools. There are variants 
of the first two that are specific to Local Adjustments (Adjustable Brush and Adjustable Gradient). The 
Super Select AI and AI Quick Mask tools — along with the Mask AI tool in Effects’ filter browser (see page 

Three views of a mask (A-C), along with the Masking 
Control Options section, here shown attached to a 
HDR Look filter in Effects. When you first add a filter 
(or a layer), the mask is empty (A). If you click on the 
empty mask, Effects will automatically generate the 
mask, here shown filled with white, which means all 
of the effect will come through (B). When you use any 
of the masking tools, the areas masked out (partially 
or completely), will be shown in the filter’s mask view 
(C). And, whenever you click on the mask icon in the 
pane, it includes options for displaying, copying and 
pasting, and fine tuning that mask (D)
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145) — generate masks automatically, based on known regions in your photos. You can also use the Refine 
Brush to create a mask — it also works to refine edges and other masked areas.

You can use the gradient and masking brush tools cumulatively, meaning that you can add to or subtract 
from the current mask. However, if you select the AI Quick Mask or Original Quick Mask tools, it will 
replace any existing masks on that pane or layer. However, once you’ve created a mask with the Quick 
Mask tools, you can add and refine that mask with the other tools.

The Refine group of tools—Blur, Chisel and Refine—are designed to help work with edges and halos that can 
crop up when you have areas of strong contrast between a masked area and an unmasked one.

In addition to the masking tools, each mask has a set of controls you can use to manipulate the mask to 
refine it further. (See page 57 for more.)

When you add a filter or a 
layer, the mask is technically 
hidden. You can create a 
mask by either using one 
of the masking tools, or 
by clicking the Show/Hide 
Mask icon in the title bar of 
the pane, to the right of the 
filter name. The contents 
of the Show Mask icon will 
represent the mask on that 
layer. (Local Adjustment 
panes automatically create a 
black layer mask, so you can 
‘paint in’ the adjustment to 
the image.)

There are two primary options for viewing the contents of a mask: either as a red overlay on top of your 
image (the default) or a view only of the mask itself, represented as grayscale. The grayscale view can be 
helpful when checking edges, or when refining some of the advanced masking controls. These mask view 

The bison in this photo has been selected with the Super Select AI tool, and applied to a Dynamic Contrast 
filter in Effects. The Show Mask option has been turned on (red), so you can see where the effect has been 
masked out. 

The two Mask View options help in different ways. The Red Overlay option (above left) can give you an idea of what portions of your photo are successfully 
masked in or out. The Grayscale option (above right) lets you view the mask solely as luminance values, where pure black indicates portions that have been masked 
out completely, pure white is where the effect is applied completely, and the levels of gray indicate partial application of the effect. The Grayscale option is 
especially useful when you wish to check the edges along a mask border.
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options are available from the Mask menu; select Show Mask to see the mask, while the View Mode option 
lets you switch between the two modes. You can also set the app to display the red overlay when you are 
brushing with the Masking Brush and its cousins. (Effects will remember the previous settings.)

When you’re viewing a mask in either overlay or grayscale modes, you have access to all of the tools in the 
Edit module. You can zoom in, to view the mask in greater detail, you can use the Refine masking tools to 
adjust the fine edges of your mask, or you can use any of the other the masking options described below.

MASKING CONTROL OPTIONS

When you click on the Mask icon at the top 
of a pane or in a layer, Effects will display a 
set of options for that mask. This section has 
the following contents, as shown, using the 
Color Enhancer filter as an example:

A.	The Show/Hide Mask icon, which 
displays the contents of the current 
mask. The default mask is white 
when you add an effect, and black 
when you add a local adjustment 
layer.

B.	 Buttons for opening the blending 
options, resetting the filter, and 
removing the filter.

C.	 Sets the overall opacity of the 
effect.

D.	Mask AI pop-up for selecting an 
area based on region.

E.	 Larger display of the current mask, 
option to invert, reset, copy, paste, 
create a luminosity mask, and view/
hide the mask.

F.	 Density adjusts the overall density 
from black (100) to white (0). 
Feather blurs the mask. Levels and 
Window let you adjust the black 
and white points of the mask, fine 
tuning them in different ways.

G.	The Color Range option lets you 
choose a color and make or tune 
the mask based on the range of the 
color selected.

The buttons at the top portion of the Mask 
Options can be quite helpful, especially when you’re working with complex masks, or when you wish to 
reuse masks in other parts of Effects. Their functions are as follows:

Overview of the Mask Options section, shown with a Color Enhancer filter in 
Effects. The Mask AI pop-up for that photo is displayed beneath the options. 
Mask Options is also applicable when working in the Local Adjustments tab, or 
on a layer in the Layers pane.
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• Invert reverses the contents of the mask, swapping the tones.

• The Reset button erases the current mask, leaving it filled with white. 

• The Copy and Paste buttons let you copy the current mask, to paste it into another filter, 
local adjustment or layer. 

• The View button toggles the Mask View on and off.

• The Lumen button creates a luminosity mask of the image for the current filter, adjustment or 
layer, replacing any existing masks (see page 59). 

Color Range selections

The Color Range option lets you create a mask using a specific color, either one inside your image, or one 
via your system’s color picker. To use this option, click the On button next to the Color Range section, and 
click the eyedropper tool to select a color inside your image that you wish to sample. You can then use the 
slider to expand or contract your mask based on that color: lower numbers means that fewer colors (related 
to the chosen color) will be selected, higher numbers mean a wider range of will be selected.

The Color Range option found in the Gradient masking tools can be controlled from the Mask Options 
section of the pane. When you add a gradient mask and click on the Color Range option in the Tool Options 
bar, the color chosen is sampled from the center of the gradient control, but you can open the Mask 
Options pane and sample a different color using the eyedropper. Note that if you do this, and move the 
masking bug, it will resample using the color from the center of the bug.

Here, we’ve created a mask using the Color Range option in the Mask Options section for this Glow filter, to apply the filter only to the mountains. We 
clicked on a color in the sky to use as the base for the selection range. Adjusting the Color Range slider while viewing the mask lets us fine tune the 
selection without using brushes or gradient masks. We can then further refine the mask using other masking tools or the refine mask tools.
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Luminosity masks

A luminosity mask is a specialized mask type you can create anywhere you can create a mask inside Effects. 
This mask uses the brightness (or luminance) values in your image to let you target specific tonal ranges 
with an effect (or to hide the effect from those tones). It is ideal for subtle enhancements to very specific 
areas of an image. They can be used for targeted sharpening and contrast operations, highlights control, 
and much more.

To add one of these masks, click on the Lumen button in the Mask options area or choose Create 
Luminosity Mask from the Mask menu. Because luminosity masks take the brightness levels of a photo, 
when you view the mask, it will look like a grayscale version of the image. With a luminosity mask, your 
effect will be applied in an increasing amount depending upon the brightness value of the pixel underneath: 
if the pixel is black, none of the effect will be applied; if it is white, it will be entirely applied; for all other 
tones, the effect will get applied as a percentage of the pixel’s brightness, from 0 (white) to 100 (black).

You can use the Levels or Window controls to further target tones with your luminosity mask. The Levels 
setting lets you set the black (left triangle) and white (right) points of the mask, with the midpoint, or 
gamma, setting being adjusted by the middle triangle. This lets you refine the mask to focus on narrow 
bands of luminance values in an image; for example, if you wanted to focus an effect on the midtones, 
bringing the white and black points into the middle of the Levels slider, and adjusting the midpoint, will 
achieve this much quicker than you could with the Masking Brush.

The Window slider is similar to the Levels slider, in that it works like a black point slider from both sides. 
When you move the right and left triangles, all of the tonal ranges outside the points will be black, leaving 
those areas affected that are within the ‘window’ of the mask. For example, if you wanted only the shadows 
in your image to have an effect, you would move the right slider over towards the left by about two-thirds.

Viewing a luminosity mask is similar to a black-and-white version of your photo; the lighter the tones, the more the intended effect will be, and the 
darker the tones, the lower the effect. You can use the Invert button to swap the tones in a luminosity mask, or use the Levels and Window controls 
to restrict the mask to specific tones in your selection.
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MASKING TIPS

Here are a few tips for working with the various options in the Mask pane:

• You can use multiple masking tools to create, modify and refine masks. For example, you can 
start with a luminosity mask, adjust the tonal range of the mask with the Levels or Window 
sliders, and then further refine your mask by painting in or out with the Masking Brush or 
Masking Bug. Adding a luminosity mask always overrides the current mask (as is the case with 
the AI Quick Mask tool), however, so you should start there.

• While the AI-based masking tools can be quite good when building selections, they aren’t 
perfect. You should inspect your AI masks after applying them, and use the other masking 
tools — the Refine Brush, and Chisel or Blur tools — or the Mask Options section to fine-tune 
your selections.

• Use the Feather slider to smooth transitions between masked and unmasked sections.

• Lowering the Density slider helps intensify an effect after you’ve created a mask. Think of it 
like a ‘reverse fade’: at the 100, all of your mask is viewable, at 0, the mask is entirely white.

• Don’t forget that masks aren’t just for filters and local adjustments; you can create a master 
layer mask that will apply your selection to the cumulative adjustments made in the Edit 
module. To do this, click on the Mask icon to the right of the layer.

• It can sometimes be helpful to use the same mask on different filters, so use the Copy button 
to grab the contents of a mask from one filter and the Paste button to paste that onto the 
mask of another filter. The Invert command can be invaluable when you wish to apply a filter 
to the opposite portion of a photo, such as a sky and your foreground.

• Because masks are tied to the actual pixels of the current photo (or layer), they cannot be 
copied from one photo to another, or between layers in a multi-layered document.
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Presets
Presets are stored “recipes” that include sets of Effects filters and local adjustments, and can be applied to 
a photo with one click. Presets are a fast way to get consistent results when editing a group of images, 
helping you hone your own look. You can also create your own presets, even presets that incorporate 
ON1’s Mask AI technology to apply masks automatically to regions in a photo (See “Creating and Using AI 
Adaptive Presets” on page 64).

Three different views of the Preset panel. On the left is the List view, in the center is Thumbnail view; these views display the categories of presets. (The 
view options can be set in the View > Preset Browser submenu.) On the far right is an expanded category, displaying the various presets, with a thumbnail 
of the current image with the preset applied. From there, you can apply a preset to the current image.

As you hover over a category, the Quick View Browser icon appears on the left side of the category’s name. Clicking on that icon will open a full-screen 
window showing your photo with that category’s presets applied to it. (See the following page for a screen shot of the Quick View Browser.
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ON1 Effects 2023 comes with more than 200 built-in presets, in more than a dozen categories, ranging 
from landscapes to portraits, color grading, film looks and much more. You can create your own presets, or 
import presets from other ON1 users and photographers.

Presets can also store crop settings and retouching information, as well as masks created with brush tools, 
Effects’ Masking Bug, and the Adjustable Gradient Tool in the Local Adjustments panel. If you apply a 
preset that contains these options, you should check to make sure that you have the desired result; if not, 
you can reset the various individual operations via the Settings menu. 

APPLYING PRESETS

To apply a preset to an image, click on the Presets panel. There you will see any built-in presets supplied by 
ON1—ordered by category—as well as any presets you might have created or installed yourself. Clicking on 
a category name will open it and display any presets within that category, with a tiny thumbnail showing 
your selected image with that preset applied to it. To change the size of the thumbnails in the Presets panel, 
select the Browser Mode option from the View menu and choose One, Two or Three Column View.

To help you view the effects of a specific preset, Effects will display a real-time representation of that 
preset over your current photo when you hover your cursor over a preset in the subcategory view. To see a 
larger representation of what your selected photo will look like 
with all of a category’s presets, click on the Quick View Browser 
icon in the title bar. That will display a window with all of the 
presets in that category. (Press the Escape key to close the Quick 
View Browser.) To apply a preset to a photo, click on the preset in the mini-browser or in the Quick View 
Browser. Presets are not cumulative; clicking on another preset will remove the previous one and apply the 
new one.

A preset with the Quick View Browser icon shown.

Clicking on the Quick View Browser icon in the Panels pane (or choosing Open Quick View Browser from the Window menu) will open a 
full-screen representation of that category’s presets, giving you a larger representation of how that preset will look on your image.
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Once you’ve applied a preset, you can reduce its overall effect by hovering over the preset name, which 
displays the Fade slider. This lets you lower the opacity of the Effects filters 
applied with the preset. 

After you have applied a preset, you can still make changes to any of the settings, 
add or remove adjustments, switch to another preset, perform retouching 
operations or more. 

If you don’t like a preset, clicking on another one will replace the settings of the 
previous preset with the settings of the new preset. To remove a preset entirely, 
choose one of the reset options from the Settings menu, or remove the individual 
settings from the appropriate panes in the Effects and Local tabs. 

You can save a preset as a favorite by hovering over its thumbnail in the browser, and clicking on the 
heart icon. This will add that preset to a Favorites category that resides at the top of the Presets panel. To 
remove a favorite, click again on the heart icon.

Inserting Presets (Effects tab only)

When you click on a preset, Effects’ default behavior is to remove any existing adjustments and apply the 
newly chosen preset to your photo. Sometimes, however, you would 
like to add a preset on top of your adjustments. To do this, open the 
Presets pane, right-click on the preset you wish to add, and choose Insert 
Preset from the pop-up menu. This will add the preset’s filters above the 
currently selected filter pane and will preserve any edits in the Local tab. 

Inserting a preset will only add that preset’s Effects filters to your 
currently edited photo. Local adjustment layers will not be added.

CREATING YOUR OWN PRESETS

Once you have a group of edited settings that 
you wish to save, go to the Settings menu and 
select Save Preset. The Save Preset dialog will 
appear, with options for which module’s settings 
you wish to save, naming the preset, and adding 
it to an existing or new category. Nearly all 
of the Edit module settings can be saved as 
a preset, including cropping, retouching, and 
masks. To save your masks — AI adaptive or 
otherwise — check the Apply Masks option for 
each tab in the Edit module. 

If you have applied a preset to an image, and 
subsequently updated any of the edit settings 
(or add or remove adjustments), you can update 
the preset with the new settings by choosing 
Update Preset with Current Settings from the 
Settings menu. This will only change the preset in your app; any images that had the old version of the 
preset will keep those settings unless you reapply the preset. (You can also update a preset by right-clicking 
on the preset in the Preset Browser.) 

The Fade slider reduces the 
opacity of Effects filters 
applied with a preset.

The Save Preset window includes all of the operations possible in Effects. 
Filled circles to the left of a setting mean that the setting will be saved in the 
preset; click the circle if you don’t wish that setting to be saved.
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If you would like to create a new preset category—which will be added to the Presets panel throughout 
ON1 Effects—choose Add New Category from the category pop-up. 

CREATING AND USING AI ADAPTIVE PRESETS

When you use the Super Select AI tool or the Mask AI options in the Effects, Local Adjustments or in the 
Layers panel, you can save those region selections when you create a new preset, by clicking on the Apply 
Masks item in the appropriate tab. Then, when you apply the preset to a new photo, anything (Effects filter 
or local adjustment) that had an AI-generated mask region — such 
as a sky — will be applied to those regions with the same name in 
the new photo. These preset types are called “adaptive,” meaning 
that they are applied to a photo based on ON1’s AI models.

Here are a few tips to think about when working with adaptive 
presets:

• It’s best to create an adaptive preset that only uses AI-
generated masks. If you save a preset where any filters 
or local adjustments have masks that have been created by the standard masking tools (like 
the Masking Brush or Masking Bug), those masks will be regenerated based on the precise 
location of the mask in the image that was used to create the preset.

• Any changes to the mask made via the Mask Control Options pane (see page 57) are saved 
with the preset.

• After you apply an adaptive preset to a photo, check the masks that the preset created. Quite 
often, you’ll find that you might need to use some of the mask refinement tools — or even the 
Masking Brush — to fine-tune your mask.

• Feel free to add your adaptive presets to any of the existing preset categories, or create your 
own category (see below for how to do that). For best practice, however, name or categorize 
adaptive presets such that you know which ones contain AI-generated selections.

MANAGING PRESETS AND CATEGORIES

You can perform a variety of operations on presets and preset categories, including importing and 
exporting presets (individually or by category), deleting individual presets, and hiding categories.

Importing & Exporting Presets

You can import presets you have downloaded from the ON1 website or other source. Some files will be 
individual presets, while others might be preset “packs,” which will include more than one preset.

A preset will have an ‘.ONP’ extension, while a preset pack has an ‘ONPreset’ extension; all you need to do 
is double-click on the file—or choose Import Preset from the Settings menu—and Effects 2023 will ask you 
to pick a category where you wish to place the preset or pack, and it will copy the presets into the app. You 
can delete the downloaded files, if desired.

To export an individual preset, click on it and choose Export preset from the Settings menu. You can also 
export an entire category of presets, via the category preset menu (shown below).

Clicking Apply Masks in the Save Preset window 
will save your AI-generated regions. When you use 
that preset, those masks will be applied to similarly 
named regions.
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Deleting presets

To remove a preset if you no longer want to have access to it, select the preset you wish to remove in the 
Preset panel, and choose Delete Preset from the Settings menu. You can also right-click on an individual 
preset and click Delete Preset from the pop-up menu.

You can delete any preset, including the presets that came pre-installed with ON1 Effects. If you think you 
might wish to save a preset, export it first, then delete it.

Managing categories

In addition to creating your own preset categories, which get 
displayed in the Presets pane, you can also perform other operations 
on categories, including deleting, renaming or exporting. These 
options are all available via the Preset Category pop-up menu, which 
is available when you hold right-click on a category name:

• To remove a category—and its presets—from the Presets panel, choose Delete Category from 
the pop-up.

• Choose Rename category if you wish to change the name of the category.

• To export a category and all of the presets within it as an ONPreset pack, choose Export 
Category from the pop-up menu.

TIP: Many preset management options can also be performed by clicking on a 
preset in the Preset panel and right-clicking on the preset. This is helpful if you 
want to update, export or rename a preset without applying it to an image in 
Effects.

Nesting presets

To help manage large groups of presets, Effects’ Extras Manager lets you nest preset categories. See page 
17 for details on how to create and manage preset category subfolders.

Resetting edits
Any edits you have made with ON1 Effects 2023 can be completely reset while you’re working. The 
Settings menu offers five options for erasing edits made to a photo:

• Reset All Settings: This removes all adjustments made to a photo in Effects. (This option can 
also be accessed from the Reset All button at the bottom right of the Effects window.) 

• Reset Effects Settings: Removes only the settings applied in the Effects tab.

• Reset All Retouching Tools: Resets any retouching applied to the photo.

• Reset Local Adjustments: Removes all local adjustment layers.

• Reset Crop: Returns the image to its original, uncropped size.

Right-click on a preset category to get the 
category pop-up menu.
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You can undo any of these changes immediately after making them; otherwise resetting with the 
appropriate option will permanently reset the image.

Soft Proofing
ON1 Effects’ soft proofing feature lets you 
see how a photo will look when printed, using 
the color profiles that get installed with your 
printer. Soft proofing helps you determine 
where there might be issues when you print, so 
that you can adjust your tone, color and effects 
to give you a print that is closer to your editing 
vision.

Normally, when you’re viewing an image in 
Effects, you are viewing it through the lens 
of your monitor’s display profile. The color 
gamut of your computer’s display is wider than 
that of most photo printers, which means that 
some colors you are able to view on-screen 
are not reproducible when you print. When 
this happens, the color profile conversion 
that happens in the print engine will cause 
substitutions of colors that the printer cannot 
print to the closest color that it can. This means 
that your image could have subtle (or broad) 
shifts in color, especially in certain color ranges.

Soft proofing is turned on via the View menu, 
or by clicking on the soft proofing icon to the 
left of the Preview button at the bottom of the 
main Effects window. You soft-proof various 
paper types by choosing an installed printer 
profile from the Profiles submenu. The image 
will change to approximate the color of the 
paper you’re profiling. You can also turn on an 
overlay that will display out-of-gamut colors.

The primary soft-proofing options are available 
underneath the Enable Soft Proofing item in 
the View menu. The options are as follows:

• Gamut warning: When checked, this 
displays colors in the image (via a 
red overlay) that don’t correspond to 
the current printer profile being soft 
proofed.

These three screen shots show the results of soft proofing options. The top 
image is with soft proofing off (and is using the display color profile). The middle 
image is with soft proofing turned on, and using a printer profile for Epson’s 
Ultrasmooth Fine Art paper. The bottom image has the Gamut warning turned 
on; out of gamut colors are highlighted by the bright red overlay.
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• Profiles: The Profiles submenu lists the currently available printer profiles. Choosing one 
will change the on-screen display to use that profile. You can also import profiles via this 
submenu.

• Intent: Effects offers two different rendering “intents” when soft proofing, which are used to 
convert the color from display to print. Perceptual shrinks the color gamut during the 
conversion, which works to preserve the relationship between colors in the image. The other 
intent type, Relative, only converts colors that are outside the current color gamut, but this 
can sometimes cause two colors, one in gamut, and one outside, to be identical after 
conversion.  
	 Neither rendering intent is perfect or desired; it often is a 
matter of the makeup of the image, your editing intent, the 
paper being printed on, and so forth. Often, you’ll want to 
switch back and forth between Relative and Perceptual, 
seeing which gives you a better print.

• Simulate Paper and Ink: Turning this setting on will cause 
Effects to use the white point for the chosen paper type 
(instead of the white point of your monitor), and the paper’s 
actual black density (instead of the display’s black point). 
If you’re trying to match a print, you will usually want this 
setting turned on.

Adjusting images with soft proofing is often a bit of trial and error. 
It’s easy to get caught up in eliminating out-of-gamut colors, but most 
modern photo printers—both home printers and online print services—
do a pretty good job of properly approximating colors. 

The biggest thing you want to be looking for when viewing a soft 
proof is tone, contrast and color accuracy between screen and print. 
When using a home printer, use test prints to hone in on the right mix 
of Effects adjustments. (See page 109 for information on printing 
photos from within Effects.)

Other Preview Options
In addition to soft proofing, ON1 Effects 2023 
offers a few other previewing options, which 
can be found Preview Option section at the 
bottom of the main window. With these options, 
you can compare the before and after views of a 
photo—in either split-screen or full-screen views—see the current mask, and turn soft proofing on or off. 

CHANGING THE MAGNIFICATION VIEW 

Effects includes various options for zooming in or out of a photo while you’re working on it. In addition to 
the Zoom tool and the Navigation pane (see page 23 and page 25, respectively), you can change the 
zoom view by moving the magnification slider. You can either click on the control and slide it to the right to 
zoom in and to the left to zoom out, or you can click on the boxes at the ends of the slider.

The Profiles submenu displays the installed 
printer profiles for any installed photo 
printer. You can also import your own color 
profiles.

The Preview area at the bottom of the main Effects window includes options 
for adjusting the preview magnification, turning compare (before/after) view 
on or off, viewing the current mask, turning soft proofing on or off, and for 
viewing the original photo, with all edits removed.
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BEFORE/AFTER PREVIEWS

As you work in Effects, it can be helpful to see how individual edits—via items in the different edit tabs—
affect your photo, as well as to see the cumulative changes made to the original image. The Compare mode 
displays a side-by-side view of your photo, with the original version on the left, the edited version on the 
right. There is a movable slider in the middle of the screen, which lets you view more or less of each view; 
click on the box at the center of the slider and drag it to the left (to view more of the edited image) or to the 
right (to view more of the original. While working in Compare view, you can use the magnification slider to 
zoom in or out of the image, which can be useful when you wish to see the effects of your edits on smaller 
sections of your photo.

You can also view your original image full-screen by clicking the Preview button at the far right of the 
previewing toolbar. When you click this button, the original photo is displayed with a “Preview Off” overlay. 
To return to your edited version, click the Preview button again. (You can also use the backslash key—‘\’—to 
show and hide the full-screen preview.)

SHOW/HIDE MASK

ON1 Effects 2023 has extensive masking capabilities throughout Effects. While you’re in the process of 
creating a mask, you have two options for displaying the contents of a current mask: 

• As a transparent red overlay, where the masked sections of your photo are shown in red.

• As a grayscale mask, where you do not see the photo, but see only the mask. Masked areas 
are shown in shades of gray, with pure black meaning that those pixels are completely 
masked. Gray values (from 1% to 99%) represent the opacity of the those pixels relative to 
the mask, and areas of pure white are not masked.

The overlays can be set in the Mask menu’s View Mode submenu while you are working in Effects. You can 
also, via this option, show the mask as a red overlay only when you are brushing a mask. 

Effects’ Compare view displays a before/after view of your current photo, with a movable slider (circled, above) for expanding and 
contracting the different views.
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You can toggle the current mask view by clicking on the Show Mask icon in the previewing toolbar, or by 
pressing the O key.

For more information on the varying aspects of masking in ON1 Effects 2023, check the respective 
masking tools earlier in this chapter, as well as the “Filter Masks” on page 75.

FOCUS AND CLIPPING VIEWS

Two additional—and powerful—previewing tools are available when you are editing photos: the Clipping and 
Focus Mask overlays. 

Clipping

Clipping occurs when the shadow and highlight tones in an 
image are suddenly cut off to completely white or black, 
rather than fading smoothly. (Large expanses of white pixels 
in a photo are often referred as ‘blown’ highlights, and can be 
quite distracting to a viewer.) One of the benefits of shooting 
in raw format is that, while many photos will have areas of 
pure white or black when originally viewed on-screen, there 
is still recoverable data in the raw image. The Clipping overlay 
can help determine how big a problem you might have with a 
photo, and how easy (or difficult) it will be to fix. 

To display the Clipping overlay temporarily, press the J key; 
to turn it on permanently as you move from photo to photo, 
choose View > Show Clipping, or press Alt (Windows) or 
Option (Mac) J on your keyboard.

The Clipping view overlay displays the areas that have either pure white or pure black in them. Those areas 
with a bright blue overlay indicate pure black pixels, while the areas with the bright red overlay indicate 
pure white pixels.

Focus Mask

It can often be difficult to view the sharpness in a photo 
without zooming in to 100% or more, and if you have a 
lot of photos from a shoot, it can be a bit tedious to check 
focus at that level. Luckily, Effects’ Focus Mask overlay can 
help winnow your shots down to the sharpest ones.

To turn on Focus Mask, choose View > Show Focus Mask, 
or press Shift-Alt-J (Windows) or Shift-Option-J (Mac). The 
sharpest areas in your image will be represented by a bright 
green overlay. As you move from photo to photo in a folder, 
you’ll be able to tell whether you have an acceptable level of 
sharpness where you need it by the strength of the overlay. 
The mask will continue to be displayed even as you zoom in 
on a photo.

Clipping view displays pure white pixels with a bright red 
overlay, and pure black pixels with a bright blue overlay.

The Focus Mask option displays areas of sharpness with a 
bright green overlay.
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SHOWING OR HIDING FILTER AND LOCAL ADJUSTMENTS PANES

All of the individual filter panes and local 
adjustment panes inside Effects have a Show/Hide 
control in the upper left-hand corner of the panel. 
You can make your adjustments, and can click the 
control to turn the effect on or off. 

This option is not solely for previewing an effect; if 
the adjustment is turned off, it will not be present 
in the finished, edited image. This can be helpful if 
you’re trying different filters in Effects, for example, and you want to see if one looks better than another, 
or if you wish to see if it truly helps the photo or not. To turn the adjustment back on, click on the Show/
Hide control so that the circle is filled.

If you wish to view your photo without those adjustments, you need to press the Reset icon, which is 
represented by ‘⟲’ at the top right side of the panel. 

For a complete description of the controls in the filter panels, see page 72.

To turn an effect or other adjustment off, click on the Show/Hide control 
in the upper left of an adjustment’s panel. If the control’s circle is empty, 
that effect is not implemented. Clicking the control will turn it back on.
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Working with Filters

With 31 different adjustment types—called filters in Effects—you can create stunning, pro-level photos 
with ease. Effects is extensively customizable in how filters are applied, and, when working with an image, 
you can:

• Add filters in any order;

• Have multiple instances of any filter;

• Move filters up and down in the stack;

• Add blending mode options to all or some of the filters and set the opacity of each filter 
individually; and

• Create complex masks for each filter, letting you selectively apply a filter to specific portions 
of an image.

Filters are the building blocks of Effects’ editing power. Each filter acts like a movable, editable layer over 
the base image you are working on. You can use Effects’ masking tools to apply a filter to only part of an 
image and can change the blending mode (and opacity of the filter) to alter the way the filter interacts with 
those above and below it in the stack.

The Effects tab has 31 filter types, added either by the Add Filter button found at the top of the Effects 
tab, or via the Filters pane on the left side of the window. You can apply filters in any order, and you can 
have more than one instance of a filter in the stack. (This can be helpful when you are creating complicated 
masks on an image and wish to apply the same filter differently in parts of the photo.)
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FILTER OVERVIEW

Each filter pane has a different set of adjustment 
options and controls, but every filter pane has the 
same five sections:

A.	Filter on/off button (left); Show/Hide 
Mask (right)

B.	 Displays blending mode options (left); 
Resets filter (middle); Deletes filter from 
the stack (right).

C.	 Filter opacity setting.

D.	Styles pane for filter presets.

E.	 Control area for adjusting that filter’s 
specific settings (dependent upon the 
filter chosen).

APPLYING FILTERS WITH THE ADD FILTER BUTTON

If you click the Add Filter button at the top of the Effects tab, the Filters window opens up, with a list of all 
31 filters on the right side of the window, and the Mask AI pane on the left (see screenshot on the following 
page). If you run your cursor over a filter name, the right side of the window will have a small before/after 
thumbnail, a short description, and a list of keywords that relate to that filter. To add a filter, click once on 
the filter name, and it will add it to the stack, above the current filter. If there aren’t any filters in the stack, 
the new filter will be at the top of the stack. You can click and drag the title bar in any filter to move it up or 
down in the stack.

If you’re not sure what you might looking for, you can search for filters using keywords, like “monochrome,” 
“contrast,” “sharpening,” and so forth. ON1 Effects will then narrow down the search to those filters that 
match your search terms.

Overview of a filter—in this case, the Cross Process filter—inside Effects.

When you click on the Add Filter button in the Effects tab, the Filters window is displayed, which consists of the Mask AI controls 
(left), the list of filters (center), and a description (right) of the filter your cursor is currently hovering over, with a sample preview 
(including a before and after split view).
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Using Effects’ AI-based tools to mask regions automatically

Normally, when you add a filter, the filter is placed at the top of the Effects stack, and is applied to the 
entire image. If you’d like to selectively apply a filter automatically to specific areas in a photo, you have 
three options:

• You can use a tool like the Super Select 
AI tool to select a region and create 
a filter in Effects (see page 34 for 
information on using this tool).

• To add a filter from within the Effects 
tab, choose the Add Filter button, and 
select the region in the Mask AI section 
on the right side of the Filters window.

• If you have an existing filter, you can also 
select a region from the masking control 
options section of the filter.

In addition to these options, you can also use an AI 
adaptive preset when you wish to create selections 
based on regions in a photo. (See page 61 for 
more on presets and their application.) 

If you click the Add Filter button at the top of the 
Effects tab, the Filters window opens up, with a 
list of all nine filters. If you run your cursor over a 
filter name, the right side of the window will have 
a small before/after thumbnail, a short description, 
and a list of keywords that relate to that filter. To add a filter, click once on the filter name, and it will add it 
to the stack, above the current filter. If there aren’t any filters in the stack, the new filter will be at the top 
of the stack. You can click and drag the title bar in any filter to move it up or down in the stack.

If you’re not sure what you might looking for, you can search for filters using keywords, like “monochrome,” 
“contrast,” “sharpening,” and so forth. Effects will then narrow down the search to those filters that match 
your search terms.

APPLYING FILTERS WITH THE FILTER BROWSER

In addition to the Presets panel, Effects has an additional Filter panel on the left side of the screen. This 
panel lets you browse all of the filters inside Effects, and display previews of the available styles for that 
filter. 

To choose the Filters panel, click on the Filters tab. A list of the filters will appear, and clicking on a filter 
will display thumbnails of your image with that filter’s available styles. To choose one, click on the style, and 
Effects will add that filter to the Overall Settings pane. This will replace the currently selected filter in the 
stack; to add a new one on top of the stack, click the Add Filter button at the top of the Effects tab on the 
right panel, then choose a filter from the list. (You can also click and drag the title bar of any filter and move 
it up or down in the stack.)

In addition to using the Super Select AI tool to add filters selectively to a 
photo, ON1’s Mask AI technology can be found in the Add Filters window 
(above left), and in the masking control options section of the filter itself. 
(Click the mask icon in the filter to open the mask options section.)
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If you’d like to see a larger representation of what your selected photo will look like with a filter’s styles, 
click on the Quick View Browser icon in the category’s title bar. That will display a window with all of the 
styles in that category (see page 62). Press the Escape key to close the Quick View Browser.

To change the size of the thumbnails in the filter styles panel, select the Browser Mode option from the 
View menu and choose One, Two or Three Column Thumbnail View. (If you choose Thumbnail from the 
Browser Mode submenu, the Filters and Presets 
panels will display as thumbnails.)

If you’d like help with what the different filter 
operations do, click on the Info button at the top 
right of the panel. With that button checked, 
when you hover over a filter, Effects will display 
a small pop-up window containing the same 
description (with before/after thumbnail) found 
in the Add Filter window. Click the Info button 
again to turn off this display.

Searching for filter styles

To search for styles inside the Filter Browser, 
type in the name you’re looking for in the 
search field at the bottom of the panel. The 
search results will appear in a new sub-folder 
called search results, which will be selected 
automatically.

Saving filter styles as favorites

If you hover over a filter style’s thumbnail in 
either the Filter Browser or the Quick View 
Browser, you’ll see a heart icon. Clicking the icon 
will fill the heart in and add that style to your 
Favorites category. This category resides at the 
top of the filter list, and contains all filter styles 
you have selected as a favorite. To remove a 
favorite, open the Favorites category, and click 
again in the heart icon. To apply a filter style to 
a photo, simply click on the style in either the 
Filter Browser or in the Quick View Browser.

The Filter Browser has a list of all the filters available in Effects (left). Clicking 
on a filter will display thumbnails of the filter’s styles using your photo (right). 
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Filter pane details
By default, the filter stack is empty, although, if you have applied a preset that uses filters from Effects, you 
will see those filters in the stack. Clicking on the button in the top left corner of the filter pane will turn 
that effect on or off, which can be helpful if you want to see the effect in the context of other edits you 
have made. If you don’t like the effect, click on the ‘X’ icon in the pane’s title bar to get rid of it. The Reset 
button, which is next to the Delete button, represented by ‘⟲,’ will reset that pane’s settings.

To move a filter up or down in the stack, click on the pane’s title bar and drag it up or down. A heavy white 
line will appear between panes as you drag; let go of the mouse at the location you wish the filter to go.

TIP: Each pane can be collapsed, by clicking in the pane’s title bar (a Hide/
Show link is visible when you move your cursor over the title bar, but the entire 
title bar is clickable). If you don’t want to scroll up and down the filter stack 
with a lot of open panes, go to the Window menu and choose Solo Mode. This 
will leave the current pane open, and will hide all the other panes. Clicking on 
another pane will open that one and collapse the previous one.

STYLES

As noted in the section on the Filter Browser (page 
73), all Effects filters have a set of built-in styles, and 
when you add a filter to the stack, you’ll see the Styles 
section in the top part of the pane. Styles are like preset 
adjustments for a pane: they provide a group of settings 
to help you get started in the pane, or to apply a specific 
effect.

You use a style by clicking on the style’s icon in the pane, and then can adjust 
the sliders as desired to get the right effect for your photo.

You can also save your own settings as a style. Simply click on the More icon 
on the far right side of the styles list for that pane, then choose Save New 
Style from the pop-up. Name your style, and it will then be added to the top 
of the More menu (see right). To apply a saved style, choose the style from the 
More pop-up menu. To adjust the settings for a saved style, apply it, make any 
changes you would like to the sliders or other options, then right-click on the 
More pop-up and choose Update Style with Current Settings from the menu.

FILTER MASKS

Every filter (and local adjustment) has a mask associated with it, which lets you apply that filter’s effect to 
specific areas of an image, using the Masking Brush (or the Local Adjustment Brush and Gradient, when 
working in the Local tab) and Masking Bug tools. By default, the mask is white, which means that the effect 
is visible in every part of the image. Using the Masking Brush, for example, you can ‘paint out’ the effect in 

Styles for the Split Tone filter.

Saved styles appear at the top of 
the More menu.
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areas that you wish not to be affected by the filter. Alternatively, you can invert a filter’s mask and choose 
to ‘paint in’ the filter where you would like it to be.

When you add a filter, the mask is technically hidden. You can add one by either selecting and using one of 
the two masking tools, or by clicking the Show/Hide Mask icon in the title bar of the filter pane (this icon 
will initially be represented with a plus sign in the middle of it). When you add a mask in either way, the 
contents of the Show Mask icon will represent the mask on that filter layer.

Effects has two options for viewing the contents of a mask: either as a red overlay on top of your image 
(the default) or a view only of the mask itself, represented as grayscale. These options are available from 
the Mask menu; select Show Mask to see the mask, while the View Mode option lets you switch between 
the two modes. (Effects will remember the previous settings.)

The Mask section of any effect or local adjustment has the following contents, as shown below (using the 
Glow filter as an example):

A.	The Show/Hide Mask icon, which displays 
the contents of the current mask. The default 
mask contents are white when you add 
an effect, and black when you add a local 
adjustment layer.

B.	 Buttons for opening the blending options, 
resetting the filter, and removing the filter 
from the stack.

C.	 Sets the overall opacity of the masked effect.

D.	Mask AI selection pop-up. Displays a list of 
the known regions in the current photo. To 
create a mask with any of the specified areas, 
click on the item and choose Apply

E.	 Larger display of the current mask, with 
buttons to invert, reset, copy, paste, create 
a luminosity mask, and view/hide the mask 
contents.

F.	 Mask adjustment tools. Density adjusts the 
overall mask density from black (100) to white 
(0). Feather blurs the mask. The Levels and 
Window settings let you adjust the black and 
white points of the mask, fine tuning them in 
different ways.

G.	The Color Range option lets you choose a color (selected via the dropper tool), and make or 
tune the mask based on the range of the color selected.

For more details about creating and manipulating masks in Effects—as well as some tips and tricks for 
working with masks—see “Masking Basics” on page 55; information on the Masking Brush and Masking 
Bug tools starts on page 38.

Overview of the Mask Options section of a filter pane in Effects, 
showing a luminosity mask. Mask Options is also applicable when 
working in the Local Adjustments tab, or on a layer in the Layers 
pane.
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DELETING A FILTER

You can remove a filter by selecting it and pressing the ‘X’ icon to the right of the filter’s pane.

FILTER OPACITY

Every filter has an opacity setting, which effectively adjusts the strength of the filter. The Opacity slider, 
which is found at the top of each filter’s pane, ranges from 0 (no effect) to 100 (full effect). What this 
means is that at 100, all of the filter is applied to the image in the stack. At 50, the filter strength is half, and 
the effect is much less strong. Playing with a filter’s opacity can often help soften an effect in a way that 
you wouldn’t be able to get otherwise.

For example, if you add a Black & White filter, but would like a faded, muted color effect, simply reduce the 
opacity of that filter. The more you reduce the opacity, the less effect the Black & White will have.

By default, when you add a filter, the opacity will be set to 100. You can create presets, however, with 
whatever opacity you wish for a given filter.

BLENDING MODES

In addition to opacity, you have one other very powerful option for adjusting the strength and effect of a 
filter: blending modes. Blend modes determine how a filter interacts with the filters below it in the image 
stack. Blend modes can darken or lighten an image, depending upon the mode chosen, while others adjust 
contrast or color. ON1 Effects 2023’s blend modes also let you apply a blend mode to specific colors or 
tones in your image, making them a very useful tool for precision editing of your images. You can apply 
sharpening, for example, only to the midtones in an image, which can be very helpful in a landscape image.

To see the blending modes, click on the Blending Options gear icon at the top of a filter’s pane. The 
Blending Options area will drop down from the top of the panel. The blending option controls are:

• Blending Options: A pop-up list of 
blending modes. There are 24 common 
blending modes available in the list, 
including Normal, Lighten, Darken, 
Screen, Multiply, Soft Light, Hard 
Light, Overlay and Color.

• Apply To: This lets you apply the 
blending mode to a specific color 
or tonal range. The options are; All 
(the default), Highlights, Midtones, 
Shadows, Reds, Greens, Blues, 
Magentas, Cyans, Yellows, Flesh 
Colors, Vivid Colors and Neutrals. (You 
can also manually choose a color range 
by selecting the Dropper Tool in the 
pane and clicking on a color in your 
image.)



ON1 Effects 2023 User Guide	 Part 2: Working in Effects	 78

When you choose one of the options in this menu, the adjustment is only applied to that part of the image 
that is based on the lightness, hue, or saturation range specified. The Range slider expands or contracts 
the selected option, and the Highlights, Shadows, and Skin sliders protect those settings from your 
adjustments.

How blending modes work

At their basic level, blend modes determine how the pixels on one layer interact with the layers below it. 
With 24 blend modes in ON1 Effects 2023, it might be difficult to know which ones to use in any given 
situation, but they can easily be grouped into Normal (the default mode) and five categories: Darken, 
Lighten, Contrast, Comparison, and Color/Luminosity. 

Normal is the most widely used: it simply applies the effect to all of the pixels in the adjustment (or effect), 
assuming the layer opacity is 100%.

The other modes apply different levels of that category’s effect using various mathematical formulas, 
and sometimes it can be hard to know which mode will work best with what photo. Most often, when 
you know how you want to apply an effect —by darkening, for example—you’ll need to perform a bit of 
experimentation with the different modes in that category to determine which mode works best.

MASTER OPACITY, BLENDING AND MASK OPTIONS

Effects also has master opacity and master 
blend mode options for the entire image stack, 
and includes a Master mask option. The Master 
Opacity slider, found at the top of the Effects 
tab, controls the strength of the composite filter 
stack against the original image.

The Master Blend Mode options can be 
accessed via the gear icon at the top of the 
Effects tab. It has the same controls as the 
blending options in the individual filter panes.

To create a Master mask, click on the mask icon 
next to the Save Preset icon in the Effects tab. 
This mask works on the entire effects stack, 
letting you selectively add or remove an entire 
effect.

At the top of the Edit module stack, you can find a master opacity setting, as 
well as a master mask, with corresponding blending modes. Masks created here 
get applied to all of the edits you’ve made to a photo in each of the three Edit 
tabs.
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Effects 2023 Filter Types
Effects has 31 filter types available for you to use inside ON1 Effects 2023. Each filter has a set of styles in 
the top row, providing a range of popular or useful options for using that filter. You can also save your own 
preset styles by clicking the More pop-up at the end of the Styles row.

ANTIQUE

The Antique filter gives your image an aged look; unlike the 
Vintage filter, this filter focuses more on a monochromatic or hand 
colored look.

• Color: Displays a list of color options that are similar in 
tone to the Split Tone filter, providing a duotone-style 
effect.

• Brightness: Adjusts the overall brightness of the image.

• Fade: Adds a white fill to the image, giving the illusion of 
a faded photograph.

• Saturation: Adjusts the color saturation. Moving the 
slider to the left decreases the saturation; moving it to 
the right increases it.

• Film Grain: Amount controls the strength and size 
dictates how large the grain appears.
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BLACK & WHITE

This pane is used to turn a color image into a monochromatic 
image, with additional toning features.

The styles at the top of the pane represent different filter types 
often applied to an image, while the Auto button selects the black 
and white points of your image automatically. To manipulate the 
tones manually, move the color range sliders to the right (increasing 
brightness) or the left (decreasing). Alternatively, you can choose 
the Channel Mixer option from the Conversion pop-up, and use 
the slider to choose a look that accentuates the color tones you are 
most interested in.

To change the tones directly inside a photo, choose the Color 
Response tool in the pane: click on it to select the tool, then click 
and drag in the image to increase or decrease the brightness of the 
selected color range.

Tone

The Tone section of the Black & White pane lets you adjust 
brightness, contrast, highlights and shadows, whites and blacks.

Toner

The Toner section of the filter is designed to approximate many 
traditional and popular darkroom-based paper toners, from sepia 
tones to platinum, selenium, coffee and more. You can choose from 
more than 20 toning options via the Type pop-up menu, and adjust 
the combination of paper (which is represented by the Highlights 
section of the pane) and silver (represented by the Shadows). To 
tune your options, you can adjust the Hue or Amount of each 
setting, and use the Swap tones icon (next to the Highlights color 
well) to swap the highlights and shadows colors. The Preserve 
Whites and Blacks button keeps the pure whites and pure blacks 
neutral, instead of taking on the color of the toner.

Film Grain

The last section of the Black & White pane is Film Grain, which, 
like the Toner section, is designed to add a classic film grain look 
to your photos. To add film grain, choose from the drop-down list 
of popular black and white films. The Amount slider controls the 
strength of the effect, while the Size slider adjusts the scale of the 
grain.
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BLEACH BYPASS

This filter is based upon an old color film processing technique 
where the bleaching step was skipped. It reduces the saturation 
and increases the contrast.

• Amount: Controls the strength or amount of the bleach 
bypass appearance.

• Brightness: Adjusts the overall brightness of the image.

• Contrast: Increases or decreases the global contrast.

• Detail: Enhances the details by increasing the micro 
contrast.

• Saturation: Adjusts the underlying saturation.

• Tint: Choose a new color by clicking in the color icon or 
by using the Hue slider.

• Amount: Adjusts the strength of the tint.

BLUR

This filter has five options for adding blur to your images: Gaussian, 
Motion, Radial, Surface and Box. Each blur has its own look:

• Gaussian: This is a simple Gaussian blur applied to your 
image. It has one slider, Amount, which controls the 
strength of the blur by adjusting the radius.

• Motion: This adds the appearance of movement.

• The Amount slider controls the strength of the 
blur, and Distance controls the blur relative to the subject and camera. Angle sets the 
angle of the blur, and the Smoothing slider softens the lines created by the motion.

• Radial: These blurs are circular, zooming out from a central point.

• Amount controls the strength of the blur. Quality controls how noisy the blur is, with 1 
being grainy and 100 smooth. Smoothing softens the lines created by the motion.

• The Radial blur type includes a center spot selector at the bottom of the pane. Click on 
the icon, then click on the part of the image you want to make the center of the blur.

• Surface: These blurs tend to maintain edges but add blur to the details. This blur type can 
give you a “simplified” effect. The Amount slider controls the strength of the blur, while 
Threshold sets how similar colors are grouped.

• Box: A Box blur is similar in concept to a Gaussian blur, but it bases the blur on contrasting 
edges. Box blurs tend to retain edges a bit more clearly than Gaussian blurs.

NOTE: Do not use the Opacity slider when trying to reduce the strength of a 
blur; use the Amount sliders instead.
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BORDERS

ON1 Effects 2023 has a large collection of pre-made borders and 
edges that you can add to your photos. These borders range from 
classic film borders to viewfinders to artistic effects to emulsion 
transfers and many more.

The Borders filter also has an extensive set of controls for 
manipulating the size, color, and blending mode of the borders you 
choose.

You can also import your own borders, either directly into the 
Borders filter pane, or via the Extras Manager (see page 17). 
Border files need to be a standard PNG file type with a large 
central transparent area

The Category and Border pop-ups at the top of the pane are used 
to select the border category and the specific borders within each 
category. There are 8 built-in categories, sorted by type. Any user-
imported borders will also appear in this list.

Once you have chosen a border to add, you can adjust its blending 
mode and opacity, and, if the border has color, you can adjust its 
hue, saturation and brightness. Alternatively, if the border is black 
or white, you can colorize it.

The Transform section at the bottom of the Borders pane lets you 
scale the border up or down in size, to help you get the look you’re 
after, and the Fit Image slider adjusts the size of the image under 
the border.

You can rotate or flip the currently selected border by clicking the 
buttons at the bottom of the screen.

NOTE: See page 17 for information on how to use the Extras Manager to 
import borders, textures and other extras, along with additional information for 
preparing files for the Borders and Textures filters.
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CHANNEL MIXER

The Channel Mixer filter adjusts the intensity and color of the 
individual red, green and blue channels in a photo. You can use it 
for black and white conversions, channel swapping for infrared 
shots, or to shift entire color ranges.

Click on the channel icons to select a specific channel, and use 
the Red, Green and Blue sliders to increase or decrease the pixel 
values for that channel. 

The Constant slider affects the luminosity of the currently selected 
channel. 

COLOR ADJUSTMENT

This pane lets you adjust specific ranges of color in your photos. 
The styles at the top of the pane are designed to help enhance 
specific scene types (Foliage, Fall, Desert, Sky).

In the pane underneath are color swatches for eight colors: red, 
orange, yellow, green, aqua, blue, purple and magenta. Clicking 
on one of the colors will let you adjust the hue, saturation and 
brightness of the selected color range. Other settings include:

• Range: This slider lets you narrow or widen the range of 
the selected color.

• Hue: Changes the hue for the selected color range.

• Saturation: Adjusts the saturation of the selected color 
range.

• Brightness: Adjusts the brightness of the selected color range.

You can also use the pane’s Targeted Dropper tool to adjust the hue, saturation or brightness dynamically. 
To do this, click on the tool and choose which parameter you would like to adjust. Then click in your image 
on a color you would like to adjust and drag the cursor to the left or right to decrease or increase the effect.
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COLOR BALANCE

This filter lets you adjust the colors in a photo’s highlights, 
midtones and shadows tones. This can be useful when you wish 
to color grade a photo, remove color casts from shadows or 
highlights, or to create duotone- or tritone-style images.

To use the pane, click on the tone you wish to adjust (Highlights, 
Midtones, Shadows) and raise the Amount slider. After that, use 
the Hue and Brightness controls to adjust the look you wish to 
achieve. 

The Color patch, which will originally be represented as 18% gray, 
will change, representing the combination of all three sliders for 
that tone.

COLOR ENHANCER

The Color Enhancer is designed to give you complete control over 
color manipulation in your image, whether it is on a globally across 
your entire image, or by adjusting different color ranges. 

The styles at the top of the pane are designed to help enhance 
specific scene types (Foliage, Fall, Desert, Sky). To adjust global 
color in an image, work in the Color section of the top half of the 
filter pane; to work with individual color ranges, use the Color 
Range section at the bottom of the pane.

Color

The Color sliders in the top half of the pane control Temperature, 
Tint and Vibrance. They are used to remove a color cast and 
enhance the color of the image. The settings in this section of the 
Color Enhancer pane include:

• Auto Button: The auto button attempts to detect 
and remove a color cast. It makes adjustments to the 
Temperature and Tint sliders.

• Gray Dropper: Used to remove a color cast of an image. 
Click the icon to activate, then click on an area in the 
image that should be gray. The sliders will automatically 
adjust according to the sample you have selected.

• White Balance: This pop-up lets you change the white 
balance according to common color temperatures 
(As Shot, Auto, Daylight, Cloudy, Shade, Tungsten, 
Florescent, Flash, Custom). The default is As Shot, the 
color temperature that the camera recorded when you took the photo.

• Temperature: This slider shifts the color either cooler (blue) or warmer (yellow).
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• Tint: Shifts the color either green or magenta.

• Saturation: Increases or decreases the saturation of your image.

• Vibrance: Increases or decreases the color of muted tones, leaving more saturated colors 
alone.

• Reduce Vibrance on Skin: When turned on, adjustments made with Vibrance slider are 
reduced on skin colored areas. This allows you to increase the vibrance of clothing and the 
background without adversely affecting the skin color.

• Purity – Highlights: Reduces the saturation in the highlights.

• Purity – Shadows: Reduces the saturation in the shadows.

Color Range

In the Color Range section of the pane are swatches for eight colors: red, orange, yellow, green, aqua, blue, 
purple and magenta. Clicking on one of the colors will let you adjust the hue, saturation and brightness of 
the selected color range. Other settings in the pane include:

• Range: This slider lets you narrow or widen the range of the selected color.

• Hue: Changes the hue for the selected color range.

• Saturation: Adjusts the saturation of the selected color range.

• Brightness: Adjusts the brightness of the selected color range.

You can also use the pane’s Targeted Dropper tool to click on a section of your photo and adjust the hue, 
saturation or brightness dynamically. To do this, click on the tool and choose which parameter you would 
like to adjust. Then click in your image on a color you would like to adjust and drag the cursor to the left or 
right to decrease or increase the effect.

CROSS PROCESS

This filter simulates the effect of processing film deliberately 
with the incorrect chemistry. It creates unnatural colors and high 
contrast.

• Color: A drop-down list of cross-processing types (Blue, 
Green, Yellow, with Strong options).

• Amount: Controls the overall strength of the filter.

• Brightness: Adjusts the overall brightness.

• Contrast: Adjusts the overall contrast.

• Saturation: Adjusts the underlining saturation.
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CURVES

The Curves pane is a powerful—and advanced—tool for adjusting 
contrast, tone and color in your image. 

The main section of the pane displays the histogram of the current 
image in the background; the gradient behind the histogram is 
designed to give you a sense of how the tones will change as you 
adjust the curve. 

The center line is a linear representation of the image’s tonality, 
ranging from 0 to 255; the point at the bottom left represents the 
darkest tones in a photo (minimum of 0), while the point at the 
upper right represents the lightest tones in the photo (maximum 
of 255). By clicking along the line at the center of the pane and 
dragging it up or down you adjust specific tones by making them 
lighter (up) or darker (down). 

By default, the pane shows the composite RGB channel, but you 
can view and adjust each channel separately by clicking on the 
appropriate tab (Red, Green, or Blue). When looking at the individual channels, the background gradient will 
indicate what color shifts will occur when you adjust the curve. For example, raising the points on the curve 
in the Red channel will move the data more towards red, while lowering the points on the curve will move 
the data more towards green. 

Moving the line adjusts the tonality by adding control points along the line (turning the line into a ‘curve,’ 
hence the name):

• Inside the pane, clicking anywhere along the center line will add a point, and you can drag 
that point up or down to change the tones.

• You can also click on the Dropper tool to the left of the channel tabs, then click and drag 
inside the photo at a location where you would like to adjust the tonality. This adds a point at 
the precise tonal location on which you clicked.

You can add multiple control points to the curve, and readjust 
them at any time by clicking on the point in the pane. You can 
“slide” a point along the curve, or you can click and drag up or 
down. If you are familiar with numeric-based color values, you also 
click on a point and use the In or Out boxes to adjust the input or 
output values of the tones at that point. 

To remove a point, right-click on it and choose Remove Control 
Point. Note that there is always at least one control point selected.

Working in the individual RGB channels alters the tonality of each 
specific channel, but the adjustments are similar. To reset any 
curve adjustments made in a channel (or in all channels), right-click 
in the grid, and choose Reset Channel (or Reset All) from the menu.

The Style pop-up for the Curves filter has preset options, including settings for color negatives, matte-style 
looks, and more. If, for example, you regularly apply a classic S-curve to your photos, you could set the 

Right-clicking on a control point gives you the 
option of removing that point. You can also reset 
curve adjustments made to one or all of the 
channels.
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curve the way you like it, and then choose Save New Style from the pop-up. If you apply a style and make 
adjustments to it that you would like to save, select Update Style with Current Settings from the menu.

NOTE: The Curves section of the Tone Enhancer filter (page 95) operates in 
the same way as the Curves filter, with the sole exception being that there are 
no curve-specific style options available.

DYNAMIC CONTRAST

Dynamic contrast adds clarity—also known as tonal contrast—to 
your image, making it pop. It can be a strong effect, so it is often 
combined with masks to help lessen the effect in certain areas of 
an image (clouds in a sky, for example, often look surreal with too 
much Dynamic Contrast applied to them).

The top portion of the pane adjusts the contrast in areas of small, 
medium and large detail; moving the slider to the left decreases the 
contrast, while moving the sliders to the right increases them.

Because adjusting the contrast in extreme ways can affect an 
image’s tonal qualities, the bottom section of the pane lets you 
make adjustments to the highlights and shadows to recover detail, 
in the white and black areas, and increase vibrance.

FILM GRAIN

The Film Grain filter is designed to add a classic film grain look 
to your photos. It operates identically to the section found in 
the Black & White filter, but lets you add grain without having to 
convert your photos to black and white. 

ON1 Effects 2023 has a wide range of grain types from classic 
black-and-white negative films from Kodak, Ilford and Fujifilm. To 
add grain, choose from the Film drop-down menu.

The Amount slider controls the strength of the effect, while the 
Size slider adjusts the scale of the grain.
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GLOW

This pane adds a soft-focus glow to the image, which can be 
accentuated by using different blending modes. The Styles section 
and the More pop-up include a number of different glow types. 
Adjustable settings for the Glow pane include:

• Amount: Controls the overall strength of the glow.

• Halo: Sets the radius of the glow effect; higher numbers 
create more ‘fuzziness’ to your image’s edges.

• Mode: Lets you set the blending mode for the glow 
effect.

GRUNGE

This filter is used to add a dirty or grungy look to your image. 
Settings in this pane include:

• Amount: Adjusts the overall strength of the grunge.

• Brightness: Adjusts the overall brightness of the image.

• Saturation: Adjusts the underlying saturation.

• Detail: Adjusts the amount of detail.

• Glow Amount: Adds a glow to the grunge.

• Mode: Selects the glow blending mode.

• Film Grain Amount: Adds film grain to the image.

• Film Grain Size: Controls the grain size.
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HDR LOOK

This filter recreates the HDR style of tone mapping, with 
accentuated edges and sharpening. Like the Dynamic Contrast 
filter, HDR Look will often benefit from masking or via blend 
modes. Settings include:

• Compression: Compresses the tone to reveal highlight 
and shadow detail.

• Detail: Increases the local contrast of details and edges.

• Clarity: Increases the global contrast.

• Highlights: Recovers detail in the highlights.

• Shadows: Recovers detail in the shadows.

• Vibrance: Adjusts the vibrance of muted colors.

• Glow: Adds a bright glow.

• Grunge: Adds a dark gritty look.

LENS BLUR

This filter creates a blur, based on a camera lens such as a tilt-shift 
or a shallow depth of field look. You can use the Masking Bug to 
adjust the amount of blur through your image, or brush in or out 
the effect where you want it. The filters settings include:

• Amount: Adjusts the overall strength of the blur.

• Optic Quality: Controls the aperture shape in the inner 
and outer feather.

• Sides: Sets the number of blades in the lens aperture, 
which changes the shape of the bokeh.

• Curvature: Sets the curvature of the aperture blades.

• Blooming: Adjusts the highlight bokeh.

• Brightness: Controls the overall brightness of the blur.

• Contrast: Controls the contrast of the blurred areas.

• Noise: Adds simulated film grain to the blurred areas.

NOTE: Do not use the Opacity slider when trying to reduce the strength of a 
blur; use the Amount sliders instead.
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LUTS

The LUTs filter applies a color look-up table (LUT) to transform 
the underlying color of an image. LUTs were first used with video 
applications to provide color-grading (and other) effects to film, 
and they are increasingly popular in still photography. The Styles 
section has  a few default effects you can apply, and you can also 
import your own LUTs, by clicking the Import button inside the 
filter. 

Effects can import common LUT file formats, including .3DL and 
.CUBE file types.

• Category: This pop-up menu lets you choose from one 
of the pre-installed LUT categories, or any categories you 
have imported into Effects.

• LUT: Displays the available LUTs within the chosen category.

• Contrast: Lets you adjust the underlying contrast.

• Saturation: Adds or reduces saturation.

NOTE: See page 17 for information on how to use the Extras Manager to 
import LUTs into Effects.

NOISE REDUCTION

Use this pane to reduce luminance and color noise, while 
maintaining image detail. The styles section includes a number 
of different noise reduction options, based on the type of image 
you’re working on.

• Luminance: Adjusts the overall strength of the noise 
reduction applied to the luminance or detail of the image. 
Hold down the Alt/Option key to see just the luminance 
while adjusting this slider.

• Color: Controls the amount of noise reduction applied 
just to the color or chroma of the image.

• Detail: Controls how much edge detail is protected. Hold 
down the Alt/Option key to see the edge mask while 
adjusting this slider.

• Apply to: Allows you to limit the noise reduction to just a portion of the image based on 
color or brightness values. Options include highlights, shadows and midtones, as well as color 
ranges. To set a custom color range, click the Dropper icon and click on a color area that has 
the noise you wish to remove. Use the Range slider to adjust the range (or ‘fuzziness’) of the 
color range to apply the noise reduction to.
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PHOTO FILTER

This filter recreates traditional color lens filters used for warming, 
cooling, gradients and more. You choose the filter type from the 
pop-up menu at the top of the pane, then adjust the settings to 
your liking. Each type offers different options for selecting a filter 
color (or colors, in the case of the Bi-Color type), adding saturation 
or polarization, and more.

There are four Filter Types: Solid, Graduated, Bi-Color, and Center. 
The Solid option includes a section for choosing the single color 
you wish the filter to be, and an Amount slider for how strong 
you want the effect, as well as a Saturation slider for boosting 
or reducing overall color. The Polarizer slider adds a polarization 
effect, which can sometimes help clear haze or enhance the blues 
and greens in an image.

The Bi-Color and Graduated filter types let you choose filter color 
(or colors), feather for the filter transition, and a direction for the 
effect.

The Center type works much like the Graduated option, with the 
difference being that the filter radiates from the center of your 
image, and you can choose the center to be either clear or colored.

REPLACE COLOR

This filter lets you select a color range and replace that range with 
one of a completely different color. When used with filter masks, 
you can achieve targeted color changes in a photo with ease, while 
retaining the other colors in the image.

The top section of the filter is used to select a target color, and the 
bottom section is where you pick a replacement color. 

First, use the eyedropper tool to select a color from your photo, or 
click on the color swatch to pick one from the color wheel. Adjust 
the Range slider to add or remove colors similar to your target. The 
Amount slider is similar to an opacity setting: anything less than 
100 (the default) will blend the new color with the original color. 
You’ll see the results in real-time, so you can get a good idea of the 
selection.

In the Color Change section, click on the swatch to set a new color, 
or use the Hue, Saturation and Brightness sliders to get the color you’re after. If you have areas where you 
don’t want the source colors changed, use the masking tools to paint the effect out.
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SHARPENING

This pane helps add sharpness to your photos, to compensate 
for a moving subject or a slightly out-of-focus camera, or for an 
illustrative effect. ON1 Effects 2023 offers three algorithms for 
sharpening, High-Pass, Progressive and Unsharp Mask. Which one 
you use depends upon the image or your personal preferences. 
The styles section and the More pop-up have a wide range of 
sharpening styles to help you get started.

• Type: Chooses the sharpening method. Each sharpening 
method has its own set of sliders.

• Amount (all types): Controls the overall strength of the 
sharpening for each sharpening type.

• Halo (Unsharp Mask, High Pass): Sets the radius of the 
sharpening effect. Smaller amounts keep fine detail, 
while larger amounts can exaggerate edge detail.

• Threshold (Unsharp Mask, Progressive): Controls the sharpening effect based on contrast in 
your photo. Larger settings means that smoother areas do not get sharpened.

• Detail (Progressive only): Controls sharpening in small details.

• The Protect section protects highlight, and shadow areas and skin tones from having 
sharpening applied.

SKIN RETOUCHING

The Skin Retouching pane is used to reduce blemishes, smooth 
skin and reduce shine on skin. The styles at the top of the pane 
represent a range of adjustments, from subtle to strong, and the 
More pop-up menu has a number of additional styles for you to 
choose from, depending upon your image. Other settings include:

• Blemishes: Adjusts the strength of acne, pores and fine 
lines.

• Smoothing: Adjusts the strength of smoothing similar to 
makeup foundation.

• Shine: Adjusts the strength of the skin shine.

• Evenness: Adjusts skin color consistency across the 
entire face. It is great for correcting overly yellow 
highlights, shadows that may be green or reducing 
redness in noses and ears.

• Skin Color: Use the Color Dropper icon to select the skin color. Click the icon to activate it 
and single click again on the color of the skin in the image.

• Color Well: This will display the color you have chosen with the Color Dropper. Clicking on 
the well will let you choose a different color to represent the skin.

• Range: Adjusts the precision of the color selected.
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SPLIT TONE

This filter applies a duotone-style effect by using a gradient map 
that tints the dark and light portions of the image in different hues. 
This can be used to age an image and give it an antique or vintage 
look. The styles section has a selection of popular split-tone 
effects, and you can create your own by manipulating the sliders to 
choose a map for the highlight and shadow colors.

To use the pane, you can use the Hue slider in each of the sections 
to choose the colors you want for highlights and shadows. The 
Amount slider controls the strength of the color, and Balance sets 
the balance between the shadow and highlight colors, letting you 
make one of the colors more dominant. You can swap the Highlight 
and Shadow Colors by clicking the button to the right of the 
Highlight color.

The Mode pop-up sets the blending mode for the split tone. The 
options you can choose from are Normal (no blending), Color, 
Lighten, Darken, Multiply or Screen.

SUN FLARE

This filter adds realistic-looking sun flares, sun stars and bokeh 
overlays to a photo. You can resize, move and adjust the tone 
and color of the effect, and can also add toning similar to the 
standalone Sunshine filter. The Type pop-up lets you choose 
between the three options (bokeh, flare or star), and the Texture 
menu displays a range of options for the chosen type.

The Tone & Color section of the filter lets you adjust the 
brightness, saturation and hue of the current texture.

To move the position of the texture, click the icon next to the 
Transform label, then click and drag on the overlay to the desired 
spot. You can use the Scale slider to enlarge the overlay, and you 
can rotate or flip it by clicking on the icons to the left of the Fit to 
Canvas button.

The bottom of the Sun Flare pane includes a version of the 
Sunshine filter, letting you adjust the warmth and saturation of the 
overall effect. The Fade slider gives a matte look to the final effect.
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SUNSHINE

This filter increases the appearance of sunshine in a photo, and can 
help to make a flat, cloudy day more vivid. The controls are fairly 
straightforward, including adjustments for the strength (Amount), 
warmth and saturation. You can use the Glow slider to add a bright 
glow to your image.

TEXTURES

The Textures filter places a texture over the image to add a stylized 
look and is similar to the Borders filter in scope and functionality. 
ON1 Effects 2023 comes with an extensive set of textures that 
you can add to your photos, ranging from fabric, metal, stone, text 
and more. You can also import your own textures directly into the 
Borders filter pane, or via the Extras Manager (see page 17). 
Texture files can be almost any image format (JPEG, TIFF, Raw or 
Photoshop).

When loading a texture file, it will be rotated automatically to 
match the orientation of your image. You can override this with 
the rotate and flip tools, and use the Transform option to scale the 
texture’s size over your image.

The Textures pane has Category and Texture pop-ups at the top 
of the pane, used to help you narrow your texture search. There 
are nine texture categories, sorted by type, and any user-imported 
textures will also appear in this list.

Once you have chosen a texture, you can adjust its blending mode 
and opacity, and, if the texture has color, you can adjust its hue, 
saturation and brightness. Alternatively, if the texture is black or 
white, you can colorize it by clicking on the Colorize button in the 
bottom half of the pane.

The Transform section at the bottom of the pane lets you scale the 
texture up or down in size. You can also rotate or flip the texture 
by clicking the buttons at the bottom of the screen, which can be 
helpful to achieve the look you desire.

NOTE: See page 17 for information on how to use the Extras Manager 
to import textures (and other extras), along with additional information for 
preparing files for Borders and Textures.
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TONE ENHANCER

The Tone Enhancer controls the brightness and contrast, or tone, 
of the image and lets you recover detail in the highlights and 
shadows, and adjust the white or black point. It offers similar 
controls to the Tone section of the Tone & Color pane, and also 
includes a curves dialog.

• Auto Button: The auto button sets the white and black 
points automatically, adjusting all of the primary tone 
settings to balance the histogram.

• Exposure: Adjusting this slider to the right will lighten 
your image. Adjusting to the left will darken your image.

• Contrast: Increase or decrease the contrast.

• Highlights: Darkens the highlights, recovering detail.

• Shadows: Lightens the shadows, revealing details.

• Whites: Adjusts the white point, adding or removing 
contrast in the highlights.

• Blacks: Adjusts the black point, adding or removing 
contrast in the shadows.

• Compression: Compresses the tone to reveal highlight 
and shadow detail.

• Detail: Increases the local contrast in the image.

• Clarity: Enhances large edges to add clarity.

• Curves: The curves dialog is a powerful, advanced tool 
for adjusting contrast and color. For specifics on how to 
work with this feature, see “Curves” on page 86.
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VIGNETTE

The Vignette pane creates flexible vignettes which focus a viewer’s 
eye toward the center of the image by darkening the edges of the 
frame. The buttons at the top of the pane let you quickly apply a 
vignette and then customize the look with the advanced controls. 
Styles apply common vignette types.

• Brightness: Controls how light or dark the vignette is.

• Size: Controls the size of the vignette.

• Feather: Controls the hardness of the edge of the 
vignette.

• Roundness: Controls the shape of the vignette from 
square to round.

• Type: This menu lets you select a Normal, Subtle, or Soft 
vignette effect. The Priority option will let you preserve 
highlights when applying the vignette.

The Center Tool at the bottom left of the pane lets you to select the center point of the vignette. Click 
on the tool icon to activate and then click on the area in the image you wish to make the center of your 
vignette.

VINTAGE

The Vintage filter is for adding an aged, vintage look reminiscent of 
films and photographic papers from the mid-to-late 20th Century. 

• Color: A drop-down menu of various color styles to apply 
to your image.

• Amount: Controls the overall strength of the filter.

• Saturation: Adjusts the saturation of the original image.

• Film Grain Amount: Adds film grain to the image.

• Film Grain Size: Controls the grain size.
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WEATHER

This filter adds weather-inspired overlays to a photo. The 
Precipitation section at the top lets you add rain or snow overlays, 
by choosing a type from the Texture pop-up menu. You can adjust 
the opacity of the effect, and can scale, flip or rotate the overlay 
via the Transform section of the panel.

You can also add fog effects to a photo. To turn this effect on, 
raise the Amount slider in the Fog section at the bottom of the 
pane. The Position pop-up menu includes a number of gradients 
for applying the effect (choose All to apply the effect to the entire 
image). Choose the one that is the best starting place for your 
photo.

The Distance and Transition sliders act upon the gradient, letting 
you choose the intensity and length of the Position gradient, while 
the Rotation slider lets you adjust the angle.
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PART 3: USING LOCAL ADJUSTMENTS
You can easily make local adjustments to portions of an image 
in ON1 Effects 2023. You can apply these adjustments using 
the Adjustment Brush or the Adjustable Gradient, or with the 
Super Select AI or AI Quick Mask tools. You can also use the 
Mask AI selection feature in the Masking Options area of each 
adjustment pane (see page 57 for a discussion of the Masking 
Options section and the use of Mask AI to create automatic 
selections). 

You can create as many local adjustments as you need on an 
image by clicking on the Add Adjustment button at the top of 
the Local Adjustments section. If you’d like to use the Mask AI 
feature, hold the mouse button down on the button, and choose 
the appropriate region for which you wish to apply a local 
adjustment. ON1 Effects will create the mask and open the new 
pane in the Local Adjustments stack.

Local adjustments can be used to apply a gradient filter to 
darken a sky, for example, or to add a more complicated vignette 
to an image. Local adjustments are in essence a mask that is 
applied to a portion of your image, and you can manipulate 
those masks in powerful ways with both the blending modes 
and the luminosity options in the Local tabs.

Operations you can perform with local adjustments include tone 
(exposure, contrast, highlights and shadows, detail), color (white 
balance, saturation and vibrance) and detail (structure and 
noise). Each local adjustment layer can have completely different 
settings and work on different parts of your image. You can also 
use local adjustments to paint with color over part of a photo, to 
perform specialized tasks such as skin retouching or to replace 
the color of an object. 

Local adjustments are independent from the Develop and 
Effects tabs; you can create a local adjustment while working in 
Develop, switch to Effects, and when you click on the Local tab, 
your local adjustments remain intact.

Local tab
To create a local adjustment, click on the Local tab. If there are 
no local adjustment layers present, Effects will add one. If you 
want to add additional adjustment layers, click the Add 
Adjustment button. If you wish to use Mask AI to create an 
adjustment for a specific region (or regions in a photo), click and 
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hold on the Add Adjustment button. This will display a list of regions in the photo, and you can select the 
appropriate regions directly from the pop-up menu.

The top of each adjustment layer includes the following options:

• Opacity: Sets the opacity of the adjustment.

• Styles: The pane has a number of styles for you to start 
with, including ones for lightening or darkening, adding 
vibrance, fixing teeth or red eye, and more. (You can also 
save your own styles via the More pop-up menu.)

The main section of the Local tab has all of the same options 
found in the Tone & Color pane in the Develop tab: Exposure, 
Contrast, Highlights, Shadows, Detail, and Color Temperature, Tint, 
Saturation and Vibrance. In addition to those settings, the local 
adjustment pane includes a Noise slider, designed to help reduce 
noise on a targeted level (most often seen in the shadows).

These controls work the same way inside the Local Adjustments 
panel. One difference is that, since a local adjustment is actually 
a layer that sits on top of your global adjustments, ON1 Effects 
2023 provides you with a number of blending options for each 
adjustment. Blending modes determine how the selected layer 
blend with the items below it in the image stack.

TIP: You can name each adjustment layer by double-clicking on the word 
‘Adjustment’ in the pane. This can be helpful when you have a lot of adjustment 
layers and wish to remember which adjustment did what.

Click on the Blending Options gear icon at the top of the Local tab to drop down the Blending Options:

• Blending Options: A pop-up list of blending modes. 
There are 24 common blending modes available in 
the list, including Normal, Lighten, Darken, Screen, 
Multiply, Soft Light, Hard Light, Overlay and Color.

• Apply To: This lets you apply the blending mode 
to a specific color or tonal range. The options are; 
All (the default), Highlights, Midtones, Shadows, 
Reds, Greens, Blues, Magentas, Cyans, Yellows, 
Flesh Colors, Vivid Colors and Neutrals. (You can 
also manually choose a color range by selecting the 
Dropper Tool and clicking on a color in your image.) 
 When you choose one of the options in this 
menu, the adjustment is only applied to that part 
of the image that is based on the lightness, hue, 
or saturation range specified. The Range slider 
expands or contracts the selected option, and the 
Highlights, Shadows, and Skin sliders protect those 
settings from your adjustments.

You can use the Mask AI feature to add a new local 
adjustment layer by clicking and holding on the Add 
Adjustment button at the top of the Local tab. The 
regions in the current photo will be labeled.

The Adjustment pane’s Blending controls give you extensive 
options for applying local adjustments to targeted tonal and 
color ranges in an image.
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For detailed information on how the various blending modes work, see page 77

PAINTING WITH COLOR

The Paint with Color option at the bottom of the local 
adjustment panel lets you use the Local Adjustment 
brush to select a color and paint it into your image. It 
is designed for two situations: when you wish to apply 
softening (or evening out) to portions of an image by blending existing color, and to replace the color of an 
existing object. 

The Paint with Color section has three options, Solid Paint, Replace Color, and Classic, and a color swatch 
for the chosen color. You can choose a color from your image by clicking on the eyedropper icon, or you 
can click on the swatch and choose a color from the system color picker. 

Solid Paint will paint over anything you brush with the chosen color; think of it as painting with a Normal 
blending mode. Replace Color will replace the hue, but not the luminosity, of the color you are brushing 
over; it is essentially painting with a Color blend mode, in which whites are preserved. 

The Solid Paint option is an ideal skin softening tool; use the eyedropper to select a midtone section of skin, 
and, using a low opacity setting, paint over parts of the skin with the brush. This option is also useful when 
you are using custom brushes to add overlays to a photo. See page 101 for more on this.

Working with Local Adjustments
When adding a local adjustment layer, click on the tool you wish to use in the Tool Options bar at the top 
of the window. The Adjustment Brush is perfect for working with specific subjects or areas in an image: 
a person or primary object that you wish to brighten, shadow areas that you wish to darken, and more. 
It works in the same manner as the regular Masking Brush: you set the paint mode (in or out), brush size, 
feather and opacity, and brush in the areas you wish to paint an effect in or out.

The Adjustable Gradient is designed to apply a gradient mask over a section of an image: most commonly to 
darken a sky, for example. Because the local adjustment tools are for working on a mask, you have all of the 
masking and blending options you have throughout Effects, and you can use one or both tools—in addition 
to the Refine, Chisel and Blur Mask tools—to refine your adjustment mask as desired. 

To apply a standard gradient to a local adjustment, click on the tool, then click in the image roughly where 
you wish the effect to be. You’ll see the outline of the gradient, which is called a bug. You can use the 
handles on the bug to move your gradient, increase or decrease the length of the gradient, or rotate it.

You can change the gradient shape via the Tool Options bar: in addition to the standard dark-to-light 
horizontal gradient, you can also create a circular gradient and a reflected gradient, which is like the 
horizontal gradient, but goes from black (no effect) at the outer edges to white (full effect) in the center.
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MANIPULATING A GRADIENT MASK 

Once you’ve added a gradient to an image, you can 
modify it by accessing the parts of the gradient overlay: 

• To move a gradient, click on the big circle at 
the center of the gradient and drag. 

• To resize a radial gradient, click and drag on the 
solid line. 

• To adjust the feather (hardness) of the mask, 
click and drag along the dashed line. 

• To rotate the mask, click the smaller circle near 
the gradient center and drag. 

When working with local adjustment masks, all of the tools in the Refine group—the Refine Mask, and the 
Chisel and Blur tools—can be used to help give you create smoother and more realistic masks.

OTHER MASKING OPTIONS

Every local adjustment has its own mask, and it uses the same masking options and controls found in 
throughout Effects. To access the mask, click on the mask icon in the title bar of the local adjustment layer. 
There you can copy and paste masks, create luminosity masks, and create masks based on color ranges. For 
specific details on how to work with these masking options, see page 55.

Using Custom Brushes to Add Overlays To Photos

Using custom brushes, available via the Brush Shape pop-up in the Adjustment Brush’s Tool Options bar, you can easily add realistic shapes—such as the 
clouds shown here—as overlays to your photos.
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One specialized use for local adjustment layers and the Paint With Color’s 
Solid Paint option is to add overlays with custom brush shapes. You can paint 
in stamps, watermarks, and other shapes to create specialized creations or 
enhanced photos. For example, you could use a custom cloud brush to add 
interest to a lackluster sky, or you could create your own watermark and apply it 
precisely. Effects comes with a collection of custom brushes of all kinds, and you 
can import any black-and-white TIF file or Photoshop-compatible .abr brush file 
for use in the app, via the Extras Manager (see page 17).

Creating basic overlays with a custom brush is easy:

1.	 Create a new local adjustments layer by clicking on the Local tab.

2.	 If the Adjustment Brush isn’t selected in the Tool Options bar, select 
it, and choose a new brush from the Shape menu in the options bar.

3.	 Set the brush size and angle. In general, you’ll want to keep the 
Opacity and Flow high, and the Feather low (or 0), but that will depend upon the brush and 
the application.

4.	 From the gear menu, turn the Manual Spacing option on. Depending upon the brush type 
and the application, you’ll have to play with the Amount slider, but the general rule of thumb 
is, for stamped brushes, where you wish the shape to be applied singly, set the spacing 
low. If you wish to apply the brush multiple times with a stroke—and have clear definition 
between the brush shapes—set the spacing higher (see the spacing chart below for an 
illustration of the different settings).

5.	 Turn the Paint With Color option on and set to Solid Paint. Choose a color for brush, and 
paint as desired on the image.

TIPS FOR USING CUSTOM BRUSHES

• The best way to begin working with brush overlays is to practice. Use some of the default 
brushes, and play with them by adding them to a photo or blank canvas.

• Use the Brush Styles option (in the Tool Options bar) to save your favorite brushes and their 
optimal settings.

• The maximum brush size in Effects is 2500 pixels.

• If you’re applying a brush as a single stamp here and there on a photo, start with a feather of 
0, and Opacity and Flow set to 100. Once you’ve set your brush size and angle, click once on 
the image.

• The Paint With Color option applies to all brush strokes made on that adjustment layer. You 
can easily change the color via the color patch in the panel. If you want to apply the same 
stamp with different colors, create a new adjustment layer for each color.

The Manual Spacing option is 
key when using custom 
brushes as stamps.
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This chart shows the effect of the Manual Spacing on a brush stroke for a star custom brush. With a spacing of 100, as you stroke, the stroke will be applied 
with plenty of space between the brush shape. With a spacing of 0, the shape will meld together as you apply the stroke. Depending upon the brush type, 
this might be acceptable for your purposes.
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PART 4: WORKING WITH LAYERS

The Layers functionality inside ON1 Effects lets you create quick composites, blend multiple images 
together, paint in new skies or backgrounds, align layers based on their content, and much more. And, 
because Layers is tightly integrated within Effects, all of your work remains re-editable at all times: you can 
go back and add, change or update any setting made in the Effects and Local Adjustments stacks, on any 
layer.

You can combine multiple photos or copies of the same photo as layers. Each layer can be moved, sized and 
masked on its own. But more than that, each layer has its own non-destructive settings—just like any photo 
in Effects, all the way back to the original raw data. 

When you add a layer to a photo, Effects 
automatically creates a new document with an 
.onphoto extension, leaving your original photo 
intact. This document type contains all the 
layer information and non-destructive editing 
operations made inside Effects. 

Layers can be as simple as copies of the current photo, to apply more complex adjustments to portions of 
an image than you could with local adjustments. You can also add other documents as a layer inside the 
current document, for replacing skies or other backgrounds, for adding textures, or for when you wish to 
create complex collages. Effects supports up to 14 layers in a document.

Once you have added a layer, all of Effects’ options are available for that layer. When you click on a layer, 
you can add any filter or local adjustment, create masks, and more. You can use the Transform tool to move, 
rotate, and scale the contents of a layer independently from the complete document. (Because the Crop 
tool works at the document level, you can’t crop individual layers.)
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Adding a New Layer
The easiest way to add a new layer to an existing image is to choose Add Layer from File item in the Layer 
menu. This will open the Add Layer window, which will two tabs in it: Extras and Folders. The Extras tab 
will display two folders, ON1 Extras and My Extras. The ON1 folder will include all of the Extras installed 
with your copy of Effects, including backgrounds, textures, borders, skies, and more. The My Extras folder 
will include any similar files you have added to Effects via the Extras Manager (as described on page 17).

If you wish to open a different file, click on the Browse button at the top of the Add Layer window, which 
will open your computer’s file selection dialog box, where you can navigate to the specific file. Any file 
compatible with ON1 Effects 2020 can be opened and added as a layer.

OPENING A LAYERED PHOTOSHOP FILE

ON1 Effects 2023 can open most layered Photoshop files. What happens depends upon the composition 
and type of layers in the document:

• If the layered document has basic Photoshop layers and masks, Effects will open the 
document with each layer and mask visible in the Layers pane. 

• If the Photoshop file has specialty layers—smart objects, text layers, layer styles—Effects will 
flatten the visible layers and will open the file as a composite image, with a single layer.

When you choose Add Layer from File, a window appears with Extras and Folders tabs. The Extras tab contains backgrounds (shown above), textures 
and borders supplied by ON1 with Effects, as well as any extras you might have added via the Extras Manager. Clicking on the Folders tab (or the 
Browse button at the top right of the window) will let you browse your computer for photos and other supported files.
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Working with the Layers Pane 
The Layers pane has three sections:

A.	Layer Opacity: Reflects the opacity of 
the currently selected layer.

B.	 Layers: All of the layers in your 
document are listed here, with a 
thumbnail of the layer contents and the 
layer mask (if there is one); the currently 
selected layer has an colored outline 
around it (based on the Accent Color 
chosen in the System Preferences’ 
General tab). You can rename a layer by 
double-clicking on the title.

C.	 Layer Tools: The toolbar at the bottom of the Layers pane includes buttons for performing 
basic layer operations (described in more detail below). 

LAYER PANE OPERATIONS

There are a few basic operations you can perform directly inside the Layers pane:

• A layer’s visibility can be turned on or off by clicking the button to the left of the layer 
thumbnail. When turned off, the layer has no effect on the composite image. 

• The Opacity slider controls how opaque or how strong the selected layer is. The default is 
100%. At lower settings, the layer will blend with the layer(s) under it. Altering the blending 
mode and opacity of a layer can create a wide range of color and tone effects. 

• You may change the order of layers by dragging and dropping layers into the order you prefer. 

• You can rename a layer by double-clicking on it. The name turns into an editable field. Type in 
your preferred name and press Enter. 

LAYER PANE TOOLBAR

All of the layer commands in Effects can be 
accessed via the Layers menu and a pop-up 
menu that you get when you right-click on any 
layer. The toolbar at the bottom of the Layers pane, however, contains the basic commands you need when 
working with layers. From left, the icons represent:

• New Layer: Adds a new layer, opening the Add Layer from File window.

• Duplicate Layer: Makes a duplicate layer, including any Effects and Local Adjustments 
settings made in the original image.

• New Color Fill Layer: Creates a new color fill layer.

• Delete Layer: Deletes the currently selected layer.

• Merge Layer: Merges the currently selected layer with the one directly beneath it in the 
Layers stack.

The Layers pane in Effects. This photo has three active layers.
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• Blending Modes: Lets you select a blending mode for the current layer. (See page 77 for 
more about working with blend modes inside Effects.)

Other layer commands, available via the Layer menu or pop-up, include:

• Reset Layer Properties: Deletes any layer masks or transform 
operations you have made to the current layer. To reset Effects or local 
adjustments made to a layer, click the Reset Layer button at the bottom 
right of the main window.

• Merge Visible: Unlike the Merge Layer command, this will merge all 
of the visible layers—ones with the layer visibility status set to on—in 
a file into a single composite layer, with all of the merged layers’ effect 
applied.

• New Stamped Layer: When you have the top layer in the stack 
selected, this option will create a new composite layer at the top of the 
stack, with all of the layers’ effect applied.

• Align Visible Layers: This will align the visible layers, based on the content of the layers. See 
page 108 for more information about this feature. 

Changing Blending Modes 

Blending modes determine how the selected layer blend with the layer(s) below it. The default blending 
mode is Normal. This maintains the full opacity of the upper layer. Layers also supports many other 
blending modes which can be used to alter the brightness, contrast and color of the image. See “Blending 
Modes” on page 77 for more detailed information on this topic. 

Layer Masks 

If you use any of the masking tools, a layer mask will be created automatically. Clicking on the layer’s mask 
icon will display the standard Effects mask options, and you can use all of Effects’ masking tools to create 
or modify layer masks. You can also copy and paste layer masks—including masks from Effects filters—via 
the Mask options section or via the Mask menu. See “Filter Masks” on page 75 and “Masking Tools,” 
starting on “Masking tools” on page 35 for more on using Effects’ masking tools.

NOTE: If the file you add is larger or smaller than the pixel dimensions of 
the document, use the Transform tool to resize it as desired. If you wish to 
preserve the original aspect ratio of the placed file, use the Shift key to resize it 
proportionally. 

Right-clicking on a layer 
brings up a list of available 
Layers operations.
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Using the Transform Tool with Layers
Use the Transform tool (see page 32) at the top of the Toolbar to manipulate layers. A layer may be 
repositioned, sized or rotated using the tool. When selected, transform handles will appear on the edges of 
the selected layer. You use these transform handles to manipulate the image. You can only transform one 
layer at a time. 

REPOSITIONING A LAYER 

To reposition a layer, simply click and drag inside the transform box. You can also use the keyboard arrow 
keys to nudge a layer one pixel in any direction. 

RESIZING A LAYER 

To resize a layer, click and drag on any of the transform handles. Clicking on a corner handle allows you to 
adjust two sides simultaneously. Clicking on a side handle allows you to adjust that side. If you hold the 
shift key down while adjusting the size, the proportions of the layer are maintained. If you hold down the 
Option (MacOS) or Alt (Windows) key while resizing, your image will resize from the center instead of from 
the edge. You can hold down Shift-Option (or Shift-Alt) to resize proportionally from the center. 

You can type in the size you desire in the Tool Options bar in the width and height fields. You can also size a 
layer to fill the canvas automatically by pressing the Fill button in the Inspector. 

ROTATING A LAYER 

To rotate a layer, move the Transform tool just outside a corner transform handle. Notice that the tool 
cursor changes to a rotate cursor. Now click and drag to rotate the layer. You can also use Option/ 
Alt with the left or right arrow keys to rotate a layer when the Transform tool is selected. To rotate the 
layer in 90 degree increments, use the rotate left and rotate right buttons in the Tool Options bar. 

FLIPPING A LAYER 

You can flip a layer either horizontally or vertically by pressing the flip buttons in the Tool Options Bar. 
When you have completed your transforms you need to commit the changes. You can do this by pressing 
the Apply button that appears in the Tool Options Bar or by pressing the Enter key. You can cancel a 
transform by pressing the Cancel button in the Tool Options Bar or by pressing the Escape key. 

Aligning Layers
Effects can also align multiple layers based on content. This can be a great aid when you’ve hand-held a 
group of shots, and want to blend portions of one image onto another, to use a better sky, for example. 

To align layers, open the images in the Layers pane, and choose Align Layers from the Layer menu or pop-
up menu. Effects will then analyze the contents of the layers, and align them to the one with the most 
commonality. When you look at the individual layers after aligning them, you’ll see that some layers have 
been moved or rotated slightly to match the content.
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PART 5: PRINTING

ON1 Effects 2023 has a flexible print engine that can print photos at any size. You can print photos 
individually; or multiple versions of a photo, package style, on a single piece of paper. You can even print 
when using Effects as a plugin from any of its supported image editors. 

The print window can be opened by clicking on the Print icon in the module selector, or by selecting the 
Print command from the File menu. It has the following components:

A.	Preview: Displays the photo being printed.

B.	 View Selector: The first three icons are not applicable inside Effects; the icon on the far right 
turns soft proofing on and off.

C.	 Page view: Displays the number of pages being printed. (Not applicable in Effects 2023.)

D.	Printer pane: Contains options for output—printer or PDF—as well as printer, page setup, 
page size, number of copies, resolution, and printer profile and rendering intent.

E.	 Print Area pane: Contains options for fitting and selecting the print image size.

F.	 Watermark pane: For adding a watermark to printed photos.

G.	Sharpening: Options for sharpening during the print process.

H.	Print/Cancel: Print the current photo or cancel the operation.
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NOTE: The print engine in Effects 2023 is based upon the engine inside Photo 
RAW 2023, which has the capability to print multiple photos at a time. Because 
Effects can only work with a single photo at a time, some of the options, like 
contact sheets and some view settings, are not applicable in Effects.

Printing Options
The four panes in the Print window—Printer, Print Area, Watermark, and Sharpening—each deal with a 
specific printing-related task.

PRINTER PANE

The Printer pane is where you set the printer-specific features 
for your output. It has two modes, which are chosen by clicking 
on the icon at the top of the pane: Print, which lets you print to a 
connected printer, and File, which will print the selection to a PDF. 

When choosing to output to a printer, you’ll set the specifics of 
your printer, the paper size you wish to print to, the resolution, 
orientation, and the number of copies. When choosing resolution, 
make sure that you are printing at the printer’s optimal resolution. 
Most photo printers, for example, work best with a file that has 
between 240 and 360 ppi. (Effects will use its internal resampling 
engine to ensure that your photo is at the final resolution you 
choose.)

At the bottom of the pane is a section for choosing a printer-specific color profile; choose the media profile 
for the paper type you are printing to. If you wish the printer to handle the color conversion, select the 
Printer Managed Color option in the Profile list.

The rendering intent is related to the conversion of an image’s colors to fit within the color range (or gamut) 
of the printer. The default intent, Perceptual, will change all of the colors in a photo proportionally to fit 
within the printer’s range of colors. The other option, Relative Colorimetric will only change the colors out 
of the printer’s gamut, to the closest in-gamut color. Depending upon the image, you might need to play 
with the intent settings, but Perceptual is usually the best place to start. 

When choosing a specific paper profile—as opposed to Printer Managed Color—you can use Effects’ Soft 
Proofing feature to look at out-of-gamut colors in your photos. Click on the soft proof icon at the bottom 
left side of the window to view the photo with your chosen paper. (See “Soft Proofing” on page 66.)

NOTE: Effects’ Print feature will work with borderless printing options as well. 
Be sure to choose your printer’s borderless options in the page setup pop-up. 
Different printers will have specific borderless settings, so check the manual to 
see how to turn borderless printing on.

The Printer pane sets printer-specific options for 
the current print job. You can also choose to render 
the print job to a PDF file.
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Printing to a file

In addition to sending images to a printer, you can also choose to export the current print job to a file. This 
can be helpful if you are submitting prints to an online service or to print remotely.  To use this option, click 
on the File icon at the top of the pane. Effects will ask you for a filename and a location to save the file. 
Choose a page size for the file from the Page Size pop-up, and adjust your print area settings. When you 
choose Print, Effects will create a PDF of the photo (or photos) and save it with the name and destination 
you specified earlier.

PRINT AREA PANE

The Print Area pane is where you set the options for the size of the 
print, and how you wish your photos to be printed. You can also 
choose whether to print photos individually or package-style. (The 
contact sheet option, while present, is not applicable in Effects, as 
it is largely designed to gang-print a set of different photos.)

The top of the pane includes preset styles for either fitting the 
current photo inside the size of the print, or filling the entire size 
of the print. It also includes options for printing at common print 
sizes, including 8x10, 5x7, 4x6; and options for printing to a contact 
sheet. You can also create custom print sizes via the Custom 
section at the bottom of the pane; just set the width and height of 
the print size, and whether you wish to fit the image to the print 
size, or to fill the frame with it. If you would like to save this print size as a style, click on the More pop-up 
at the top of the pane, and choose Save as New Style from the menu. You’ll then be able to recall that style 
from the More pop-up whenever you print.

If you are printing multiple copies of a single photo, Effects will attempt to put as many photos at your 
chosen print size on the paper size as defined in the Printer pane. To print only one photo per page, click 
that option at the bottom of the Print Area pane.

Page size vs. print size

It’s worth understanding the distinction between the page size and the print size. In some cases, the two 
will be identical. For example, if you wish to print on 4x6-inch photo paper, you would choose that option 
in the Printer pane’s Page Size pop-up, and then 4x6 in the Print Area’s Custom pop-up. Depending upon 
the aspect ratio of your photo, you then might need to choose Fit or Fill to get the proper crop. Fit does 
exactly what it sounds like: it will fit the entire photo within the bounds of the photo’s dimensions, which 
means that there could be some extra white space around the final print. Fill will resize the photo to fill the 
dimensions of the chosen print size, centering the image. 

In our example, a 4x6-inch print has an aspect ratio of 2:3. If the photo you are printing has that aspect 
ratio, then Fit and Fill do the exact same thing: the photo will fill the print area without any cropping.

For package printing, where you wish to generate multiple prints on a larger sheet of paper, you’ll set the 
specific size paper you are printing to in the Printer pane, and then set the appropriate print size for each 
photo in the Print Area pane.

The Print Area pane is for setting the actual print 
size of the photo or photos you are printing.
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WATERMARK PANE

The Watermark pane adds an overlay to the printed image, and is 
most often used for your logo, signature or copyright. Watermarks 
generally need a transparent background, so make sure your 
watermark file is a PNG or PSD.

The module has the following options:

• Choose: Click the Choose button to select the file you 
wish to use as your watermark. Once you’ve added a 
watermark file, it will be saved to the Logo File pop-up.

• Size: This slider controls the size of the watermark file.

• Inset: This will determine the percentage in which the 
file is inset from the edge, based on the Position (see 
below).

• Opacity: This sets the opacity of the watermark.

• Position: This grid sets the location of the watermark. 
Click on the square of the location you desire.

When working with watermarks, make sure your watermark file 
is sufficiently large for your usage. For example, if you want it to 
appear 2 inches wide on a 300-ppi image, your watermark needs to be at least 600 pixels wide. Otherwise, 
it could appear pixelated on the print.

SHARPENING PANE

In most cases, and depending upon the media type you print 
to—glossy papers often benefit from additional sharpening, for 
example—you’ll need to add an additional sharpening step when 
printing. This is an additional level of sharpening beyond anything 
you might have applied in the Effects or Local Adjustment panels. 

The Sharpening pane lets you select a type of sharpening that will 
be applied to your photos during the printing process. The pop-up 
menu has a set of options for general sharpening, including ones 
for a standard print, glossy papers, details, high-pass sharpening, 
and many more. Depending upon the image, you might need to play with the settings here; performing test 
prints on small sections of a photo can often be quite helpful in determining the proper level of sharpening 
in a print.
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PART 6: EXPORT
Export is a special function that is available inside ON1 Effects 2023. The Export window gives you the 
power of ON1’s patented Resize technology in an easy-to-use panel, letting you export your photos with 
incredible flexibility, ease and control.

The Export window is separated into two panels: Export Presets and Export Options. The Options panel 
contains specific types of options—file renaming, destination folders, file type and more—that you can use 
when you are exporting images from Effects. If you find that you are using a specific set of options all the 
time for your workflow, you can create a preset and apply that whenever you use Export.

The contents of the Export window include:

A.	Export Presets: The current preset (if used), will be represented with a selection box around 
it, and the filled circle to the left of the preset name means that it will be used when the 
Export button is pressed. To use the Export Options panel without any preset applied, turn 
off all of the presets in the list, and click in the current preset once.

B.	 Save Preset: Lets you save the current set of export options as a preset.
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C.	 Naming: Renames the exported file based on criteria added to the rename box in the panel.

D.	Destination: Lets you set the destination of the exported files. (required)

E.	 File Type: Sets the file type for each exported file. (required)

F.	 Resize: Adjusts the size for each image. 

G.	Sharpening: Applies sharpening to the exported images.

H.	Metadata: Adds/removes metadata from the export. 

I.	 Watermark: Lets you add a text or graphic watermark to an exported image. 

J.	 Export/Cancel: Starts the exporting, or cancels it and returns you to Effects.

 Export Options

NAMING

The Naming pane gives you extensive controls for creating customized filenames using tokens in the entry 
box inside the pane, as well as with any custom text entered directly into the entry box. You can use any 
combination of tokens and text in the entry box, and the Example label directly above the box will display 
what your new filename will look like, using the 
first item in the export group.

To use this feature, click the control circle to the 
left of the label in the panel. Add any custom 
text, or click the Add Token pop-up menu to add 
tokens based on information associated with the 
image, including filename data, date and time 
information, and associated metadata There are 
four submenus in the Add Token menu:

• Filename, which includes options for using the original filename, number suffix (taken from 
the image as recorded by the camera) and enclosing folder name.

• Date/Time, which includes a list of date (year, month, day) and time data that can be 
combined in various ways.

• Sequence is intended for batch processing of images. (Not applicable when exporting from 
Effects, which processes a single image at a time.) 

• Metadata, which lets you add specific EXIF and IPTC metadata to the filename.

To build a rename sequence using tokens, click on the Add Token button, and choose the appropriate token 
from the pop-up menu. The token will be added as a shaded item in the text field, and the Example item 
above the text field will show a sample of a renamed file using the current set of tokens and custom text. 
To change an existing token, click on the down arrow on the right of the token, which will display the full 
set of tokens. To delete a token, double-click on it and press the Delete key.

Custom text can be added anywhere in the entry field. You can click the cursor at the beginning or end 
of a token (or in between tokens) and add spaces, dashes, underscores and any other text you wish to be 
included in each renamed file. Each change you make will be updated automatically in the Example label.



ON1 Effects 2023 User Guide	 Part 6: Export	 115

The Presets pop-up menu at the top of the Rename window includes a set of common token combinations 
that you can use as a starting point. You can also create your own batch-rename presets: build the rename 
options you wish, and choose Save New Preset from the bottom of the Presets menu. You can also update 
an existing preset and delete presets from this menu.

Because the Rename process is not undoable, make sure you use the Example field to check that your text 
and token combinations give you the filenames you expect for your batch process, and adjust as needed. 
When you’re sure, click Apply, and Effects will rename all of the files.

NOTE: A complete list of the tokens used in the Rename window, with 
explanations, can be found starting on page 120.

DESTINATION

The Destination pane is where you set the 
desired location for the exported images. At 
minimum, you must specify a destination folder 
for your export, but the pane has a number of 
options for adjusting the export location:

• The Folder pop-up menu lets you 
choose the same folder as the original 
images, another folder, or, can be set 
to ask for a destination every time, 
which can be helpful when you’re 
using an export preset.

• Checking the Put in Subfolder option 
will export the images to the folder—
or, create a new folder, if it doesn’t 
exist—specified by option’s text field.

• The Existing Photos pop-up is for 
those times when there might be a 
naming conflict within the destination 
folder. Replace will overwrite the file 
with the new one being exported, Skip 
will leave the destination file alone 
and not export the new file, and Keep 
Both will add a number ‘1’ to the end of the filename of the exported file, preserving both 
files.

• Generate Subfolders will subdivide the export based on the exported file’s metadata, 
creating subfolders as necessary—or, if the folders exist, placing the exported file into the 
appropriate subfolder. This option uses the same token-driven scheme (and presets) used in 
the Naming pane.

• After Export lets you determine what to do when Effects completes the exporting process. 
Options include displaying the image location in the MacOS Finder or Windows Explorer, to 



ON1 Effects 2023 User Guide	 Part 6: Export	 116

create a ZIP archive of the exported group, to open in another editing application, or to run a 
script.

FILE TYPE

Like Destination, File Type is the other required 
element for using Export. Effects can export in 
DNG, PSD, TIFF, JPG and PNG formats. With 
the exception of DNG and PNG, each file format 
has specific options in the pane:

• Original includes options for embedding metadata and saving an ON1 sidecar file with the 
exported images.

• JPEG includes options for JPEG quality and for attaching a color profile.

• Photoshop includes options for attaching a color profile, bit depth, and whether to flatten 
any layers in the original image.

• TIFF includes options for image compression (none, LZW or ZIP), attaching a color profile, bit 
depth, and to preserve transparency.

• DNG and PNG have no additional options.

The File Type pane also includes an estimated file size for the first item in the group.

RESIZE

The Resize pane lets you adjust the finished 
dimensions of the exported photos, using the 
patented Genuine Fractals technology found 
in ON1 Resize. It has seven options for export: 
Dimensions, Long and Short Edge, Width and 
Height, Megapixels and Percentage. Each option 
has a different range of settings, and all have a 
setting for resolution (in pixels per inch, or ppi), as well as a Don’t Enlarge option, which, when set, will not 
upscale a file past its native image dimensions (but will still export the file). 

The Dimensions option is the most complex of the six Resize options, letting you set the exact pixel 
dimensions of the exported files, in terms of width and height. This option is best for when you are 
exporting single images, when all of your exported files have the same aspect ratio and orientation, or 
when you wish to fit the exported images to an exact size. 

The Common Sizes pop-up menu at the top of the pane options lets you set the final dimensions to any of a 
broad array of common paper, photographic ratio, square and video formats. You can also create your own 
specific sizes for re-use via this menu.

Click the lock icon to resize the images proportionally as you enter either the width or the height, or, if 
you wish to fit the images to an exact width and height, click the lock icon to turn it off. If an exported 
image doesn’t exactly fit the dimensions you set for Width and Height, Export will do one of two things, 
depending upon whether you have Fit in Dimensions or Fill Dimensions set in the pop-up to the right of the 
Resolution box.

The Resize pane, with the Dimensions option open.



ON1 Effects 2023 User Guide	 Part 6: Export	 117

• Fit in Dimensions will fit the exported file inside the boundaries of the width and height 
settings.

• Fill in Dimensions will zoom the exported image to completely fill the boundaries of the width 
and height settings, essentially cropping the exported image. If the image’s aspect ratio is 
different from the width and height settings, the image will be filled from the center. 

The Dimensions options include one more setting, Rotate to Match Photo, which, when checked, will rotate 
an exported photo to maximize its orientation. For example, if you exported a group of images to fit a 
landscape orientation (longer width than height), any image that was in portrait orientation (longer height 
than width) would be rotated during export.

The remaining options in the Resize pane include:

Long Edge and Short Edge are useful when you want to lock one edge to a 
specific length or width and don’t care about the sizing of the other edge. 
Simply choose which option is the important one for your photos, enter the 
dimension, and Export will resize your images proportionally based on the 
chosen setting. When you’re exporting a group of images with different 
orientations (landscape or portrait), these options will ensure that all images 
have the same long or short edge dimension.

Width and Height will resize all of the images proportionally to the width 
or height defined, regardless of orientation. Exporting photos with different 
orientation will result in the width or height of every image being the same, 
depending upon the setting chosen.

Megapixels will export images to a specific megapixel count, while Percentage will enlarge or reduce the 
size of the exported images. Percentages below 100 will reduce the image, while those above 100 will 
enlarge the image.

SHARPENING

The Sharpening pane has two modes, Sharpen 
For and Manual. The Sharpen For pop-up 
menu lets you choose from six options, based 
upon your final intent. There are four options 
designed for print output, Glossy Paper High 
and Low, and Matte High and Low, and two 
option for display output (for social media or 
online sharing), Screen High and Low.

The Manual setting provides a bit more control 
over the output sharpening, letting you adjust 
the Amount (overall strength), Radius (detail) and Threshold (masks out areas that shouldn’t be sharpened 
based on contrast). 

Resize has seven options for 
exporting images.
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METADATA

The Metadata pane lets you set which pieces of 
metadata are exported—or not exported—with 
the images in the export set. You can choose to 
export all Metadata or by clicking the control 
circle to the right of the All Metadata label. 
If you click that label off, you can then select 
which metadata items you wish to save by 
clicking the appropriate label.

When checked, the Remove Unmanaged XMP 
button only exports metadata that ON1 recognizes as standard metadata fields; any unmanaged image 
metadata from other apps will not be included. 

WATERMARK

The Watermark pane adds either text- or graphics-
based watermarks to an image, with options for 
size and positioning, opacity, font type, and more. 
You can import your own logos and save either 
watermark type as a preset for frequent use. 

The Watermark pane also gives you a representation 
of your chosen watermark (on the first image in your 
export group), so you can adjust the parameters of 
the watermark precisely.

To create a new watermark, turn on the pane by 
clicking on the control circle to the right of the label. 
Choose either a preset from the Presets menu or 
click on the Add Watermark button in the lower 
right of the pane and choose either Text or Logo 
from the pop-up menu. Once you’ve selected a type, 
the bottom of the pane will open with settings for 
the chosen option. If you change your mind, click the 
Cancel button to the right of the Logo or Text labels.

Using graphics-based watermarks

The Logo section of the Watermark pane lets you 
use either watermark files imported via the Extras 
Manager (see page 17), which will be displayed 
in the File pop-up at the top of the Logo section, or 
by clicking on the Import button to the right of the 
menu (which will add them to the menu). 

Use the Position grid at the bottom of the pane to 
place your watermark, and use the Size and Inset sliders to move it within the area chosen. The Opacity 
slider adjusts the transparency of the watermark on the final image.
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The Repeat Image button will repeat the logo graphic rightward across the image from the location chosen 
in the Position grid. If you wish to repeat the watermark across the entire image, choose one of the sections 
on the left side of the Position grid.

When working with graphics-based watermarks, make sure your watermark file is sufficiently large for 
your usage. For example, if you want it to appear 2 inches wide on a 300-ppi image, your watermark needs 
to be at least 600 pixels wide. Or if you want it to appear across an entire photo—such as when posting 
to social media—it needs to be the same size as what you are exporting for the web, typically over 1000 
pixels. Using a watermark file that is too small will create a pixelated watermark appearance. And, because 
most watermarks are overlays on top of an image, these files are usually PNGs with areas of transparency, 
although JPGs can also be used, depending on the logo.

Using text-based watermarks

When creating text-based watermarks, the Text 
section of the pane has an entry box for your 
watermark text, a font selection area, and the same 
Appearance and Position options found in the Logo 
section.

The text entry box can contain multiple lines of 
custom text, and has the same token-based naming 
options found in the Naming pane (discussed on 
page 114), which can be helpful when exporting 
informational slides or for other data-driven uses.

You can set the font from the pop-up menu, and 
the font color by clicking the swatch on the left side 
underneath the font name. The text style can be 
set to bold, italic or underline, and the alignment to 
left, center or right. If you’d like to add a background 
color to the text box, turn on the Color Fill button 
on the right side of the pane.

Use the Position grid at the bottom of the pane 
to place your watermark, and use the Size and 
Inset sliders to move it within the area chosen. 
The Opacity slider adjusts the transparency of the 
watermark on the final image.

Saving watermark presets

Both watermark types can be saved as a preset 
for re-use later. To save a preset, adjust your Logo 
or Text settings as desired, and choose Save New 
Preset from the Presets menu. If you wish to adjust 
an existing preset at a later time—with a new logo 
file, for example—choose the appropriate preset 
from the Presets menu, make your changes, and 
choose Update Preset with Current Settings from the Presets menu. You can also rename and delete 
watermark presets from this menu.

With text-based watermarks, you can not only create simple, single-line 
watermarks showcasing your business, but you can also create 
data-driven watermarks (using tokens) for presentations and the like.
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Exporting and Export Presets
The Export window has been designed to offer as much or as 
little complexity as you would like. At its simplest, you can set the 
Destination and the File Type to your desired settings, leave all 
of the other panes alone, and click Export. Effects will remember 
your last Export setting—including anything you did in the Naming 
pane—the next time you export, so you don’t have to worry about 
which settings need to be set, and which ones don’t. You can use 
the Show/Hide buttons in the title bar of each pane of the Export 
Options panel to display only those settings you want to see.

Once you have your settings the way you’d like, you can save them 
as a preset by clicking the Save Preset option in the Preset panel 
on the left. Then, when you click that item in the Preset panel, the 
Export Options will be set to the specifications of that preset.

The Export Presets panel will display a list of the currently 
available presets. If you have selected a preset, it will have a 
selection box (in the app’s accent color) around it, and if the control 
circle is filled, the preset is on, meaning that clicking the Export 
button will export using that preset. If you don’t wish to use a 
preset, click the control circles off on all of the presets in the list.

By default, each preset will have up to three lines of explanatory 
text underneath the preset name, displaying the file type—DNG, 
PSD, TIFF—and the Destination information. This can be helpful 
when you’re scanning presets for a specific destination, but you 
can also collapse the preset to its title by clicking the Hide button 
in the title bar.

When you change the settings for a selected preset, Effects will 
ask you if you wish to update the preset with the new settings 
either when you click the Export button to start the process, or 
when you switch to another preset with the Export window.

It is possible to export more than one preset at a time. Every preset 
in the Presets panel that has the control circle set to On (filled) will 
be included in the export operation. This might be helpful to create backups on another disk, for example, 
or to build proxy versions for use while the original is being edited.

About Effects’ File-Naming Tokens
When using the Naming option in the Export window, Effects includes a broad set of tokens that you 
can use as part of the strings to build complex file names, in conjunction with any custom text you wish 
to enter. These tokens draw on image metadata, including filenames, dates taken, and EXIF and IPTC 
metadata fields, and can be used in any number of combinations.

All presets include an informational view that lists 
the export file type, the destination folder, and 
resize information. If you don’t wish to see that, 
click the Hide button to collapse the view to just 
the preset title.
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To build a rename sequence using tokens, click on the Add Token button, and choose the appropriate token 
from the pop-up menu. The token will be added as a shaded item in the text field, and the Example item 
above the text field will show a sample of a renamed file using the current set of tokens and custom text. 
To change an existing token, click on the down arrow on the right of the token, which will display the full 
set of tokens. To delete a token, double-click on it and press the Delete key.

Custom text can be added anywhere in the entry field. You can click the cursor at the beginning or end 
of a token (or in-between tokens) and add spaces, dashes, underscores and any other text you wish to be 
included in each renamed file.

There are four categories of tokens, each with their own set of options: Filename, Date/Time, Sequence, 
and Metadata. A description of each is listed below.

FILENAME

The Filename tokens use information from the 
filename or the enclosing folder that the file resides 
in. There are three options, Filename, which adds the 
current filename of the file being worked on; Filename 
Number Suffix, which takes the index (shot) number 
from the original raw file, if available; and Folder Name, which grabs the name of the folder in which the 
renamed (or imported) file resides.

DATE/TIME

This submenu consists of 17 combinations of date and 
time data, as taken from the image’s metadata. There 
are prebuilt date and time combinations (20220104, for 
example, for a year-month-date token) in the list, or your 
can build your own combinations out of the subtokens 
listed in this menu. 

Year data can be presented in either 4- or 2-digit 
numbers, and Month data can be presented in month 
number, full name, or 3-letter abbreviations.

You can use a combination of tokens and custom text to rename files to exacting specifications, all 
drawn from file information, metadata and more.
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SEQUENCE NUMBER

The Sequence Number tokens come into play when exporting a group of image files, and, as such is not 
applicable within Effects.

METADATA

This submenu has five items, each with its own submenu. 
All of the items create the chosen token based on the 
embedded metadata for each image being renamed, 
imported or exported. The specific text pulled from the 
Camera and IPTC tokens will be visible in the Metadata 
pane’s EXIF (for camera-specific data) and IPTC (for IPTC 
data) tabs. 

NOTE: If there is no information in the specified Metadata token, it will be 
ignored during processing.

Camera

The Camera submenu includes 21 items, all of which are 
directly taken from an image’s EXIF data. Not all cameras 
capture all of the items listed, but most of them save essential 
items like exposure information, focal length and more.

Ratings and Labels

The three tokens in the Ratings and Labels submenu (shown 
below) pull information from any rating, label and like 
information stored with images opened in Effects.

The Rating token will add the number of stars an image 
is rated, while the Label token will add any color label 
information (red, yellow, green, blue, purple), and the Likes 
token will add Liked, Not Set, or Disliked to the image name.
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IPTC Metadata Tokens

IPTC (International Press Telecommunications Council) is an industry-standard metadata format, and offers 
much more detailed metadata information than EXIF. It historically has been used by journalists and stock 
photographers to catalog and tag photos, as well as add copyright information, captions, and other data. 
There are nearly 30 different tokens in the IPTC metadata submenus, which are divided into Contact, 
Content, and Image. You can use these tokens if you know that an imported file has stored IPTC Metadata 
information.   
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EFFECTS MENUS
ON1 Effects 2023 (macOS Only)

• About ON1 Effects 2023: Opens the About box and displays 
your version number. (This is in the Help menu on Windows)

• Preferences: Opens the preferences dialog. (This option is In 
the Edit menu on Windows)

• Quit ON1 Effects: Quits ON1 Effects 2023.

File Menu
• Done: Saves your edited photo and quits Effects.

• Cancel: Cancels the current editing operation.

• Quick Export: Saves the current image in Photoshop, TIFF, 
JPEG or PNG format.

• Export: Opens the Export window.

• Export with Preset: Exports the current selection using a 
preset from the hierarchical menu, bypassing the Export 
window.

• Export with Previous: Exports the current selection with the 
last-used Export setting, bypassing the Export window.

• Print: Opens up the print dialog box.

• Manage Extras: Opens the Extras Manager window.

Edit Menu
• Undo: Removes the last file operation.

• Redo: Redoes the undo operation. This is only available if the 
last thing you did was an undo.

• Undo Delete: [unused]

• Redo Delete: [unused]

• Cut: Cuts the currently selected item.

• Copy: Copies the currently selected item.

• Paste: Pastes (copies) the items in the clipboard to the current 
location.

• Delete: [unused]

• Revert: Reverts to the original state of the current photo.

• Keyboard Shortcuts: Lets you add or modify the hotkeys for 
many of Effects’ commands. 

• Preferences (Windows): Opens the Preferences dialog.
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Mask Menu
• Invert Mask: Inverts the mask, what was hidden is revealed 

and vice versa.

• Reset Mask: Resets the mask to plain white.

• Copy Mask: Copies the mask.

• Paste Mask: Pastes the mask.

• Create Luminosity Mask: Creates a luminosity layer mask 
based on of a photo’s black or white tonal values.

• Show Mask: Displays the current mask either as a red overlay 
or as grayscale.

• View Mode: Sets the Show Mask mode to either red overlay 
or grayscale.

Settings Menu
• Reset All Settings: Resets all of the settings applied to a 

photo, returning it to the state it was when opened.

• Reset Effects Settings: Resets settings applied in Effects.

• Reset All Retouching Tools: Resets retouching applied in Edit. 

• Reset Local Adjustments: Resets any local adjustments.

• Reset Crop: Resets any cropping made to a photo.

• Save Settings as Preset: Saves the editing settings of the 
selected photo as a preset.

• Update Preset with Current Settings: If an image with a 
preset has had some settings changed, this lets you update 
the preset with the new settings.

• Rename Preset: Renames a preset.

• Delete Preset: Deletes a preset.

• Export Preset: Exports a preset as an ON1 preset file.

• Import Preset: Imports ON1 preset files.

• Get More Presets: Goes to ON1’s Photo Presets web page.

• Save Settings: Saves the current state of your edits, in case of 
crash.
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View Menu
• Zoom In: Zooms the preview window in one increment. This 

will make the preview image larger.

• Zoom Out: Zooms the preview window out one increment. 
This will make the preview images smaller.

• Fit to Screen: This sets the preview image so that the entire 
image is on screen at once. Think of this as an overview of the 
entire image. This is the setting you will use most of the time.

• Actual Pixels: This sets the preview image so that it zooms to 
actual pixels or 1:1 also called 100%. This setting allows you 
to see every pixel in the image. This is useful when making 
precision adjustments.

• Preset Browser: Sets the Preset panel browser view to 1, 2 or 
3 columns.

• Show Clipping: Shows the clipping overlay view, displaying the 
pure white or black pixels in the current image.

• Show Focus Mask: Displays a green overlay on those portions 
of the current image that are in focus.

• Show Preview: Toggle to enable or disable the preview.

• Compare: Displays an adjustable split-screen view of the 
current image, with the Before view on the left side of the 
preview area.

• Preview Background Color: Lets you set the background color 
options.

• Enable Soft Proofing: Turns on soft proofing for the current 
image.

• Gamut warning: Displays colors that the printer can’t 
reproduce with a red overlay.

• Profiles: Displays a list of installed printer and display profiles; 
choosing a profile will apply soft proofing for that profile’s 
paper type.

• Intent: Lets you switch between perceptual or relative 
rendering intent for the current image.

• Simulate Paper and Ink: When turned on, Effects will set the 
white point and black point of the display to account for that 
of the chosen profile.
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Window
• Minimize: Minimizes your screen.

• Zoom: Zooms your window to full-size.

• Full Screen: Toggles full-screen mode (hides menus).

• Full Screen Preview: Displays the current photo full-screen, 
without any additional interface elements.

• Navigator: Hides or shows the Navigator, Loupe, Histogram 
and Info pane.

• Layers: Hides/shows the Layers pane.

• Solo Mode: Keeps only one pane open at a time.

• Show Layers: Displays the Layers pane.

• Open Quick View Browser: Opens the Quick View Browser 
overlay for the selected preset category.

• Show Bumper Labels: Hides/reveals the bumper text labels.

• Show Browser Panel: Hides/shows the Browser Panel.

• Show Control Panel: Hides/shows the Control Panel.

• Hide Panels: Hides or shows all Panels.

• Document Name: Shows the name, zoom level and bit depth 
of the open image.

Help
• Search: Searches the menu options (MacOS only).

• Learning Hub: Opens the Learning Hub window in Effects.

• ON1 Effects 2023 Online Help: Opens ON1.com support 
page in your default web browser.

• Video Tutorials: Opens ON1.com product training page in 
your default web browser.

• Check for Updates: Checks the ON1 update server to see 
if you are running the current version. If there is a newer 
version, you will be notified and be walked through the 
update process.

• Sign-In/Sign-Out: Uses your ON1 account login information 
to authenticate your copy of ON1 Effects 2023.

• Provide Feedback: Opens the default web browser and goes 
to the feedback page of the ON1 website.

• About ON1 Effects (Windows Only): Opens the about box 
with the version number displayed.

• Help Improve ON1 Products: Opens the Improve ON1 
Products dialog.

• Show ON1 Log: Diagnostic tool that can help ON1 support 
when you’re having issues with ON1 Effects 2023.
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PREFERENCES
ON1 Effects 2023 has a number of system-wide settings that you can set via the Preferences window. To 
access Preferences, either click on the gear icon at the lower left side of the screen, or choose Preferences 
from the ON1 Effects 2023 menu (MacOS) or the Edit menu in Windows. The Preferences window has four 
tabs: General, Files, Plug-Ins, System, Services. The settings in each tab are described below.

GENERAL SETTINGS

The General settings tab adjusts basic settings 
for the Effects workspace, including background 
color, scrolling controls and more.

Font Size

Sets the size of the text in the basic Effects 
workspace (labels, panes and pop-up menus) to 
one of three general sizes: Small, Medium, Large. 

When changing the font size, you must quit and 
restart Effects for the new setting to take effect.

Preview Background Color

You may select the color of the background behind the preview image. The default is black. The custom 
option has a color picker where you can select your own background color.

Accent Color

Lets you choose the display color for highlighted items (folders, tabs, selections) in the Effects interface.

Application Language

Lets you change the display language for Effects. Auto will use your system’s default language.

Check for Update on Launch

Enabled by default, the product will communicate with ON1’s software update server when you start ON1 
Photo; if an update is available it will prompt you to download or skip.

Only Adjust Brush Size with Scroll Wheel

Turning on this option overrides Effects’ default behavior, setting the app so that your mouse’s scroll wheel 
will only change the size of a brush (when an appropriate tool is selected). 

When not checked, Effects uses the scroll wheel to scroll, zoom, pan and adjust brush size and feathering, 
depending upon the modifier keys being pressed. See page 21 for specifics on the default settings for 
scroll wheel options in Effects. 
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FILES

Sidecar Options

Click this box if you wish Effects 2023 to create 
ON1-specific ‘sidecar’ files when you are editing 
images. This is helpful if you are using multiple 
computers, and want your edits to be visible 
on each machine. The sidecar file contains the 
editing information used inside Effects. 

Default Processing

Apply Lens Correction Automatically will use lens correction information automatically on any raw photo 
opened in ON1 Effects. Choosing Disable Base Corrections on Raw Files will turn off the basic raw-
file correction settings. This can be helpful for scientific/technical photography, time-lapse, and other 
specialized applications.

PLUG-INS

Plug-Ins is specific to using Effects as a plugin 
Photoshop or Lightroom, and lets you set up 
conditions when opening files from these apps.

General

Checking the “Leave ‘ON1 Effects 2023’ open 
when done will keep the app open after you’ve 
edited an image via a plugin.

Photoshop
• Apply Results to: When editing in 

Photoshop you can choose to have your 
effect added to a copy of your current 
layer or to the current layer. You can also 
choose to start with the last used settings 
when launching Effects.

Lightroom

This preference sets specific options for files opened via the Plug-In Extras menu in Lightroom:

• File Type: The file type drop-down menu determines what type of file will be created. The default is 
PSD, which maintains layers. You can also select ON1’s Smart Photo format to preserve re-editability 
from within Lightroom, and JPG or TIFF if you prefer those formats. The last option, ‘Same as Source,’ 
maintains the file type of the original file, except for Lightroom raw files, which are saved as PSDs.

• Color Space: Sets the working color space; Adobe RGB, sRGB or ProPhoto RGB.

• Bit Depth: Sets the file bit depth, either 8-bit or 16-bit per pixel.
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• Resolution: The resolution drop-down menu determines the resolution of the file.

• Stack with Original: When enabled, the new image is stacked with the original image.

• Use Original for Single PSDs: When enabled, if you select a single PSD file, it will be edited directly, 
rather than having a copy made.

• Ask Every Time: Presents these export options whenever you chose an item from the Plug-In Extras 
submenu. Turning this option off will bypass the file-export window, using the options in the Plug-In 
Preferences window every time.

NOTE: For detailed information about the Smart Photo format and re-
editability options from within Lightroom, see page 11.

Apple Photos (MacOS only)
• The Enable Helper option works to ensure a smooth connection between Apple Photos and ON1 

Effects. It should remain on by default.

SYSTEM

The System tab displays performance-related 
characteristics of Effects 2023.

AI processor

Sets the processing option for AI-based 
operations. By default, the option is set to Auto, 
which uses the best combination of system 
resources to process tasks. If you are noticing 
some performance issues with Effects, you can 
try setting the options to either your CPU or 
your graphics card.

Memory Usage
• System Usage: Specifies the amount of RAM that is used by the application. The maximum (default 

value) is 80%.

• VRAM Usage: Specifies the amount of video memory (VRAM) that is used by the application. The 
maximum (default) is 80%.

Scratch Folder Location

This setting lets you move or reset your memory cache, which helps speed editing operations while you’re 
running Effects. This is helpful if your system drive has limited space and wish to use a faster external drive 
as a cache. This cache information is purged each time you quit the application.
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Performance

The Performance section is designed to help you optimize Effects for your specific setup. The adjustments 
you can make are as follows:

• Video Card Strength balances updating the preview of the image and the movement of brushes and 
gradient tool overlays. If your brush is sticking try turning it down. If you have a high-end video card try 
turning it up for faster preview updating.

• Fast Panning reduces the preview quality (makes it less sharp) while panning the photo to improve 
performance of panning.

• Fast Preview reduces the preview quality (makes it less sharp) while painting or making other 
adjustments to improve paintbrush performance. This is off if you have a high-end video card.

• GPU Render uses the GPU (video card) to render preset thumbnails, exporting, printing, sharing and 
caching. This can greatly improve performance. It is on by default for systems that support it. It may be 
disabled on lower-end GPUs.
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